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Chapter 1:  Overview
LeCroy’s SASSuite expert application software package provides a powerful and flexible 
means for recording, decoding and displaying communications traffic on SAS and SATA 
links.  The SASSuite application supports the following major products to assist 
engineers in designing, developing and validating SAS- and SATA-based products. 

• The Avalanche Protocol Analyzer allows users to record and display all communica-
tions traffic on SAS or SATA links at data rates of 1.5, 3 and 6 Gb/s.  As with all 
LeCroy analyzers, hardware-based pre-capture filtering is supported for efficient 
memory management. The system provides full decoding of STP traffic moving 
between SAS expanders and SAS initiators.  Full SATA-II analysis support is 
included for users interested in using Avalanche to test Serial ATA environments 
(1.5, 3 or 6 Gb/s).  

• The SASTracer Protocol Analyzer allows users to record and display all communi-
cations traffic on SAS or SATA links at data rates of 1.5 and 3 Gb/s.  Full SATA-II 
analysis support is included for users interested in using SASTracer to test Serial 
ATA environments (1.5 or 3 Gbps).  An important option for the SASTracer Analyzer 
is the SASTracker Command Analyzer option.  SASTracker monitors commands 
issued over SAS or SATA networks to track all commands, measure execution time, 
identify slow commands or commands that fail to complete, and optimize overall 
system performance.

• The SASTrainer Exerciser is a traffic generation system that can initiate SAS or 
SATA traffic (emulating either an initiator or target device) for testing of SAS/SATA 
designs and products. The system can be programmed to transmit valid and invalid 
SAS or SATA traffic. It can send specific IO operations or customized data payloads. 
The exerciser can “play-back” any previously recorded trace as a stimulus file and 
also offers a text-based API for creating scripts from the ground up.

These products, used either separately or in combination, provide fast, efficient and 
accurate debug, test and verification of Serial Attached SCSI semiconductors, devices 
and systems. They allows designers and validation engineers to quickly and easily 
transmit valid and invalid SAS or SATA traffic, selectively record the exchange and 
display the results using the SASSuite expert analysis software.  The SASSuite software 
supports all LeCroy SAS and SATA products, allowing this all-in-one test platform to play 
an important role at every phase of the SAS product development process.

The Avalanche protocol analyzer uses LeCroy’s newest and most advanced hardware 
platform, providing support for all SAS and SATA data rates up to 6 Gb/s.

The SASTracer and SASTrainer systems operate on a common modular hardware 
design, based on the LeCroy CATC 10K chassis.  The different product functions are 
supported by hardware modules which plug into the chassis, by LeCroy’s unique 
BusEngine firmware cores, and by the SASSuite Application Software.

The heart of the LeCroy SAS platform is the revolutionary LeCroy BusEngine™. This 
state-of-the-art, field-upgradeable, technology core incorporates a real-time 
non-intrusive recording engine and configurable tools to trigger and filter SAS and SATA 
traffic. It can intelligently monitor SAS and SATA frame headers and addresses, and start 
or stop recording based on user-defined events.  
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The modular LeCroy SAS products allow users to expand and upgrade systems as their 
needs change.  Adding new modules, or adding new BusEngines to existing modules, 
can economically expand the system capabilities while maintaining a common software 
interface through the integrated SASSuite Application Software.

For complete product information, please visit www.LeCroy.com.

Please refer to the Serial Attached Specification for details on the Serial Attached SCSI 
protocol. The Serial Attached SCSI specification is available at the web site www.t10.org.

                    Avalanche System                                     SASTracer/Trainer System

General Description 
The LeCroy SAS analyzer systems are intended to operate while inserted in the data path 
between SAS or SATA initiators and targets, non-intrusively passing all data traffic while 
capturing and recording the traffic of interest to the user.

The analyzer, in turn, connects to a PC over a high-speed USB cable. The PC functions 
as the host controller for the analyzer. SASSuite software on the PC controls and 
configures the products and retrieves and displays recorded data. 

The SASSuite trace viewing software runs on any personal computer using the Windows 
98SE, Window 2000, Windows ME, or Windows XP operating systems and equipped 
with a functional USB interface. 

The CATC 10K chassis supports up to two plug-in modules that can support tracing, 
traffic generation and/or command analysis.  The common hardware design allows users 
to obtain muliple functions at economical prices, and to upgrade existing systems to new 
functions by adding the appropriate modules, BusEngines or software licenses.
2 LeCroy Corporation



SASSuite User Manual Version 6.2
The protocol analyzer is capable of on-the-fly detection of and triggering on such events 
as Primitives, Bus Conditions, SSP and SMP Frames, Data Patterns, and Errors. 
Whether recording manually or with a specified trigger condition, the analyzer 
continuously records the link data in a wrap-around fashion until manually stopped or until 
the Trigger Event is detected and a specified post-Trigger amount of link data is recorded.

Upon detection of a triggering event, the analyzer continues to record data up to a point 
specified by the user. Real-time detection of events can be individually enabled or 
disabled to allow triggering on events as they happen. This includes predefined exception 
or error conditions and a user-defined set of trigger events. 

Recorded data is presented as a "trace" in the trace viewer as rows of color-coded 
graphics. Users can then search this trace for errors and other  events using advanced 
search utilities, and then hide from the display all but only the most interesting and 
relevant data. 

The SASSuite software provides powerful search functions that enable investigation and 
highlighting of specific events. In addition to immediate analysis, you can print any part 
of the data. Use the Save As feature to save the data on disk for later viewing. The 
program also provides a variety of timing information and data analysis reports.
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Avalanche Features 
• High-Performance Protocol Analyzer System
• Available with one, two or four analysis ports, each supporting 1.5 Gb/s, 3.0 

Gb/s and 6.0 Gb/s data rates
• SAS and Serial ATA Recording at 1.5, 3.0 or 6.0 Gb/s
• Sophisticated Triggering
• Hardware Filtering
• DWORD Display
• External 4-lane MiniSAS Connectors
• Traffic Summaries
• Collapsible / Expandable Headers
• Automatic Decoding at Transport Layer; SCSI, ATA and Management 

Application Layers
• Field Upgradeable BusEngine Technology
• Dynamically Allocated Memory Pool (4 GB)
• 3 Year Hardware Warranty
• All-in-one platform transmits, records, and analyzes SAS protocols
• Monitor, trigger and record up to 4 Serial Attached SCSI links simultaneously
• Isolate areas of interest with real-time hardware triggering
• Extend capture window and data by removing non-essential primitives 
• Chronologically display all DWORDs on all channels synchronized to a 

common clock 
• Flexible platform for testing host and end-device behavior
• Automatically bring SAS device under test through power up / reset and 

speed negotiation sequence
• Statistical reports provide high level abstraction of events, operations, errors 

and throughput for each I_T_L Nexus
• Easy “drill-down” on field structures for individual Frames, Commands and 

Tasks
• View high-level Serial Attached SCSI protocol events
• Easily upgrade firmware to support new features
• Protect your investment with industry-leading warranty
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SASTracer/Trainer Features 
• Integrated Analyzer, Generator and Command Analyzer System
• Available with One, Two or Four 1.5 or 3.0 Gbps SAS analysis ports
• SAS and Serial ATA Recording at 1.5 or 3.0 Gbps
• Sophisticated Triggering
• Hardware Filtering
• DWORD Display
• Internal Single-lane or External 4-lane Connector Option
• Exerciser offers Initiator and Target Emulation
• Exerciser automatically responds to incoming OOB
• Command Analyzer tracks all commands issued in SAS matrix of up to 8 

initiators and 128 targets
• Traffic Summaries
• Collapsible / Expandable Headers
• Automatic Decoding at Transport Layer; SCSI, ATA and Management 

Application Layers
• Field Upgradeable BusEngine Technology
• Dynamically Allocated Memory Pool (2 GB)
• 3 Year Hardware Warranty
• All-in-one platform transmits, records, and analyzes SAS protocols
• Monitor, trigger and record up to 4 Serial Attached SCSI links simultaneously
• Isolate areas of interest with real-time hardware triggering
• Extend capture window and data by removing non-essential primitives 
• Chronologically display all DWORDs on all channels synchronized to a 

common clock 
• Flexible platform for testing host and end-device behavior
• Automatically bring SAS device under test through power up / reset and 

speed negotiation sequence
• Statistical reports provide high level abstraction of events, operations, errors 

and throughput for each I_T_L Nexus
• Easy “drill-down” on field structures for individual Frames, Commands and 

Tasks
• View high-level Serial Attached SCSI protocol events
• Easily upgrade firmware to support new features
• Protect your investment with industry-leading warranty

LeCroy BusEngine 
LeCroy’s BusEngine™ Technology is at the heart of the SAS Product Line. The 
revolutionary BusEngine core uses FPGA technology and incorporates both the real-time 
recording engine and the configurable building blocks that implement data/state/error 
detection, triggering, external signal monitoring, and event counting and sequencing. 
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Like the flash-memory-based firmware that controls its operation, all BusEngine logic is 
fully field upgradeable, using configuration files that can be downloaded from the LeCroy 
Website. 

Connection to Host PC System
The Avalanche and the SASTracer/Trainer are USB 2.0 Certified Hi-Speed Devices. To 
upload traces from the analyzer to an attached PC at Hi-Speed, the PC must have a USB 
2.0 Certified Host Controller and be running Windows 2000 SP3 or Windows XP.

Note:  The analyzer products include 2.0 USB hubs. You might see the 
drivers for these generic hubs being installed upon the initial plug-in.
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Chapter 2:  Installation
This chapter describes how to set up the SAS Analyzer and create your first recording.

System Components
• One stand-alone SAS/SATA Analyzer system
• One USB cable
• SASSuite software program CD-ROM
• SATA(SAS) cables approriate to analyzer system and devices under test
• Breakout board

Note:  Specific components included with the analyzer system vary based 
on model and configuration ordered.

Warning!  Do not open the analyzer enclosure. There are no user serviceable parts 
inside. Refer servicing to LeCroy.

Analyzer PC Requirements
The SAS Analyzer connects to a Host PC via USB line.

Please consult the readme file on the installation CD for the latest PC requirements.

Analyzer Hardware Description
Avalanche 
System

The LeCroy Avalanche system is a compact package that provides ports on the front to 
connect to SAS or SATA initiators and targets, and rear connections including power and  
USB (to host PC).  The front panel also contains arrays of indicator LEDs, both for the 
status of the four initiators and four targets, and also for the analyzer functions.

The SAS/SATA ports are "MiniSAS" connectors that can use either MiniSAS-to-MiniSAS 
cables or can use an "octopus" cable that breaks out the MiniSAS connector to individual 
device connectors.  Up to four links are supported between targets and initiators.

Avalanche LED Descriptions
The Status and Speed LEDs indicate the status of each link, as follows:

• The STATUS LED is green when receiving a frame, red when errors are 
found, and mixed color (1/2 green, 1/2 red) during OOB.  Otherwise, the LED 
is off.
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• The SPEED LED is green for 6Gb/s traffic, mixed color (1/2 green, 1/2 yellow) 
for 3 Gb/s traffic, and yellow for 1.5 Gb/s traffic (or off if no traffic is detected 
on that link)

The System LEDs indicate the status of the protocol analyzer, as follows:
• The TRIG/ERR RIGHT LED is green if the system is triggered, red if either 

Link 1 or Link 2 have a system error; and off otherwise.

• The REC/UPLOAD RIGHT LED is red if either Link 1 or 2 is recording, green 
if either Link1 or Link 2 are uploading, and off otherwise.

• The TRIG/ERR LEFT LED is green if the system is triggered, red if either Link 
3 or Link 4 have a system error, and off otherwise.

• The REC/UPLOAD LEFT LED is red  if either Link 3 or Link 4 is recording, 
green if either Link 3 or Link 4 are uploading, and off otherwise.

Note:  In the descriptions above, "Link 1" refers to the link between Initiator 
1 (I1) and Target 1 (T1), "Link 2" refers to the link between I2 and T2, 
etc.   The designation "Left" or "Right" is used since the Avalanche 
system includes dual BusEngines, one of which (right side) 
processes traffic from Link 1 and Link 2, while the other (left side) 
processes traffic from Link 3 and Link 4.

Avalanche Rear Panel Connectors
The rear panel of the Avalanche System provides the following connectors:

• POWER IN (to be supplied using the Adapter provided with the Avalanche 
System)

• USB (to provide a connection to the host PC system running the SASSuite 
application software)

• DATA IN/OUT (This connector links a 25 pin RS-232 cable to an external 
breakout board.  The breakout board allows signals to be sent from the 
analyzer to an external device such as an oscilloscope or from an external 
device to the analyzer for the purpose of triggering on an external input.  You 
configure input/output signalling through the Recording Options dialog box.  
Breakout board use is described at the end of this chapter.)

• SYNC OUT and SYNC IN (provides the capability to link up to 8 Avalanche 
Systems together to form a single system supporting up to 32 
time-synchronized links)

• EXT OUT and EXT IN (SMA connectors which provide signal connections to 
the Avalanche system from an external device, or to cause the Avalanche 
system to signal an external device)

SASTracer/ 
Trainer 
System

LeCroy’s SASTracer/Trainer System is based on the CATC 10K (or "UPAS 10K") 
platform. Plug-in modules for SAS are available with either the Internal SATA style cable 
connector (SS002MAA-X & SS003MAA-X) or the External "Infiniband style" connectors  
(SS004MAA-X) below.
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  SASTracer Analyzer Systems

SASTracer/Trainer Analyzer LED Descriptions
When powered on, the SAS Analyzer activates the user-accessible controls and LEDs 
on the front and rear panels of the CATC 10K.

Front Panel (Internal single lane connector - SS002MAA & SS003MAA-X)

Front Panel (4 Port External connector  - SS004MAA-X)

Front Panel LEDs (from left to right)
A PWR (power) - Green indicator LED for CATC 10K.  Lights when the unit 

power is switched on.
B Status indicator - Red indicator LED for CATC 10K.  Lights during 

initialization/power up of CATC 10K base unit. Blinks if a self-test fails.
C REC (recording) - Green LED. Lights when the unit is recording.
D TRG (triggered) - Orange LED.  Lights when the unit triggers on an event.
E UPLD (Upload) - Green LED.  Lights when trace is being uploaded from the 

analyzer to the PC.
F Manual Trigger - Push-button.  Allows a manual Trace capture.
G 1 - 4 (Link Channels 1 - 4) - Green LEDs.  Lights when a connection is 

established on the corresponding link. Blinks during OOB or when only one of 
the two connected devices is transmitting.

                                  Module Part # SS002MAA-X & SS003MAA-X                                         Module Part # SS004MAA-X 
LeCroy Corporation  9



Version 6.2 SASSuite User Manual
Connectors on the SASTracer Analyzer Module
• Plug-in Modules SS002MAA-X & SS003MAA-X  use single-lane Serial ATA 

Connectors (4).
• Plug-in Module SS004MAA-X  use 4 port Infiniband style connectors (1).

SASTracer/Trainer Rear Panel Description
From left to right, the CATC 10K rear panel contains the following components: 

USB type “B” host computer connector
This connector links the analyzer to the Host PC. for the purpose of transmitting 
commands from the PC to the analyzer and uploading traces from the analyzer’s 
recording memory to the SASSuite software for viewing and analysis.

RS-232 25 pin "Data Output" Connector
This connector links a 25 pin RS-232 cable to an external breakout board.  The breakout 
board allows signals to be sent from the analyzer to an external device such as an 
oscilloscope or from an external device to the analyzer for the purpose of triggering on 
an external input.  You configure input/output signalling through the Recording Options 
dialog box.  Breakout board use is described at the end of this chapter.

BNC Connectors "Ext. In" and "Ext. Out"
These connectors allow BNC cables to be attached to the analyzer for the purpose of 
triggering on external input signals or for sending an output signal from the analyzer to 
another device.  These connectors have the same function as the 25 pin RS-232 
connector - i.e., they channel input and output signals but do not support the use of a 
breakout board.  

Wide range AC connector module
— Power socket

— Power on/off switch

— Enclosed 5x20 mm 2.0A 250 V fast acting glass fuse

Warning!  For continued protection against fire, replace fuse only with the type and 
rating specified above.
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Setting Up the Analyzer
Step 1 Remove the analyzer from its shipping container.
Step 2 Connect the analyzer unit to a source of compatible AC power 

using the provided power cord (and, for Avalanche, the provided 
external power supply). 

Note: The analyzer is capable of supporting supply voltages 
between 100-volt and 240-volt, 50 Hz or 60 Hz, thus 
supporting all known supply voltages around the world.

Step 3 Turn on the power switch (on the front of the Avalanche or on 
the rear of the CATC 10K).  

Note: At power-on, the analyzer initializes itself in approximately 
ten seconds and performs an exhaustive self-diagnostic 
that lasts about five seconds.  If the diagnostics fail, call 
LeCroy Customer Support for assistance. 

Step 4 Insert the CD into the CD ROM drive of the PC that will be 
controlling the analyzer.

Step 5 Connect the USB cable between the USB port on the back of the 
analyzer and a USB port on the PC.

The operating system detects the analyzer and begins to install the USB 
driver.

Step 6 Follow Windows on-screen Plug-and-Play instructions for the 
automatic installation of the analyzer as a USB device on the 
Host PC (the required USB files are included on the SASSuite 
CD). Step through the Windows hardware wizard.  The wizard 
will see that the analyzer has an internal USB hub and will begin 
loading hub drivers. Afterwards, the wizard will automatically 
install the system as a USB device on the PC.  When the wizard 
prompts you for driver information, point it to the CD which 
should be in your disk drive and install the following files
• For Avalanche systems, install Avalnche.sys and CTCDragn.sys

• For SASTracer systems, install CATCupa.sys and SasTracer.sys.

Connecting SAS/SATA Devices to the Analyzer
Depending on the model of your analyzer, you will have different SAS/SATA connectors 
on the front panel, as follows:

• Avalanche systems provide MiniSAS connectors.

• SASTracer systems provide either SATA-style connectors or Infiniband 
connectors, depending on the module installed in your SASTracer.
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Avalanche 
Connectors

Avalanche systems provide MiniSAS connectors, each of which can be connected to up 
to four devices.  Devices can be connected using either MiniSAS-to-MiniSAS cables, or 
using "octopus" cables, which provide connections from one MiniSAS connector to up to 
four SATA-style connectors.

SASTracer 
Connectors

Depending on the module installed in your SASTracer chassis, you will have either 
SATA-style connectors or Infiniband connectors..

Model SS004MAA-X incorporates the SAS external "Infiniband style" connector which 
includes both a non-intrusive as well as a repeater style front-end.  This allows users to 
selectively switch between these two probing techniques based on their specific 
application. Only one pair of connectors may be used at a time.

Note:  Users with model SS004MAA-X must switch between "repeater" 
and "non-intrusive" using the SASSuite software.  Go to Setup > 
Probe Control to enable "repeater" or "non-intrusive" mode.  

Non-intrusive Tap
Also known as passive tapping, this approach silently samples the signal without 
re-driving the differential lines (high value resistors contribute to reduction in amplitude  
~15%).  
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Repeater Tap
In repeater mode, the analyzer reproduces the exact patterns it receives on the inbound 
(RX) line. While the repeater does not re-time the signal—it does "clean-up" normal 
reflections that can occur over a full length cable when the analyzer is not in the line.

When using the External Connector Module (SS004MAA) to probe between devices that 
utilize single lane SATA connectors, the special octopus cable must be used. The SATA 
side of the octopus cables would be attached to the devices under test.

Note:  The initiator side must be a "cross-over" cable.
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Note:  When using new External Connector Module (SS004MAA) with 
standard 4X External InfiniBand style cables, there is no need to use  
"cross-over" cable. Both cables above are straight.

SASTracer Analyzer with Internal SATA Connectors (SS002MAA & 
SS003MAA) 
When using the original single-lane "SATA-style" module (SS002MAA & SS003MAA) 
with devices that utilize single-lane SATA style connectors, the standard SATA-style 
single-lane connector cables must be used.
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 Test Setup With DUT Requiring External 4 Lane Connector

Note:  The target side must be a "cross-over" cable.

Installing the SASSuite Software
Once the SAS Analyzer has been recognized as a USB device, install the SASSuite 
software on the Host PC.

Step 1 On the PC, run setup on the installation CD and follow the 
on-screen instructions.

The SASSuite software will install on the PC hard disk.

Step 2 To start the application, launch the LeCroy SASSuite program 
from the Start menu:   
Start > Programs > LeCroy > LeCroy SASSuite.

The SASSuite program opens.
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Note:  The software may be used with or without the analyzer.  When used 
without an analyzer, the program functions as a viewer to view, 
analyze, and print recorded files. 

Making a Recording on the SASTracer Analyzer
After installation, the software is configured to make a 16 or 32 MByte snapshot recording 
of your Serial Attached SCSI traffic (16 MByte for SASTracer, 32 MByte for Avalanche). 

To make this recording, follow these steps:

Step 1 Connect a cable to each of the two connectors on the analyzer 
module, then connect the other ends to the Serial Attached 
SCSI device under test and Serial Attached SCSI host system.

Step 2 From the Setup menu, select Recording Options.

Step 3 Select the General tab. 

The following window displays the factory default settings such as 
“Snapshot” and 16 or 32 MBytes buffer size are displayed. For your first 
recording, you can leave these settings unchanged.  The window 
displayed below is for the SASTracer system, the Avalanche window is 
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virtually identical except for the default buffer size and the image of the 
system. 

Step 4 Click OK to close the Recording Options window.

Step 5 Click  on the Tool Bar. After 16 (or 32) MBytes of traffic is 
recorded, the analyzer uploads the data and displays the 
Frames.

Stopping a 
Recording

You can stop the recording process at any time by pressing .  Afterwards, the trace 
will automatically upload from the analyzer to the PC.
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Interrupting 
the Upload 
Process

You can interrupt the upload process by pressing the Stop  button.  Pressing Stop 
will cause the following dialog box to open: 

This dialog presents options for stopping, continuing, or aborting the recording:
• Select New Upload Range within the Recorded Buffer 

•Slide Bar - Adjust arrows at either end of the slide bar to select the 
range of buffer you want uploaded.  The color in the slide bar 
indicates pre- and post-trigger traffic.   

•Full Buffer - Uploads entire buffer to the PC.

•Upload Selection - Uploads whatever range you have selected via 
the slide bar.

• Abort Upload?

•Stop - Stops the recording and then displays the trace on screen.

•Continue - Resumes the recording.

•Flush - Cancels the recording without saving or displaying the trace.

Once you have interrupted an upload, a new button will appear on the toolbar:  .  This 
button ("Re-upload") opens a dialog box with a slide bar for re-selecting the range of the 
trace that you would like to upload.  
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Saving the 
Trace

When the recording session is finished, the bus traffic is uploaded to the PC and is 
automatically saved to the hard drive as a file named data[sn].sas where [sn] is the serial 
number of the analyzer chassis; or the name you assign as the default filename. 

Step 1 To save a current recording for future reference, select  
Save As from the File menu.

Step 2 Give the recording a unique name and save it to the appropriate 
directory.

Probe Control Settings
LeCroy analyzers are designed to interface with the communications channel in a 
non-intrusive manner, to minimize any distruption of traffic or error conditions due to 
insertion of the analyzer.  In some cases, the user may desire to adjust the probe settings 
to achieve a more optimum balance of complete data capture with minimal traffic 
disruption, and for that reason direct user access is provided to the probe control settings.

The probe control dialog provides several user adjustable settings for the probe 
performance, which vary depending on the model (Avalanche or SASTracer).  
Modification of these settings occur in real-time and do not require cycling the power or 
uploading new firmware.

Avalanche 
Systems

To access probe control setting for an Avalanche System, select Probe Control from the 
Setup menu.
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Selecting this option bring up the following dialog window:

In the Avalanche System, the probes can be controlled separately for the initiator traffic 
and for the target traffic, and a selection whether to adjust initiator, target or both is 
provided at the top of the window.  If separate adjustments are desired, first adjust one 
probe, click on Apply to apply the settings, then select the other probe and make 
adjustments there.

Allowed adjustments include applying input signal equalization, output pre-emphasis, 
and output power.

Input Signal Equalization
Input signal equalization can be adjusted within a 
matrix of three time values and four settings for each 
time value.  These settings are named in relative 
terms:  time values are "Short time, Medium time, 
and Long time"; and settings for each are "Off, 
Min(imum), Mod(erate), and Max(imum)".  This 
matrix provides a range of different settings that 
covers the expected needs of any specific 
application.  The default settings are "Off" for all 
values.

Output Pre-emphasis
Output pre-emphasis is controlled within a matrix of 
two time values and 15 settings within each time 
value.  The time values are "Long level" and "Short 
level"; the settings for each are from "Off" (or 0) to 
"Max" (or 15).  The default settings are "Off" for both 
values.
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Output Power
The output power can be controlled in eight steps 
from 626 mV to a maximum of 1294 mV.  The output 
power level will appear as soon as the slider bar is 
moved (although as with all probe settings, no 
changes are applied until the "Apply" or "OK" buttons 
are clicked).  The default setting is the maximum value of 1294 mV.

SASTracer 
Systems

To access probe control settings for a SASTracer System, select Probe Control from the 
Setup menu. 

The Port Settings and OOB Idle Sensitivity are only available when the SAS analyzer 
system is operating in Repeater mode.  

The Plug-in Mode options provide an additional control for the SASTracer External 
Connector Module (SS004MAA) only. These controls will be disabled when attached to 
the Internal SATA-style module (SS002MAA) because this module operates in Repeater 
mode only.

Break Link - Checking this box for a specific channel takes the link to electrical idle. It 
has the same effect as manually detaching a single connector from the device to "break 
the link". Unchecking the Break Link box for a specific channel brings the link up. It has 
the same effect as attaching a connector to a powered-on device. 

If there’s more than one analyzer 
connected, the user will have an 
option to select Probe Control 
Settings for each device individually
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High Swing - Alters the repeaters differential output swing to accommodate for PCB / 
connector loss. By default, the repeater uses "Normal" swing. "High" swing may be 
required when tapping between long backplanes or extended cable distances: 

• Normal Swing: 440 mV min and 660 mV max  (peak to peak)

• High Swing:  800 mV min and 1200 mV max  (peak to peak)

OOB Idle Sensitivity - Alters the repeaters OOB detection behavior to accommodate for 
marginal OOB signal amplitude in SAS devices under test. The OOB idle sensitivity offers 
an adjustable threshold for detecting an inbound OOB sequence. If two PHYs fail to 
complete OOB, users may find lowering the OOB idle sensitivity provides a mechanism 
for establishing the link even when the OOB signals from the DUT are marginal.

• Normal - 100mV to 200mV

• Decrease 30mV

• Decrease 60mV
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Chapter 3:  Software Overview
SASSuite is an application that may be used with or without an analyzer unit. When used 
without an analyzer, the program functions as a viewer to view, analyze, and print 
captured traces (from Avalanche or SASTracer analyzers) or command log files (from the 
SASTracker option on the SASTracer).  

Starting the SASSuite Program
To start the SASSuite program from the Start menu,

Step 1 Click Start.
Step 2 Select Programs.

Step 3 Select LeCroy.

Step 4 Click LeCroy SASSuite.

 

Opening Sample Traces
A good way to gain familiarity with SASSuite is to open some of the provided sample files 
and explore the menus, pop-up menus, and reports. 
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Opening "Older" Trace Files
If you have recently installed a newer version of SASSuite and have existing data files 
recorded in older versions, when you try to open these files you may be prompted to 
update the files to the newer file format.  In most cases, you simply need to click on the 
"Update file" button to update the file.

If you expect to need to use the older version of SASSuite to open these files (perhaps 
on a different computer system), you can select to make a backup copy of the file which 
retains the older file format.

.

Tool Tips
Throughout the application, Tool Tips provide useful information about  buttons on the 
toolbar.

To display a Tool Tip, pause the mouse pointer over an item of 
interest such as part of the trace or a button.  

Trace Tool Tips
Many fields within the Trace will display tool tips when the mouse pointer is suspended 
over them.  These tips may provide a simple legend for the cell or may give substantial 
added details about the field. 
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The Menu Bar
While some of the analyzer’s main display window options are familiar, many contain 
options specific to the analyzer program.  Depending on the particular analyzer function 
in use, not all of the options shown here may be displayed.

Table 1: Main Display Pull-Down Menus
Menu Function
File

New GenFile Creates a new (and empty) traffic generation file.  To add 
text, click the Edit as Text button on the toolbar.

Open… Opens a trace file or traffic generation file.
Close Closes the current trace or generation file.
Save As… Saves all or a specified range of Frames from the current file 

with a specified name.
Print… Prints part or all of the current trace or traffic generation file.
Print Preview Produces an on-screen preview before printing.
Print Setup… Sets up your current or new printer.
Edit Comment… Opens a dialog for entering a brief comment about the trace.
Export>> Packets to Text  (Packet View Format) - Saves all or part of a 

trace to a text file.  Useful for saving traces to floppy disk 
and for emailing.  
to Generator File Format ... -  Creates a traffic generation file 
based on the open trace.  This is a fast and easy way of 
creating a traffic generation file.
Packets to EAS Format ... - Creates an EAS file based on the 
open trace.  Running this command opens a dialog 
prompting you for a file name, path, and a range of Frames 
to be exported.
Transport to CSV Format ... - Creates a structured .csv file 
from all or part of the trace data.  This file may be imported 
into external databases or spreadsheet programs (e.g., 
Microsoft Excel).

Convert>> Convert .stg to .ssg - Converts  SATA traffic generation files 
created by SATracer (.stg) to the SASTracer generation 
format (.ssg).

Merge Trace Files Merges files which have been recorded as multitrace files 
(e.g., when using cascaded analyzers)

Exit Exits the SASSuite program.
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Setup
Display 
Options…

Opens a dialog for customizing trace colors, formats, and 
filters.

Recording 
Options (UPAS 
10K)…

Configures the SASTracer analyzer’s recording behavior.  
Opens a dialog for selecting event triggers and filters, and 
for setting the size of the recording buffer and other 
recording options.

Recording 
Options 
(Avalanche)…

Configures the Avalanche analyzer’s recording behavior.  
Opens a dialog for selecting event triggers and filters, and 
for setting the size of the recording buffer and other 
recording options.

Update Device Opens a dialog for updating the BusEngine and Firmware of 
the selected device.

Probe Control Provides a dialog to adjust the probe settings of the 
selected device.

Channel Settings Allows renaming of the channels - ie the establishment of 
aliases for each channel.

Analyzer Network 
...

Opens a dialog box for browsing to local and networked 
analyzers.  Within the dialog, click Add to browse.  The 
dialog lists PCs that are on the LAN.  If a PC has an analyzer 
attached to it, and if DCOM permissions have been set on 
the selected PC, clicking Select establishes a connection. 

All Connected 
Devices ...

Opens a dialog box with a list of analyzers connected to the 
host PC.  Lets you select an analyzer and update the 
BusEngine, Firmware, and licensing information.

Switch ... to... Switches between SASTracer and SASTracker capabilities 
for systems with dual-function licenses.

Record
Start Causes the Analyzer to begin recording.
Stop Causes the Analyzer to stop recording.
Recording 
Options (UPAS 
10K)…

Configures the SASTracer analyzer’s recording behavior.  
Opens a dialog for selecting event triggers and filters, and 
for setting the size of the recording buffer and other 
recording options.

Recording 
Options 
(Avalanche)…

Configures the Avalanche analyzer’s recording behavior.  
Opens a dialog for selecting event triggers and filters, and 
for setting the size of the recording buffer and other 
recording options.

Generate
Start Generation Starts traffic generation.  This command requires that a 

traffic generation file (.ssg) be open.
Stop Generation Stops traffic generation.
Resume 
Generation

Resumes traffic generation if generation has been stopped.

Connect Link Establishes a link between SAS/SATA Exerciser and the 
DUT.

Disconnect Link Breaks the link between SAS/SATA Exerciser and the DUT.

Menu Function
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Generation 
Options

Opens a dialog for configuring traffic generation.  The 
dialog looks like the Recording Rules dialog (Setup > 
Recording Options > Recording Rules).  See Generation 
Options in the Traffic Generation chapter.   

Tracker
Start Tracking Initiates tracking of all commands issued and completed.

Stop Tracking Stops command tracking.

Tracker Options Opens a dislog box to allow the user to establish settings to 
control command tracking and set the timeout trigger.

Report
File Information Displays information about the recording such as the 

number of Frames and triggering setup.
Error Summary Summarizes the errors throughout the recording. Allows for 

fast navigation to errors.
Timing 
Calculations

Calculates timing between two Frames.

Traffic Summary Summarizes the numbers and types of  Primitives, Frames, 
SCSI Operations, and errors that occurred in the open 
Trace.

Bus Utilization Displays graphs of various types of events that occurred in 
the open trace.

Run Verification 
Scripts
Link Tracker » Opens a window for displaying a detailed chronological 

view of bus activity on a Primitive-by-Primitive basis.  
Frame Tracker Opens a window for displaying a detailed chronological 

view of traffic on a Frame-by-Frame basis.

Search
Go to Trigger Positions the display to show the Trigger event.
Go to Event... Positions the display to the indicated Packet, Frame, 

Primitive etc. The menu is context-sensitive and depends on 
the decode level that you are currently displaying.

Go to Marker » Positions the display to the selected marked Frame.
Go to » Enables quick searching for specific events using a 

cascade of pop-up windows.
Find ... Allows searches by multiple criteria.
Find Next Looks for the next instance of an event specified with Goto 

or Find.
Search Direction Allows the search direction to be changed from forward to 

backwards or backwards to forward.  

View

Menu Function
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Toolbars Displays list of available Tool bars.
Analyzer Network 
Chat Bar

Opens a dialog that allows users to conduct chat sessions 
over an IP LAN.  In order to send and receive electronic text 
messages, each user must be working with a PC that is on 
an IP LAN and also attached to an analyzer. 

Status Bar Switches display of the Status Bar on or off.
Zoom In Increases the size of the displayed elements.
Zoom Out Decreases the size of the displayed elements.
Wrap Wraps displayed Frames within the window.
Compact Changes view mode to the compact view.
Link Layer Displays Link Layer traffic in the trace. 
Decoding 
Assignments
Transport Layer Decodes and displays Transport Layer transactions.
SCSI Application 
Layer

Decodes and displays SCSI Application layer transactions.

Management 
Application Layer

Decodes and displays Management Application layer 
transactions.

ATA Application 
Layer

Decodes and displays ATA Application layer transactions.

Hide

Tools
Hash Address 
Utility

Opens a dialog for calculating a Hash address from the SAS 
address.  Enter an 8 byte value into the lower box to see its 
Hash value.

Window
New Window Switches display of the Tool bar on or off.
Cascade Displays all open windows in an overlapping arrangement.
Tile Horizontal Displays all open windows as a series of strips horizontally 

across the display.
Tile Vertical Displays all open windows as a series of strips vertically 

down the display.
Arrange Icons Arranges minimized windows at the bottom of the display.

Windows ... Displays a list of open windows.

Help
Help Topics ... Opens online help.
Update License 
...

Opens a dialog box for entering license key information for 
the analyzer.

Display License 
Information ...

Opens a dialog box with information about the current 
status of the analyzer's license

About... Displays version information about SASSuite.

Menu Function
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The Toolbar 

The Tool Bar provides quick access to most of the SASSuite software functions. You can 
learn the function of each button by pausing the mouse pointer over them.  Descriptions 
of the buttons appear on the status bar at the bottom of the window and as tooltips above 
each button. 

Open File Stop Recording

Save As
Re-upload.  This button appears in 
the toolbar if Stop has been 
pressed during an upload.  Causes 
analyzer to re-upload trace from  
analyzer buffer to the PC.  Gives 
options for selecting which part of 
the trace you want uploaded.

Preview Zoom In

Print… Zoom Out

Edit as text - opens a text editor for 
editing traffic generation files. Wrap

Setup Record Options (for 
SASTracer, or for Avalanche)

Find - Opens a dialog for 
conducting complex searches

Setup Display Options
Find Next - repeats last Find or Go 
To operation

Start Recording
Trace Panes.  Allows multiple 
traces to be locked together and 
scrolled in tandem.  This option 
only works with .mlt traces created 
by multi-analyzer cascades in a 
single recording session.
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Reports Buttons 

Decode Buttons 

Hide Buttons 

Multisegment Trace File Buttons
These buttons become active if a multi-segmented trace file has been opened.  
Multi-segment traces are traces that have been recorded as a series of small segments 
rather than as a single, large recording.  Multi-segmenting was developed to make it 
easier to work with large recordings where navigation can sometimes be difficult. 

Multi-segmenting is enabled in the General page of the Recording Options dialog.

File Information Report.  Opens a 
summary of the trace file including 
when it was made, the Recording 
Options used to create the file, and 
data on the analyzer that recorded 
the trace.

Traffic Summary.  Opens a window 
displaying a table summary of 
traffic recorded in the trace.

Error Report.  Opens the Traffic 
Summary window and displays a 
summary of errors in the trace.

Bus Utilization.  Presents a 
graphical summary of traffic in the 
trace.

Timing and Bus Usage 
Calculations.  Opens a calculator 
for measuring timing between 
Frames.

Show Link Tracker.  Opens window 
with detailed chronological view of 
traffic on a Primitive-by-Primitive 
basis.

Show Data Block.  Opens a dialog 
for navigating to data blocks within 
Frames and Transactions.  Once a 
data block is located, the window 
can display the data in a variety of 
formats. 

Show Frame Tracker.  Opens 
window with detailed chronological 
view of traffic on a Frame-by-Frame 
basis.

Decode & display Link Layer 
(Frames & Primitives)

Decode & display  Management 
Application Layer (Management 
Transactions)

Decode & display  Transport Layer 
(SSP, SMP, & STP)

Decode & display  ATA Application 
Layer Transactions

Decode & display  SCSI 
Application Layer (SCSI 
Commands)

Hide Align and Notify Primitives Hide Initiator Channel 1

Hide RRDY Primitives Hide Target Channel 1

Hide SATA Sync Cont Primitives Hide Raw Data

Hide Unassociated Traffic
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Multi-segmenting produces two kinds of files:  segments and an index file that 
summarizes the recording and keeps tabs of the various segments.

The buttons below allow multi-segmented traces to be navigated. 

Traffic Generation Buttons
These buttons become active if a traffic generation file (.ssg) is open.

Command Tracking Buttons

Floating the Decode Toolbar
You can float any of the toolbars by dragging them from their current 
location at the top of the screen.  If you float the decode toolbar, it will 
arrange the decode buttons so they reflect their hierarchical order.  

Show first multisegment file Show next multisegment file

Show previous multisegment file Show last multisegment file

Show multisegment index file

Start Traffic Generation. This 
button activates if a traffic 
generation file (.ssg) is open and an 
SATrainer is attached.

Connect link.  Establishes a link 
between  SATrainer and the DUT.  
When a Connect is built into the 
traffic generation script, this button 
will give status on the connection 
(it will depress when a connect 
occurs and undepress when 
disconnected.)

Stop Traffic Generation. This 
button becomes active if a traffic 
generation is underway.

Disconnect link

Resume Traffic Generation.  
Generation Options.  Opens a 
dialog for configuring traffic 
generation.

Start Tracking.  Initiates tracking of 
all commands issued and 
completed.

Stop Tracking.  Stops command 
tracking.

Tracker Options.  Opens a dialog 
window to allow the user to 
establish settings for controlling 
command tracking, including 
setting a timeout trigger.
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Pop-Up Menus
Pop-up menus within the trace provide options for formatting the trace. 

Left Mouse Button - Opens a menu for expanding fields, viewing data fields, and 
formatting the trace.  

The menu is context-sensitive and changes depending on what field of the data file has 
been clicked. 

A menu similar to the following appears:

• Data Field - Indicates the type of field that you selected.  This field is 
context-sensitive.

• View Data Block - Allows raw data to be viewed from a data cell. 

• Expand Data/Collapse Data - Expands or collapses data field. Summarizes 
the amount of data displayed in the cell. 

• Expand All Data Fields - Expands any data fields that are currently 
collapsed. 

• Collapse All Data Fields - Collapses any data fields that are currently 
expanded. 

• Format - Presents options for changing the numerical formatting of the data 
fields throughout the trace.

• Color - Presents options for changing the color of the data fields throughout 
the trace.

• Hide - Hides data fields throughout the trace.  To re-display hidden fields, 
right-click anywhere in the trace and select Unhide Cells and then one of the 
options from the sub-menu.

Right Mouse Button - If you click a cell in the recording with the 
right mouse button, a pop-up menu appears and shows the options 
for zooming in or out, wrapping the display, and other formatting 
options.
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Status Bar
The Status Bar is located at the bottom of the main display window. Depending on the 
current activity, the bar can be divided into as many as four segments.

Recording 
Progress

When you begin recording on an Avalanche or SASTracer Analyzer, the left-most 
segment of the Status Bar displays a recording Progress Indicator:  

As recording progresses, the Progress Indicator changes to reflect the recording 
progress graphically:

• In the Progress Indicator, a black vertical line illustrates the location of 
the Trigger position you selected in Recording Options. 

— Pre-Trigger progress is displayed in the field to the left of the 
Trigger Position. 

— When the Trigger position is reached, the progress indicator 
wiggles as it waits for the Trigger. 

— After the Trigger occurs, the field to the right of the Trigger  fills in 
the post-Trigger color specified in the Display Options. 

— When recording is complete, the upper half of the progress 
indicator fills in white, indicating the progress of the data upload 
to the host computer.

You should be aware of two exceptional conditions: 

• If a Trigger event occurs during the before-Trigger recording, the 
before-Trigger color changes to the after-Trigger color to indicate that 
not all the expected data was recorded pre-Trigger. 

• When you click Stop before or after a Trigger event, the Progress Bar 
adjusts  to begin uploading the most recently recorded data.

• If you wish to abort an upload that is in progress, click the Stop button 
again.

The Progress Bar fills with color in proportion to the specified size and actual rate at which 
the hardware is writing and reading the recording memory. However, the progress 
indicator is normalized to fill the space within the Status Bar.

Recording 
Status

During recording, the current recording status is displayed in the next segment of the 
status bar. (Refer to previous screenshot for examples.)  When recording is begun, one 
of the following messages flashes (depending on the selected Recording Options):

• Trigger?
• Triggered!
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• Uploading
After recording stops, The following occurs:

• Flashing message changes to Uploading data–x% done (x% indicates 
the percentage completion of the data uploading process). 

• Traffic data is copied to disk using a file named data[sn].sas where [sn] 
is the serial number of the analyzer chassis; or the name you assign as 
the default filename. You can also create a file name of your choice by 
specifying one in the Recording Options window.

To abort the upload process, press the Stop button.

You are asked if you want to keep or discard the partially uploaded data.

When the data is saved, the Recorded Data file appears in the main display window, and 
the Recording Status window is cleared. 

• If the recording resulted from a Trigger event, the first Frame following 
the Trigger (or the Frame that caused the Trigger) is initially positioned 
second from the top of the display.

• If the recording did not result from a Trigger event, the display begins 
with the first Frame in the traffic file.

Recording 
Activity

During recording, the fourth segment from the left of the Status Bar displays Recording 
activity as a series of vertical bars. 

The more vertical bars that are displayed, the greater the amount of activity being 
recorded.  If there are no vertical bars, there is no recorded activity. 

During uploading, the percent of the completed upload is displayed.

Search 
Status

The rightmost segment displays the current search direction: Fwd (forward) or Bwd 
(backward).  

Navigation Tools
You can zoom in and out, and wrap the recording to fit within the screen by using the 
following buttons:

Zoom In Increases the size of the displayed elements, allowing fewer (but larger) Frame fields per 
screen. 

Click  on the Tool Bar.

Zoom Out Decreases the size of the displayed elements, allowing more (but smaller) Frame fields 
per screen. 

Click  on the Tool Bar.

Wrap Adjusts the Trace View so that Frames fit onto the next line if they are longer than the 
size of the window. Without Wrap, you can use the horizontal scroll bar to see the hidden 
part of a Frame.
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Click  on the Tool Bar.  

Adding Comments to the Recording
You can create, view, or edit the 100-character comment field associated with each data 
file.

Step 1 From the File menu, select Edit Comment.
The Edit Trace Comment Dialog window appears.

Step 2 Create, view, or edit the comment.

Step 3 Click OK.

Set Marker
The Set Marker feature allows Frames to be marked so they can be navigate back to 
events of interest.  Markers also provide you with a way of tagging events so you can 
perform timing calculations between them.

The Set Marker command works in conjunction with the Go to Marker feature.  Once 
you have marked a Frame, you can navigate back to it by selecting Search > Go to 
Marker, and then selecting the marker of interest from the list.

    Trace with Wrap turned off.  In this example, the Time Stamp extends

     Trace with Wrap turned on.  Entire Frame displays in window.

    off the right edge of the screen.
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To set a marker on a Frame, perform the following steps: 

Step 1 Click on Frame # for the Frame you wish to mark.

Step 2 Select Set Marker.
The Edit Market for Frame # comment window appears.

Step 3 Enter your comment. 

Step 4 Click OK.

A marked Frame is indicated by a vertical red bar along the left edge of 
the Frame # block: 
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Edit or Clear Marker
To clear or edit comments associated with a Frame marker, 

Step 1 Click on Frame # for the chosen packet.

Step 2 To edit the marker comment, select Edit Marker.
The Edit Marker for Frame # comment window appears.

Step 3 Edit the comment as desired.

Step 4 Click OK.

Step 5 To clear a marker, click Clear marker.
The vertical red Marker bar disappears.
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Timing Calculations on Markers
Markers can be used as reference points to calculate timing between events.  To perform 
a timing calculation, select Reports > Timing Calculations, and then click the Markers 
buttons to select the markers you want to use for the calculation. Afterwards, click 
Calculate to calculate the timing between the marked events. 

You can also calculate timing between markers by clicking the left mouse button on the 
first cell of a Frame in the trace window and selecting Time from Marker from the pop-up 
menu.  The Timing Calculations dialog will open and prompt you to select a marker.  
Upon selecting a marker from the list, the calculation will be performed.
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Chapter 4:  Avalanche Recording 
Options
Recording options provide instructions for the analyzer hardware as to how a trace 
recording should be captured.  Included in these instructions are items such as how to 
start or stop a recording, what information should be recorded, and trigger conditions that 
can be used to automatically record certain data events (or sequences of events) when 
they occur.

Since these instructions are specific to the hardware platform being used, there are  
differences in the way the recording options are set up for the Avalanche system vs. the 
SASTracer system.  In order to present this information clearly, we have divided the 
information into two Chapters in this User Manual.

This Chapter covers recording options for the Avalanche systems only.  For 
information on the SASTracer systems, see Chapter 5.

General Recording Options
From the Setup menu, select Recording Options (Avalanche)... . The following screen 
is displayed:

Options displayed on the General page include the following:
• Recording Type

• (Recording) Options

• Buffer Size
LeCroy Corporation  39



Version 6.2 SASSuite User Manual
• Trigger Position

• Save As Multisegment Trace Option

• Options Name

• Trace Filename & Path

• Misc Information

Recording 
Type

The Recording Type box presents three options that control how Avalanche begins and 
ends a recording. The options are Snapshot, Manual Trigger, and Event Trigger.

• Snapshot: A fixed-length recording.  A Snapshot is a recording whose 
size is set via the "Buffer Size" box. Recording begins when the Start 
Recording button   is clicked and ends when either the preselected 
buffer size is filled or the Stop Recording button  is pressed. 

• Manual Trigger: A recording whose ending is triggered by pressing the 
Trigger button on the front panel.  Recording begins when the Record 
button  is pressed  on the Tool Bar. Recording continues in a 
circular manner within the limits set by the buffer size. Recording is 
ended by the user pressing the Trigger button on the front panel, 
although in some cases recording may not stop immediately.  Once the 
Trigger button has been pressed, recording continues until the 
post-trigger buffer has been filled (see Trigger Position below) or the 
Stop button   is clicked on the Tool Bar.

• Event Trigger: A recording whose ending is triggered by user-defined 
events. Recording begins when the Record button   is clicked on 
the Tool Bar.  Recording continues in a circular manner within the limits 
set by the buffer size until a trigger event is detected and the defined 
amount of data has been recorded after the Trigger event.

Options The option checkboxes appear on the upper right side of the General tab of the 
Recording Options window. 

• Truncate Data Payload Dwords:  Allows data payloads to be 
truncated to whatever length is specified in the box.  Truncating the 
payload limits the amount of space each frame requires to be stored in 
the buffer, thereby increasing the number of frames that can be 
recorded.

• Beep When Trigger Occurs: When this checkbox is selected, the 
computer connected to the Avalanche beeps three times to alert the 
user when a Trigger condition is first detected.

Buffer Size The Buffer Size slide bar adjusts the recording buffer size 
from 3.2 megabytes to 4096 MB.    This option is used for 
setting the maximum memory to be used for a recording.

The option mentioned above for truncating data payloads, 
as well as filtering options which will be discussed later, 
determine what information from the raw data stream is 
actually recorded into trace memory. Also, although there are 4096 MB of physical 
memory in the Avalanche analyzer, there is additional information recorded with each 
frame, such as timestamps and other system parameters, so the efficiency of the 
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recording is at least 60% (ratio of actual SAS or SATA traffic to physical memory).  
Filtering and truncation will yield better efficiency.  The actual 4096 MB of memory can 
only be reached when symmetric data is recorded on all four ports. 

Note:  The Buffer Size slider bar is not linear and affords more granularity in the 
smaller buffer sizes. 

Trigger 
Position

The Trigger Position slider bar allows the user to 
define the position of the trigger within the recorded 
traffic.  Essentially, this is instructing the system 
when to stop recording.  If the trigger position is set to 
the end of the recording, recording will stop 
immediately when the trigger occurs.  If the trigger is 
set to the start of the recording, when the trigger 
occurs the system will continue to record until the buffer has filled again and then stop 
(before the new data overwrites the trigger).  Any intermediate setting allows the user to 
see data both before and after the trigger occurred. You can adjust the Triggering 
Position between 1 and 99% post-Trigger. Trigger Position is available only when 
Manual Trigger or Event Trigger is selected as Recording Type.

As an example, if the buffer size is set to 16MB, then for the following Trigger Position 
settings, the amount of pre- and post-Trigger data is:

• 95% post-triggering: 0.8MB pre-trigger, 15.2MB post-trigger
• 75% post-triggering: 4MB pre-trigger, 12MB post-trigger
• 50% post-triggering: 8MB pre-trigger, 8MB post-trigger 
• 25% post-triggering: 12MB pre-trigger, 4MB post-trigger
• 5% post-triggering: 15.2MB pre-trigger, 0.8MB post-trigger

Note:  When a Trigger occurs, recording continues until the post-Trigger 
amount of the buffer is filled or the Stop Recording button in the GUI is 
pressed..

Save As 
Multi- 
segment 
Trace

This option causes the analyzer 
to segment the trace into 
multiple files and create an 
index file called data.mlt that summarizes the starting and finishing frame for each 
segment. 

This option is useful for very large recordings and for host PCs with limited memory.  In 
the latter case, multi-segmenting gives a PC with limited memory a way to open 
recordings that would otherwise be too large to open. 

The only downside to multi-segmenting is that it limits the scope of reports such as Traffic 
Summary, Bus Utilization, and Error Summary to each of the segments.  You will not be 
able to perform summary statistics on the full recording.

The default value for this option is 10 MB.  Before attempting large recordings, it is 
recommended that you adjust this number to see what value best suits your needs. 
based on the capabilities of your host PC.  

To create a multisegmented trace,

Step 1 Check the box marked  Save As Multisegmented Trace.
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Step 2 Set the file size for each segment in the box marked MB Segments.  

File Structure for Segmented Files
Multisegmenting produces an index file and subordinate trace files.  The default name of 
the index file is dataXYZ.smt, where XYZ is the last three digits of the analyzer’s serial 
number.  (You can see the unit’s serial number by selecting Help > About SASSuite)  
Thus, for example, if you had an analyzer with the serial number 111, the index file would 
be called data111.smt.

The index file and the segmented trace files are stored in a directory named after the 
index file.  The directory is named indexfilename_smt_files.   For example, if the index 
file is named data111.smt, the directory will be named data111_smt_files.  Below this 
directory additional, sequentially numbered sub-directories (up to 100,000) that house 
the segmented trace files.  These sub-directories bear simple numerical names: 00000 - 
00999.  Each of these subdirectories can hold up to 100 sequentially-numbered segment 
files.  Collectively, the entire directory structure can hold up to 10 million files.

Example
A 1010 MB recording using 10 MB segments and the default file names will create the 
following sub-directories and files.  The example below uses the serial number 111:

• data111.smt   This is the index file.  
• data111_smt_files\00000\segment_00000.sas
• data111_smt_files\00000\segment_00001.sas 

...

• data111_smt_files\00000\segment_00099.sas
• data111_smt_files\00001\segment_00100.sas
• data111_smt_files\00001\segment_00101.sas

The index file looks something like a trace file but contains packet-like entities that 
summarize each 10 MB segment.

  

When uploading is complete, the index file will be opened.  Each "packet" in this file 
corresponds to one of the numbered segments.  Double clicking on the packet will open 
the corresponding segment file.
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Multisegment Toolbar 
When an index file is opened like the one shown above, the 
Multisegment Toolbar will display.  This toolbar lets you navigate the 
index file.  

Channel Settings
The Channel Settings page lets you to set speed, descrambling and packing options for 
each channel.  It also lets you inhibit channel recording.

Open first segment in 
multisegment trace.

Open previous 
segment in 
multisegment trace.

Open index file.  This 
button becomes 
active if a 
multisegment trace 
file is open. 

Open next segment 
in multisegment 
trace.

Open last segment in 
multisegment trace.
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Speed 
Settings

The Avalanche systems are designed to support Autodetect Link Rate which is designed 
to pass through the speed negotiation signaling allowing the initiator and device to 
determine the link speed using the method defined in the SAS specification. In general, 
this is the most convenient setting to use because it ensures the traffic will get recorded 
at the negotiated rate. Alternatively, users may force the analyzer to record at the 1.5G, 
3G or 6G rate. However, if the negotiated link speed is higher or lower than the speed 
selected in this tab, analyzer will not decode the traffic properly (there will be errors in the 
trace). The user will know if devices are negotiating successfully by getting clean 
recordings.

Channel 
Settings

These options allow you to inhibit recording and turn off scrambling on a channel by 
channel basis.

Inhibit - Inhibits recording of traffic from selected channels.  For example, if you check 
the option for T1, it means "record all channels except for Target channel 1 (T1)."

No Descrambling - Turns off the analyzer’s descrambling from the selected channels.  
Select this option if your DUTs are not scrambling their traffic.

 

Triggering/Filtering
The Triggering/Filtering page allows the user to define triggers and filters that can be 
simple or quite complex.  

The SASSuite application provides a menu-driven interface for building triggers and 
filters. The interface prompts you for simple decisions and choices from drop-down 
menus. As you make your selections, the script takes shape automatically in the scenario 
window. The script is in the form of simple English sentences. You need not understand 
any formal scripting language.
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Selecting the Triggering/Filtering tab brings up the following screen:

Building 
Filters

The top section of the screen, labeled "Global Filtering", is used to build filters.  Filters are 
definitions of commands or data types that may be present in the traffic, that the user 
does NOT want to include in the trace recording.  For example, some of the traffic that 
takes place in a SAS or SATA link might be simple primitives, and for high-level routines 
these primitives simply occupy space in the trace without providing any useful information 
to the programmer.  Alternatively, a busy link might include traffic between multiple 
devices, and if a problem is being experienced with one device, traffic from other devices 
simply fills up the analyzer buffer without providing useful information to the user.  In such 
a case, data recording can be limited to traffic involving only specific devices, although 
this capability is accessed in the Channel Settings tab as noted earlier.

To begin to build a filter, simply click on the link which says "Click here to add filter 
condition".  The following screen appears:
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This screen displays five filter conditions which can be selected by the user.  Selecting 
any one of these conditions brings up screens with additional information.

SAS Primitive
Selecting SAS Primitive allows the user to filter on one or more SAS Primitives from the 
data stream.  Clicking this type brings up a detailed screen as follows:
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The user may click on any specific primitive in order to exclude it from the recorded trace.  
Primitives are organized in a "nested" hierarchy, so for example the user may click on the 
AIP checkbox to exclude all AIP primitives, or may expand the selection by clicking on 
the "+" sign next to the AIP, which opens a list of specific AIP primitives and allows the 
user to specify only specific primitives such as the AIP (WAITING ON DEVICE).

Note:  Clicking on a collapsed set of primitives selects (or deselects) all 
primitives in that set, and clicking on the "master" primitive selects 
(or deselects) all primitives in that set even if the list is open.

Note:  In all screens with multiple checkboxes, a global select or global 
deselect option is provided by using CNTL-Click (holding down the 
CNTL key while left-clicking the checkbox). So the simplest method 
to exclude all SAS primitives is to open the SAS Primitives type, and 
then CNTL-Click on any checkbox to select the entire list.

Note:  If you wish to edit or delete an event or action while editing Global 
Filtering, Global Rules or Sequences, you can right-click on the 
event and you will be given the choice to edit or delete the 
event/action.  You can also edit the event or action by 
double-clicking on the event or action.

SATA Primitives
Filtering on SATA primitives is exactly analogous to the SAS Primitives described above, 
with the exception that there is no nesting structure provided for the more limited set of 
available SATA primitives.

IDLE
Filtering on IDLE characters can be controlled by clicking on "Idle" under the Filter 
Conditions Type list.  This brings up the following screen:

By default, once this condition is selected all IDLE characters are filtered on all channels.  
If the user wishes to change this default setting, individual channels can be deselected 
(or again, all channels can be deselected with one CNTL-Click on any checkbox).

SATA XXXX
Any SATA traffic which follows a SATA_CONT primitive is "filler" traffic to keep the link 
alive and active, until a valid SATA primitive (other than ALIGN) is sent to the receiver.  
This filler traffic is referred to as "SATA XXXX".  In most cases this traffic is of no interest 
and can be filtered out of the recorded trace.  Selecting this option brings up a screen 
very similar to the IDLE screen shown above, where the user can decide which channels 
to deselect.
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OOB Signal
By selecting this option, the user can control the recording of OOB (Out of Band) traffic, 
which may not be of interest to some users.  Clicking on this item brings up the following 
screen:

By default, OOB traffic (including COMINIT, COMWAKE and COMSAS) is recorded on 
all channels.  Through changing the checkboxes on this screen, the user can exclude 
OOB traffic of certain types of specified channels from the recording.

Additional Filtering Capability
Note that under a broad definition of "filtering" (i.e., any user selections that prevent all 
data traffic from being recorded into the trace memory buffer), we have already described 
(in other sections) selections which can be made which result in filtering of various types.

For example, under the General screen, data payloads can be truncated after a specified 
number of Dwords to limit the amount of data which occupies trace memory.

Also, in the Channel Settings screen, individual channels can be selected to be recorded 
or not to be recorded, as the user wishes.  This is also a type of filtering.

Global Rules And Sequences
In addition to the filtering functions described above, the Triggering/Filtering screen 
provides a means for developing logical sequences of actions based on events that 
occur.  One example of this is to create conditions that generate a trigger.

Creating a trigger condition can range from an extremely simple exercise that requires 
only one condition to be met, to a complex series of multiple events with precise timing 
requirements all of which must be met before a trigger is issued.  Why would so much 
sophistication be needed in developing a trigger?  The answer lies in the type of problem 
being pursued by the user.  For initial development, recordings may be made without 
triggers at all.  Simply start the analyzer, run the test, and look at the traffic that resulted.  
As the system becomes more sophisticated, the user may need to add simple triggers to 
enable the analyzer to focus on the data of interest in the midst of continuous, unrelated 
traffic.  Finally, when pursuing rare or intermittent bugs, the user may need to trigger on 
a complex series of events that occurs either shortly before or after the problem of 
interest. 

The Avalanche system is well equipped to manage all these types of issues, providing 
novice users with a simple mechanism to generate simple results, and allowing 
engineers the flexibility to develop sophisticated state machines to extract critical data 
from heavily loaded communication channels.

The Avalanche system supports three independent state machines, which can be easily 
"programmed" using simple menu selections which result in clear and well-defined 
instructions which can be read "in simple English".
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The first state machine supports only one state which is always active, and therefore is 
referred to as the "Global Rules".

The two remaining state machines allow for multiple states with branching between the 
various states, and allow for multiple conditions and/or multiple actions at any stage.  
These state machines are called "Sequence 0" and "Sequence 1".

Creating Avalanche sequences is easy, but it requires an understanding of the following 
terms: event, combined event, action, global rules, sequence, and state.

You can think of the Global Rules and each sequence as separate test routine or program 
operating simultaneously. Each operates independently and in parallel with the others. 
The purpose of each is to detect events and then respond with the appropriate action or 
set of actions. In essence, they allow you to operate up to three test states simultaneously 
within Avalanche.

Building 
Global 
Rules

The best way to understand how to use Global Rules is to start with a simple example.  
Suppose we wanted to define a trigger that would be issued whenever a CRC error was 
detected on any channel. 

Term Definition

Event Condition that is detectable by Avalanche.

Combined Event Logical OR association of events (for example, event A or event B).

Action Avalanche response to an event or combined event.

Global Rules A single defined Avalanche test state (always active).

Sequence Single or multiple defined Avalanche test states. More flexible than the Global Rules, a 
sequence allows more powerful scenarios that include branching and looping between 
test states (the Global Rules can define only a single test state, so there is no 
branching).

State "Behavior" of the Global Rules or a sequence at any point in time. In terms of Avalanche, 
behavior is "waiting" for a certain set of events and responding with a certain set of 
actions.
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We would bring up the Triggering/Filtering screen (via the Setup menu, selecting 
Recording Options (Avalanche)..., then clicking the Triggering/Filtering tab), as 
follows:

Under Global Rules, click on the "<Click here to add an event>" link.  A list of available 
events appears.  Click on the Event Type "Error", and the following screen appears:

Click on the CRC Error checkbox, and then click on the OK button at the bottom of the 
screen.  The Trigger/Filtering screen now shows:
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Note that the Global Rules now has the event "Wait for CRC Error" listed, but since there 
is no corresponding action defined, the bar at the top has changed from green to yellow 
to indicate an incomplete command, and there is a yellow dot next to the incomplete 
command.

To complete the command, click on the link that says "<Click here to add an action>", and 
select "Trigger" from the list of available actions.  The action screen now shows:

Note that you have the option to define a trigger to happen after "N" occurrences of the 
event (in this case, after N CRC Errors), but for now we will leave the value at the default 
setting of "1" and click the OK button.

Note:  All actions have the parameter "After Nth occurrence" where N can 
be set to a number greater than or equal to one.  If N is set to three, 
this does NOT mean that the action will happen three times.  
This means that the event which calls the action must occur three 
times before the action happens one time.

Our Global Rule now reads:
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Finally, we decide to have the system beep so that we know that the CRC Error has 
occurred and the system has been triggered.  So click on the link which reads "<Click 
here to add another action>", select "Beep" from the list of available actions, and click 
OK.  The completed Global Rule now reads:

In this simple example, we have demonstrated how easy it is to add events and actions 
to sequences, including places where we want multiple events or actions to be included.

The available events and resulting actions that can take place are discussed in detail 
below.

Multiple Parallel Events
When multiple events are defined in Global Rules, the events are operating in parallel 
and will continue to remain active (even if they have occurred one or more times) until 
recording is stopped.  In the example below, three different events have been defined 
which will all cause an action on the " EXT OUT" SMA output at the rear of the unit.  In 
addition, one event (a SCSI HARD_RESET primitive) will alert the user with a beep.  As 
long as recording continues, these events will continue to cause their defined outputs on 
the "EXT OUT" SMA output and/or beeper.

Building 
Sequences

Sequences differ from Global Rules in that sequences may have multiple states defined, 
although only one state within a sequence is active at any given time.  However, all 
events within that state are active and operating in parallel. This allows for branching and 
looping between states, where State 0 (which is always the starting state) can call 
another state depending on a specified sequence of events, and that state can in turn call 
a different state, or can call the original state.
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Note:  There is an upper limit of 256 states that can be defined within any 
one sequence.

Note:  Sequences allow a state to contain multiple conditions that result in 
branches to different other states.  For example, if event A results in 
a branch to State 2, and event B results in a branch to State 3, then 
the sequence will branch to either State 2 or State 3, depending on 
which event occurs first.

As another simple example to explain how this works, suppose we want to create some 
type of handshake between an Avalanche unit and an external device.  We want the 
Avalanche unit to look for a SCSI Check Condition, inform the external device when one 
is detected, and then allow the external device to complete some task before starting to 
watch for the next Check Condition.

We can create this sequence as follows.  First, open the Triggering /Filtering window by 
selecting Recording Options (Avalanche)... from the Setup menu, and then click the 
Triggering/Filtering tab. The screen shows the following:
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In this case, since we want to create a sequence that has multiple states, we will click on 
"<Click here to add a sequence>".  The screen displays the following:

The new sequence has been added (Sequence 0) and a default starting state (State 0) 
has been created.  To create the logic of the sequence, in the section under State 0 click 
on "<Click here to add an event>" and a list of possible events appears.  In the event type 
list, we select "SCSI Status" and in the drop down list that appears, we select "Check 
Condition", as follows:
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Click "OK", and the Sequence 0 we are building now looks as follows:

Note again that the existing of a event without an action to complete the state is flagged 
by the yellow bar along the top and the yellow dot to the left of the incomplete command.

To complete State 0, we need to select an action, so click the link "<Click here to add an 
action>" and select "SMA Output", then in the drop-down list of outputs select "Send 
Positive Pulse", as follows:

Click OK, and State 0 now reads as follows:
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However, we don’t want this action to just happen once, we now need the system to wait 
for a response from the external system when it is ready for the next Check Condition.  
So click on the link next to "Send Positive Pulse" that reads "<Click here to add another 
action>" and select "Branch to new state" from the list of actions.  The screen now shows:

The default values provided of branching on the first occurrence and branching to State 
1 are what we need, so click OK and the sequence we are building now looks as follows:

A new state, State 1, has automatically been added, and now we are ready to tell the 
State 1 what to do when the external device is ready to process another SCSI "Check 
Condition" status.  So first click on "<Click here to add an event>" (under State 1), and 
select "SMA Input" and click on the checkbox next to "Positive Pulse", as follows:
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Click OK, and the sequence now reads:

To complete State 1, click on "<Click here to add an action>" and select "Branch to 
Existing State", and then select State 0 from the drop-down list of available states, as 
follows:

Click OK, and the completed sequence now reads as follows:
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Note that the sequence we have created contains two defined states:
• State 0 is the starting state, which watches traffic passing through the 

analyzer to detect a SCSI Check Condition on any channel.  Once the Check 
Condition is detected, the analyzer issues a positive pulse to an external 
device and branches to State 1.

• State 1 is a waiting state, which watches for a positive pulse to return from 
the external device before doing anything else.  Once the external device 
signals that it is ready to process the next Check Condition, the external 
device sends a positive pulse to the analyzer, which causes it to return to 
State 0 and begin the process again.

Note:  Only one state within this sequence is active at any time.  The two 
states form a loop, first watching for the Check Condition and then 
waiting for a response from the external device.  While in State 1, 
traffic will be recorded but any SCSI Check Condition that occurs will 
be ignored by the analyzer since State 0 is not active at that time.  
The sequence will continue to loop until some manual intervention is 
used to stop the analyzer from continuing to record (e.g., the Stop 
Recording button is clicked).

With this simple example, we have demonstrated how sequences can contain multiple 
states, and how branching and looping can occur between various states within a 
sequences.

Multiple Parallel Events within a State
If multiple events are defined within a state, all events are simultaneously active and 
operate in parallel as long as that state is active.  Once a branch to another state occurs, 
all events in the first state cease to be active.

There is one exception to this rule due to a special event ("State Entrance") which is 
intended to provide a one-time action or set of actions that occur only when the state is 
initially entered.  Among other applications, this can be useful for following which state 
the system is in at any given time (e.g., you can have the system beep when it enters a 
particular state).

Multiple Parallel Sequences
Again, note that within a given sequence only one state is active at any given time, but 
different sequences can be simultaneously active.  There can be three simultaneously 
active processes, which are as follows:

• Global Rules (which has only one state)

• Sequence 0 (which can contain multiple states)

• Sequence 1 (which can contain multiple states)
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Events For either Global Rules or Sequences, there is a 
list of event types that you can choose from, 
which is presented to you each time you "Click 
here to add an event".  With one exception (see 
below), the list of events is identical between 
Global Rules and Sequences.

The events are explained in more detail in this 
section.
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SAS Primitive
The SAS Primitive event screen allows you to define one or more SAS primitives which 
must be detected in the traffic in order to generate an action. This screen selection is 
directly analogous to the SAS Primitive selection described in the Filtering section.

The detection of SAS Primitives can be limited to certain channels by selecting the 
appropriate channels across the top of the screen,  By default, all channels are selected.

All SAS Primitives are listed using a nested hierarchical structure, in which groups of 
related primitives can be selected with a single checkbox, or the nested hierarchy can be 
expanded by clicking on the [+] symbols to select individual primitives within a group. 

Note:  As with other screens, a shortcut method of selecting or deselecting 
all channels or all primitives is provided by using CTRL-Click on any 
checkbox.
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SATA Primitives
SATA Primitives can be selected in a similar manner, with the slight exception that the 
list of primitives does not use a nested hierarchical structure.

Timer
The timer event allows the user to insert a specified delay.  The Timer event screen 
allows the user to select a delay between 50 ns and 50 years, by selecting an appropriate 
value from the dropdown menu.

An example of how the timer event might be used is shown below.  In this example, the 
analyzer waits to detect a CREDIT_BLOCKED primitive, then beeps to alert the user and 
triggers the analyzer. If the condition is not detected within 30 secs, the analyzer will 
trigger to stop the test.
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Recording Start/State Entrance
In the list of events for Global Rules, this event is listed as "Recording Start", since Global 
Rules have only one state and it begins at the start of recording.  For sequences, this 
event is listed as "State Entrance".

These events are used for special actions which the user only wants to occur once, when 
the state is first entered.  Some examples have been given earlier where the user might 
want a beep as an alert when the system enters a specific state, but the concept is 
general and there may be an entire list of actions that the user wants to occur when a 
state is entered, but then not remain active while the system remains in that state.

The "Recording Start" and "State Entrance" events have no other parameters associated 
with the event.

FIS
The FIS Event allows the user to specify virtually any parameter associated with any 
SATA FIS (Frame Information Structure).  There are several types of FIS formats, and 
the drop-down list under "FIS Type" allows the user to select the FIS format of interest.

With the selection of the FIS Type, the fields associated with that FIS Type will appear as 
a list below the type, and the user may enter any value for any of the defined fields.
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ATA Command
The ATA Command Event allows the user to specify any ATA command that might be 
present in the data stream.  Selecting this event type provides a drop-down list of ATA 
Commands that can be selected.

SMP Frame
The SMP Frame event allows the user to specify any SMP (Serial Management Protocol) 
Frame.  As with other frame descriptors, drop-down menus are supplied where 
appropriate and the user may enter specific data values for appropriate fields in the frame 
structure.
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Data Pattern
The Data Pattern event allows the user a generic way of defining a match to any part of 
a frame, starting with the first Dwords that follow the SOF.  This event will match values 
a specific distance into the frame (number of Dwords) with the value(s) provided by the 
user.

OOB Signal
The OOB Signal event allows the user to specify either the occurrence or the completion 
of the three OOB (out of band) commands, COMINIT, COMWAKE, and/or COMSAS.
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SMA Input
The SMA Input event is used to detect triggers and other TTL transitions that occur on 
the "EXT IN" connector at the rear of the unit. 

Note that the TTL transition that occurs can be of several different types, including 
remaining at a given value.  In addition, there are minimum and maximum durations that 
can be selected for each type of transition, ranging from 0 to 1.5 usec for minimum pulse 
length, and from 0 to 25 usec for maximum pulse length.

BOB Input - TRIG
The BOB (Breakout Board) Input trigger events come from signals connected to the 
Breakout Board (which is in turn connected to the analyzer via the Data In/Out connector 
on the back of the unit).  The BOB Input - TRIG events have identical parameters to the 
BNC Input event described above, with the additional parameter that since there are two 
separate triggers, an extra parameter (called "Trigger Source", with allowed values of 
"Input 0" and "Input 1") is provided.

Error
The Error event is a series of errors that can be selected individually or in combination, 
as shown below:
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SCSI Status
The SCSI Status event allows the user to specify a number of high level SCSI conditions, 
shown in the drop-down list illustrated below:

SCSI TaskMgmt Function
The SCSI TaskMgmt Function Event provides a series of SCSI task management 
functions which can be selected from a drop-down list, as shown below:

SSP Information Unit
The SSP Information Unit event provides a flexible and powerful way for defining virtually 
any type of SSP (Serial SCSI Protocol) event.  Selecting the SSP Information Unit event 
provides a screen that includes a drop-down menu to select the type of SSP IU, as shown 
below:
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The screen also includes a complete list of fields in the SSP frame, allowing the user to 
specify values for specific fields.  Scrolling down this list reveals the COMMAND Fields 
parameter, as follows:

Clicking on the gray box on the far right brings up a screen where individual bits can be 
mapped into specific command field Dwords, either as a bit pattern or as Mask or Match 
Fields (Hex).
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Identify Address Frame
The Identify Address Frame event provides a list of fields which can be edited to match 
with specific values provided by the user.  Some fields (such as device type) reveal a 
drop-down list of defined selections for that field.

Open Address Frame
Similar to the Identify Address Frame event listed above, the Open Address Frame event 
provides a list of fields which can be edited by the user, with helpful drop-down menus 
for fields with defined selections (protocol and connection rate).
68 LeCroy Corporation



SASSuite User Manual Version 6.2
Actions Once any event (or set of events) has been 
identified, the next step is to define an action (or 
a set of actions) that result from the event(s).  
There are several actions which can take place, 
as shown in the list to the left. (Note:  The 
actions "Branch to Existing State" and "Branch 
to New State" are shown only when building a 
sequence, in which multiple states are allowed.  
If building Global Rules, these options are not 
shown, since Global Rules have only one state.

Trigger
The Trigger action is the most common endpoint of the majority of scenarios.  Triggers 
work in combination with other settings previously described to determine what data is 
actually captured and retained in analyzer memory.  Triggers work, in effect, to stop 
recording, but depending on the settings for the trigger position, recording may not stop 
immediately when the trigger is issued.

The Trigger action has only one parameter, which is the number of time the action must 
be called before the trigger is issued.  This allows the scenario to trigger, for example, on 
the 10th instance that the specific event occurred.  The number of occurrences can be 
selected from a list of options provided in the drop-down menu.

Branch to Existing State
This action is shown only for sequences, not for Global Rules which can contain only one 
state. The Branch to Existing State action provides a means for branching and looping 
within a scenario between different predefined states.

The option of an "unknown state" is provided as a temporary means to include a branch 
to state which has not yet been defined, but if this option is selected the Triggering/ 
Filtering screen will identify this as an error in the script until the new state is defined and 
the user returns to and corrects this "dead end".

Also note that the option is provided, as with all actions, of the event needing to happen 
multiple times before the action actually occurs.
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Branch to New State
This option is shown only for sequences, not for Global Rules which can contain only one 
state. The Branch to New State action is similar to the Branch to Existing State action 
defined above, however this option automatically create a new (but empty) state in the 
scenario. If there are currently "n" states in the scenario, the new state will be "State N" 
(because states always start with State 0).

Beep
The Beep action produces an audible beep to alert the user to various events that have 
occurred.  The beep can be specified as a duration of 250 ms or of 1 sec. Multiple beeps 
could be created in a sequence by branching to a new state which waits for a short time 
and then issues a second beep.

SMA Output
The SMA Output action produces a signal to an external device.  The type and duration 
of the signal can be controlled by the parameters listed in the action, as follows:

The signal created by the SMA Output action appears as a TTL level signal on the "EXT 
OUT" connector at the rear of the Avalanche unit.  

BOB Output - TRIG
The BOB (Break Out Board) Output -TRIG action produces a TTL level signal on one of 
the two outputs on the breakout board (which is connected to the analyzer via the Data 
In/Out connector at the rear of the unit).  The parameters associated with this action are 
identical to the BNC Output action described above, with the addition that since there are 
two outputs on the breakout board, there is an additional parameter of "Trigger 
Destination" with the allowed values of "Output 0" or Output 1".
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Recording Options - Channels
The Channels page allows the channel names to be customized.  To change a channel 
name, select the channel, then click the edit button and enter the new text, then click OK.  
Once the options are set, the analyzer will update the open trace and all future traces with 
the new channel names.  

Note:  You can also change channel names by clicking on the first cell of a 
trace (the channel cell) and selecting Rename Channel from the 
pop-up menu.

Where 
Custom 
Channel 
Names 
Appear

Custom channel names appear in three places:  
• The trace itself

• Link Tracker window

• Bus Usage window  
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Custom Channel Names in the Trace - Custom channel names do not appear right 
away in the trace:  the original names continue to display.  To see the custom channel 
names, click in the first cell of the trace (the channel cell) and select Format from the 
pop-up menu, then select Custom. 

The custom names will then appear in the trace.  

Custom Channel Names in the Link Tracker Window - The Link Tracker window will 
automatically show custom channel names as soon as they have been customized. 

Custom Channel Names in the Bus Usage Window - Custom Channel names 
automatically appear in the Bus Usage window as soon as they have been customized.  
The easiest way to see this is to open the Bus Usage window and then to open the 
Properties dialog for the window.  It will list the custom channel names.

Channel I1 renamed as Init_1.
72 LeCroy Corporation



SASSuite User Manual Version 6.2
To open the properties dialog box for the Bus Usage window, right-click in the window, 
then choose Properties from the pop-up menu.  

Saving and Loading Recording Options
Once defined, a set of recording options cam be saved as a file on disk for later use.  
Included in this file are all settings for all four screens that appear under the recording 
options selection, including General, Channel Settings, Filtering/Triggering, and 
Channels.  Included in this information will be all filtering criteria, Global Rules, and any 
defined sequences.

To save a set of recording options, have the recording options window open (with any 
tabbed page showing), and click on Save... at the bottom of the screen.

Clicking on Save... will bring up a window allowing the user to name the file and navigate 
to any folder that he wishes to use to save the file.

To reload a saved recording options file, click on the Load... button and select the file.

If you would like to define a set of recording options as the default for the system, once 
the recording options are correctly defined click on the Save As Default button.
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Chapter 5:  SASTracer Recording 
Options
Recording options provide instructions for the analyzer hardware as to how a trace 
recording should be captured.  Included in these instructions are items such as how to 
start or stop a recording, what information should be recorded, and trigger conditions that 
can be used to automatically record certain data events (or sequences of events) when 
they occur.

Since these instructions are specific to the hardware platform being used, there are  
differences in the way the recording options are set up for the Avalanche system vs. the 
SASTracer system.  In order to present this information clearly, we have divided the 
information into two Chapters in this User Manual.

This Chapter covers recording options for the SASTracer systems only.  For 
information on the Avalanche systems, see Chapter 4.

General Recording Options
From the Setup menu, select Recording Options (UPAS 10K)... . The following screen 
is displayed:

Options displayed on the General page include the following:
• Recording Type

• (Recording) Options

• Recording Scope, including Buffer Size and Trigger Position for conventional 
recordings, and recording parameters for spooled recordings
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• Options Name

• Trace Filename & Path

• Misc Information

Recording 
Type

The Recording Type box presents three options that control how SASSuite begins and 
ends a recording. The options are Snapshot, Manual Trigger, and Event Trigger.

• Snapshot: A fixed-length recording.  A Snapshot is a recording whose 
size is set via the "Buffer Size" box. Recording begins when the Start 
Recording button   is clicked and ends when either the preselected 
buffer size is filled or the Stop Recording button  is pressed. 

• Manual Trigger: A recording whose ending is triggered by pressing the 
Trigger button on the front panel.  Recording begins when the Record 
button  is pressed  on the Tool Bar. Recording continues in a 
circular manner within the limits set by the buffer size. Recording is 
ended by the user pressing the Trigger button on the front panel, 
although in some cases recording may not stop immediately.  Once the 
Trigger button has been pressed, recording continues until the 
post-trigger buffer has been filled (see Trigger Position below) or the 
Stop button   is clicked on the Tool Bar.

• Event Trigger: A recording whose ending is triggered by user-defined 
events. Recording begins when the Record button   is clicked on 
the Tool Bar.  Recording continues in a circular manner within the limits 
set by the buffer size until a trigger event is detected and the defined 
amount of data has been recorded after the Trigger event.

Options The options checkboxes appear on the upper right side of the General tab of the 
Recording Options window. 

• Truncate Data Payload Dwords:  Allows data payloads to be 
truncated to whatever length is specified in the box.  Truncating the 
payload limits the amount of space each frame requires to be stored in 
the buffer, thereby increasing the number of frames that can be 
recorded.

• Beep When Trigger Occurs: When this checkbox is selected, the 
computer connected to the SASSuite beeps three times to alert the 
user when a Trigger condition is first detected.

Recording 
Scope

Recording Scope presents two important options that affect the size or scope of the 
recording.  These options are Spooled and Conventional recordings.  The Spooled option 
enables very large recordings--for example, several hours.  The Conventional option is 
used for smaller recordings--for example, several minutes.

Conventional Single Buffer Recording
In a Conventional recording, the trace is recorded and stored in the analyzer buffer before 
it is uploaded to the host PC.  Recordings are thus limited in size to the maximum size of 
the analyzer buffer.  If you are planning to create a moderate-sized recording, this is a 
good option to select.   You set the buffer size and the trigger position, then begin the 
recording.  Once the recording is complete, the traffic is uploaded to the host PC.
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If you are planning to create a large recording or are planning to let the analyzer run over 
a several days, then select Spooled Recording.  In a Spooled Recording, traffic is 
uploaded periodically to the host PC--thus freeing analyzer buffer and allowing the 
recording to continue.

Buffer Size - The Buffer Size slide bar adjusts the 
recording buffer size from 1.6 megabytes to 2048 MB.    
This option is used for setting the maximum memory to be 
used for a Conventional recording.

The option mentioned above for truncating data payloads, 
as well as filtering options which will be discussed later, 
determine what information from the raw data stream is actually recorded into trace 
memory. Also, although there are 2048 MB of physical memory in the SASTracer 
analyzer, there is additional information recorded with each frame, such as timestamps 
and other system parameters, so the efficiency of the recording ranges from about 37% 
in the worst case to 75% in normal traffic and higher when packing is possible (ratio of 
physical memory to actual SAS or SATA traffic).  

Note:  The Buffer Size slider bar is not linear and affords more granularity in the 
smaller buffer sizes. 

Trigger Position - The Trigger Position slider bar 
allows the user to define the position of the trigger 
within the recorded traffic.  Essentially, this is 
instructing the system when to stop recording.  If the 
trigger position is set to the end of the recording, 
recording will stop immediately when the trigger 
occurs.  If the trigger is set to the start of the recording, 
when the trigger occurs the system will continue to record until the buffer has filled again 
and then stop (before the new data overwrites the trigger).  Any intermediate setting 
allows the user to see data both before and after the trigger occurred. You can adjust the 
Triggering Position between 1 and 99% post-Trigger. Trigger Position is available only 
when Manual Trigger or Event Trigger is selected as Recording type.

As an example, if the buffer size is set to 16MB, then for the following Trigger Position 
settings, the amount of pre- and post-Trigger data is:

• 95% post-triggering: 0.8MB pre-trigger, 15.2MB post-trigger
• 75% post-triggering: 4MB pre-trigger, 12MB post-trigger
• 50% post-triggering: 8MB pre-trigger, 8MB post-trigger 
• 25% post-triggering: 12MB pre-trigger, 4MB post-trigger
• 5% post-triggering: 15.2MB pre-trigger, 0.8MB post-trigger

Note:  When a Trigger occurs, recording continues until the post-Trigger 
amount of the buffer is filled.

Note:  The buffer is limited to 1 GB when in trainer mode/configuration.
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Save As Multisegment 
Trace 
This option causes the analyzer 
to segment the trace into multiple files and create an index file called data.mlt that 
summarizes the starting and finishing frame for each segment. 

This option is useful for very large recordings and for host PCs with limited memory.  In 
the latter case, multi-segmenting gives a PC with limited memory a way to open 
recordings that would otherwise be too large to open. 

The only downside to multi-segmenting is that limits the scope of reports such as Traffic 
Summary, Bus Utilization, and Error Summary to each of the segments.  You will not be 
able to perform summary statistics on the full recording.

The default value for this option is 10 MB.  Before attempting large recordings, it is 
recommended that you adjust this number to see what value best suits your needs. 
based on the capabilities of your host PC.  

To create a multisegmented trace,

Step 1 Check the box marked  Save As Multisegmented Trace.

Step 2 Set the file size for each segment in the box marked MB Segments.  

File Structure for Segmented Files
Multisegmenting produces an index file and subordinate trace files.  The default name of 
the index file is dataXYZ.smt, where XYZ is the last three digits of the analyzer’s serial 
number.  (You can see the unit’s serial number by selecting Help > About SASSuite)  
Thus, for example, if you had an analyzer with the serial number 111, the index file would 
be called data111.smt.

The index file and the segmented trace files are stored in a directory named after the 
index file.  The directory is named indexfilename_smt_files.   For example, if the index 
file is named data111.smt, the directory will be named data111_smt_files.  Below this 
directory additional, sequentially numbered sub-directories (up to 100,000) that house 
the segmented trace files.  These sub-directories bear simple numerical names: 00000 - 
00999.  Each of these subdirectories can hold up to 100 sequentially-numbered segment 
files.  Collectively, the entire directory structure can hold up to 10 million files.

Example
A 1010 MB recording using 10 MB segments and the default file names will create the 
following sub-directories and files.  The example below uses the serial number 111:

• data111.smt   This is the index file.  
• data111_smt_files\00000\segment_00000.sas
• data111_smt_files\00000\segment_00001.sas 

...

• data111_smt_files\00000\segment_00099.sas
• data111_smt_files\00001\segment_00100.sas
• data111_smt_files\00001\segment_00101.sas

The index file looks something like a trace file but contains packet-like entities that 
summarize each 10 MB segment.
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When uploading is complete, the index file will be opened.  Each "packet" in this file 
corresponds to one of the numbered segments.  Double clicking on the packet will open 
the corresponding segment file.

Multisegment Toolbar 
When an index file is opened like the one shown above, the 
Multisegment Toolbar will display.  This toolbar lets you navigate the 
index file.  

Spooled Recording
In a Spooled recording, uploading commences when the recording is begun.  As traffic is 
uploaded from the analyzer to the host PC, the analyzer memory is freed, creating space 
for recording additional traffic. Recording can thus continue for long periods of time, and 
create file lengths well in excess of the actual physical memory in the analyzer. However, 
an issue to be aware of with any spooled recording is that the actual spooling process is 
typically slow in comparison to the potential recording speed of the analyzer.  So unless 
the recorded traffic is intermittent or heavily filtered, it is possible for data to be lost if the 
the spooling process does not keep pace with the recording process.  This produces 
"gaps" in the resulting data, which are identified in the data file.

Open first segment in 
multisegment trace.

Open previous 
segment in 
multisegment trace.

Open index file.  This 
button becomes 
active if a 
multisegment trace 
file is open. 

Open next segment 
in multisegment 
trace.

Open last segment in 
multisegment trace.
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Recording Size
With Spooled Recordings, you are given the option of setting the recording length based 
on time or on the recording size.

Record for - Enter the duration of the recording in days, hours, minutes, and seconds.

Record - Enter the amount of traffic (in MB) that you want the analyzer to record.  
Selecting this option will create a fixed length recording that begins as soon as you click 
the REC button on the menu bar.

Until Triggered, plus - Enter the amount of traffic (in time) that you want the analyzer to 
record following an event trigger.  Recording time units are days, hours, minutes, and 
seconds.

Until Triggered, plus  -  Enter the amount of traffic (in MB) that you want the analyzer to 
record following an event trigger.  

You select event triggers in the Recording Rules page -- see “Recording Rules” on 
page 82 for details.

Spooled Recordings - Performance Issues
During a spooled recording if the analyzer buffer fills faster than the trace can be 
uploaded to the host PC, the analyzer will briefly suspend recording until some of the 
buffer is free.  When recording is suspended, gaps will appear in the trace.  These gaps 
will appear as entries in the trace.  

During the recording, you can see if gaps are likely to happen by reading the status bar 
at the bottom of the screen.  

The Status bar has two fields that you can use to determine if gaps are occurring or are 
about to occur.  

Gaps - Shows how many gaps have occurred.  In the example above, two gaps have 
occurred.  

Hardware Buffer - shows you how full the analyzer buffer is and if the analyzer is 
currently dropping packets.  In the example above, Hardware Buffer field shows that the 
buffer is full (shown by the thick green graph) and that the analyzer is currently dropping 
packets (shown by thin red line atop of the green graph.)  

Preventing Gaps
Gaps can be caused by a number of factors - the number of channels being recorded, 
the absence of filtering, the performance of the host PC (for example, is it using USB 2.0 
to upload traffic?), and the amount of traffic produced by the devices under test.

There are several ways to prevent gaps.  You will need to experiment with your setup to 
determine what works best for you.  You might try filtering out primitives, turning on data 
truncation (for example to 10 DWords) and filtering out LISMs.  If you want to record 
primitives, it is recommended that you enable primitive packing.
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Channel Settings
The Channel Settings page lets you to set speed, descrambling and packing options for 
each channel.  It also lets you inhibit channel recording.

Speed 
Settings

The SASTracer systems support Autodetect Link Rate which is designed to pass through 
the speed negotiation signaling allowing the initiator and device to determine the link 
speed using the method defined in the SAS specification. In general, this is the most 
convenient setting to use because it ensures the traffic will get recorded at the negotiated 
rate. Alternatively, users may force the analyzer to record at the 1.5G or 3G rate. 
However, if the negotiated link speed is higher or lower than the speed selected in this 
tab, analyzer will not decode the traffic properly (there will be errors in the trace). The user 
will know if devices are negotiating successfully by getting clean recordings.

Channel 
Settings

These options allow you to inhibit recording and turn off scrambling and packing on a 
channel by channel basis.

Inhibit - Inhibits recording of traffic from selected channels.  For example, if you check 
the option for T1, it means "record all channels except for Target channel 1 (T1)."

No Descrambling - Turns off the analyzer’s descrambling from the selected channels.  
Select this option if your DUTs are not scrambling their traffic.

No Packing -  Turns off primitive and idle packing from the selected channels. 
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Recording Rules
The Recording Rules page lets you set triggers and filters. The page divides into following 
areas:  

• Toolbar - Contains buttons that control the Recording Rules page.  
• Available Events area -- Part of the screen where you can park 

buttons that you intend to use in the Global State Cell.
• Global State Cell -- Part of the screen where you create trigger and 

filter conditions. You create conditions by dragging event buttons from 
the Available Events Area into the Global State Cell and then assign 
actions to the event buttons.  

• Sequence Cell -- The inactive cell marked by the faint text Drag an 
event here to add a new sequence.  Once an event button is placed in 
this cell, the cell becomes active.  The Sequence Cell is used to create 
event sequences - chains of events leading to an action:  If x followed 
by y followed by z occurs, trigger.  Event Sequences are created by 
assigning the action Advance the Sequence to the links in the chain 
and trigger (or some other action) to the final event.

• Rule Status Indicator - An indicator that shows the validity status of 
the current set of recording rules.  When the rules are correct, the 
indicator will display the text Config is valid.  When incorrect, the 
indicator will turn red and display the text Config is Invalid.

• Pop-up Menus (not shown) - Right-clicking on button or area in the 
Recording Rules page will access a context-sensitive pop-up menu 
containing most of the commands listed in the toolbar.
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Recording Rules Toolbar
The Recording Rules toolbar exposes functionality for controlling the Recording Rules 
page.  

Recording Rules Page - How it Works
The Recording Rules page can be thought of as a chalk board where you create a 
graphical model of the events and actions.  In essence, you are creating a visual 
representation of the rules that the analyzer should follow during a recording.

You can create simple or complex rules.

New Event.  Opens a menu of events.  Selecting an 
event causes an event button to appear in the 
Available Events area.  

Delete Event.  Deletes selected event button.

Undo.  Undoes last change made to Recording Rules 
page.  The undo buffer has unlimited depth.

Redo.  Repeats changes undone by the Undo button.

Zoom In.  Enlarges the display.  There are five zoom 
levels.  The default level is the middle one.  If you 
have a wheel mouse, you can also zoom by holding 
down the Control key and then operating the mouse 
wheel.

Zoom Out.  Makes the display appear smaller.  

Show/Hide channels.  When pressed, this button 
tells the Recording Rules dialog to show the channel 
buttons on the Events icons.  When unpressed, the 
channels are hidden.  

Show/Hide Properties Dialog.  Shows or hides the 
Properties dialog of the selected State/Event/Action.

Config is valid.  This message displays when the 
current Recording Rules configuration is valid and 
can be executed by the hardware.  This message 
gets updated every time the Recording Rules 
configuration changes.  When the configuration is 
incorrect, the message is replaced by "Config is 
invalid."

Config is invalid.  This message displays when the 
current Recording Rules configuration exceeds 
hardware limitations.  You can click the indicator to 
get the diagnostics message box to find the 
problem.
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Creating a rule involves three steps: 

Step 1 Select one or more events.

Step 2 Select the channels that the analyzer 
should record.  

Step 3 Assign an actions to the events. 

Selecting 
Events 

Events are selected from the New Event menu:

Step 1 Click the New Event button. 

A menu of Events and Event categories 
displays.

Step 2 Select an Event from the menu.  Once a selection 
has been made, an Event button appears in the 
Available Events area. The Available Events area 
is an inactive part of the window where buttons can 
be parked for future use. 

Selecting a 
Channel on 
an Event 
Button

At the bottom of each event button are small buttons that represent  
analyzer channels.  Selecting a channel button tells the analyzer 
which channels to monitor for trigger and filter events.  

Note that deselecting a channel button does not stop the recording on that channel - it  
merely disables actions such as triggers on the channel.  Thus, if you had set the 
analyzer to trigger on an error but had deselected channel T1, the analyzer would record 
traffic on all channels (including T1) but would ignore any error that occurred on channel 
T1.

To turn off recording for individual channels, use Inhibit Recording option in the 
Recording Options > Channel Settings page.  This option will prevent traffic from being 
recorded into the trace.  

Assigning an Action
Assigning an action tells the analyzer what to do when it has found the targeted event.  If 
you do not assign an action, the analyzer will look for the event but do nothing once the 
event has been encountered.

Assigning an action is a two-step process:  first, move an Event button from the Available 
Events area on the left to one of the two cells in the center of the window.  Then, 
right-click on the Event button and assign an action.

Dragging a 
Button to 
the Global 
State Cell or 
Sequence 
Cell

The center of the Recording Rules 
window is where rules are defined.  To 
create a rule, you must drag an Event 
button from the Available Events area 
on the left to one of the two cells in the 
center of the Recording Rules window.  
The cells in the center control the duration of the rule:  rules created with the Global State 
Cell are always enabled, while rules created in the Sequence cell are conditionally 
enabled.

          To activate an Event button, drag it to the 
                                                    Global State Cell.
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The Global State Cell - The Global 
State Cell tells the analyzer what 
events to look for throughout the entire 
recording.  The cell is called a "Global 
State" because the conditions you 
define in the cell are always active.  
You can place several events in this 
cell.  Doing so tells the analyzer to look 
for all of the events all of the time.   For 
example, you could place three events 
in this cell and have each cause a 
trigger.  Such a configuration would read "If any of the events occur, 
trigger."

Sequence Cell - Sequence cells are marked with the faint text Drag to 
add a new sequence.

The Sequence Cell is 
used to create event 
sequences.  An event 
sequence is a chain of 
events leading to some 
action.   For example, "If 
x is followed by y and 
then by z, trigger."  
Events linked in a chain 
are looked at 
sequentially.  Thus, at 
any given time, the analyzer is often only be looking for a single event 
out of the several that might be in the Sequence cell.  

There can be up to 255 events linked together into a sequence.  Only 
one sequence can be created.

When two or more events have been moved into a Sequence cell, they 
can be linked into a sequence by assigning the action Advance the 
sequence to events in the chain.  The last event in a sequence is then 
usually assigned the action Trigger.  
There are two ways to assign an action to an event button:

• Right-click on an event button and select Specify Action 
from the pop-up menu.

• Double-click on the event button and then select an 
action from the Properties dialog box.

            This configuration reads
   "trigger if any of these events
                                        occur."

An event sequence.  This reads "If a primitive 
               is followed by an error, then trigger."
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Assigning an Action from the Pop-up Menu
To assign an action to an event button via the pop-up menu,

Step 1 Right-click on the button.  A pop-up menu appears:  

Step 2 Select Specify Action and then an action from the sub-menu.  The 
menu closes and the action is assigned.  

Assigning an Action via the Properties Dialog Box

Step 1 You can also assign actions to event buttons via the Properties 
dialog box.  Double-click on an event button to open the 
properties dialog box.  

Step 2 Select the Actions tab.  

Step 3 Assign an action.

See “Types of Properties Dialog Boxes” on page 90 for further 
details on Properties dialog boxes.
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Types of Pop-up Menus
The pop-up menu are context-sensitive and will display different options depending on 
the object you have clicked.

Global State 
Cell and 
Sequence 
Cell Pop-up 
Menus

If you click on the Global State Cell or Sequence Cell (but not one of the buttons inside 
them), you will get the following pop-up menu: 

New Event - Brings up a menu of Event types.  This is the same menu that appears when 
you click the New Event button on the toolbar.

Properties - Brings up the State Properties dialog for the selected state.

Event 
Pop-up 
Menu

If you click on an Event button, you will get the following pop-up menu:  

Specify Action(s) - opens a sub-menu with the following options:

• Trigger - Triggers end of recording.  Recording continues until post-trigger 
buffer is expended.  Buffer settings are controlled by the Recording Options - 
General page.

• Filter Out - Excludes selected traffic from recording. Filtering preserves 
recording memory, thereby extending recording sessions and excluding 
events of little interest.

• Advance the Sequence - Appears only in Sequence Cells and is used to 
create event sequences.  Tells the analyzer to look for the next event in the 
sequence.  

• Filter In - Includes selected traffic in recording.
• External Trigger Pulse HIGH - Sends an 

output signal with a Pulse High format 
through the output ports on the back of 
the CATC 10K.  Pulse High is the 
default format.  Pulse High causes the 
analyzer to transmit a 5 volt, 40 
nanosecond signal.

• External Trigger Pulse LOW - Sends an output signal with a Pulse Low 
format through the output ports on the back of the CATC 10K.  Pulse Low 
causes the analyzer to transmit a 0 volt, 40 nanosecond signal.

• External Trigger Pulse TOGGLE -This format 
causes the analyzer to transmit a signal that will 
toggle with each trigger event between a 
continuous 5 volt signal and a continuous 0 volt 
signal.

Add Counter - Displays the Event Properties dialog with the 
Counter selected and ready to accept the count value.  The 
menu item is not shown if the counter is not applicable to the 
selected event.  If the counter is already specified this menu 
item is replaced with Don’t Use Counter and Change 
Counter Value.

Move Event To - Moves selected event to a different position in the Recording Rules 
window.
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Copy Event To - Copies selected event to a different position in the Recording Rules 
window.

Delete this Event - Deletes the selected Event.  Alternatively, you can use the Delete 
button on the toolbar or keyboard to delete events.

Properties - Opens a dialog box and lets you specify further sub-types (for example, 
types of errors) and additional conditions for the selected event. 

Action 
Pop-up 
Menu 

If you click on an Action button, you will get the following pop-up menu:  

Trigger - Sets or clears Trigger action.

Filter In - Sets or clears Filter In action.  This option 
precludes the use of Filter Out. 

Filter Out - Sets or clears the Filter Out action.  This option 
precludes the use of Filter In.

   Action menu for event in
               Global State Cell.

 Actions menu for event in
                    Sequence cell. 
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Restart All - Restarts any sequences or 
counts you may have set on other buttons.  
The example on the right illustrates how the 
Restart All action works.  This example 
reads "Look for a sequence of five SSP 
Frames and then trigger.  If, however, an 
Error occurs any time before the fifth SSP 
frame has occurred, restart the count". 

External Trigger Pulse HIGH, Pulse 
LOW, Pulse TOGGLE - Causes the event 
send an external signal out through the 
External Out port on the back of the CATC 
10K.  The shape of the signal (Pulse HIGH, 
Pulse LOW or Pulse TOGGLE) must be the 
same for all events sending out such signal.  
This means that if you change the output 
signal for one event, it will automatically change the signal for all other events sending 
output signals.

Properties - Displays the Action Properties dialog for the selected state.

New Events Menu 
To add new Event buttons to the Available Events area, click the New Events button.  A 
menu opens with the following categories:

• Primitives

• Frames

• SCSI Commands

• SATA FIS

• SSP Frame Header

• SSP Information Unit

• ATA Commands

• ATAPI Commands

• SATA Data Pattern 

• SAS Data Pattern

• Bus Conditions and OOB Signals

Restart example.  In this configuration, 
the analyzer will restart its search for a 
sequence of 5 SSP frames if an error is
                                            encountered.

             Second restart example.  In this 
  configuration, the analyzer will restart
    its search for the above sequence of
      events if a SCSI command is found.
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• Errors

• Breakout Board Data

• Timer

 Types of Properties Dialog Boxes
Each cell and button has a properties dialog box that 
allows refinement of the options being set. 

Properties dialog boxes can be opened by: 
• Double-clicking a button or cell.

• Right-clicking a button and selecting 
Properties from the pop-up menu.

• Clicking the Properties button 
on the toolbar. 

Properties dialog boxes exist for all items in the Recording Rules page:  the event 
buttons, action buttons, Global State cell and Sequence cells.

Properties 
Dialog Box - 
General 
Features

Properties Dialog boxes share several features:  an Icon preview, a Label Icon, Channel 
Settings, Negation, Counter, a Pin button, and a Descriptive String.     

Icon Preview - The Icon Preview shows what the button currently looks like.  If you make 
changes to the Channel settings or the Icon Label, these changes will immediately 
display in the Preview.

Icon Label - A text box for labeling the button.  Whatever is typed here will appear on the 
button.

Channels - These controls allow you to select the channel(s) that the analyzer should 
search when it is looking for the event.  

Counter - A counter tells the analyzer to search for x instances of the selected event.  For 
example, if you enter "10," the analyzer will count 10 instances of the selected event 
before it performs whatever action you assign.  There are only two counts available in the 
hardware so if you try to assign more than two, you will get a warning. 
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Note:  Counters can not be applied to events with Filter Actions.  The maximum 
counter value is 65,535. 

Negation - Tells the hardware to match the opposite of the event.  For example, if you 
select NOT for Errors Event, the match will occur on Error types that are not checked.  If 
you select NOT for a SCSI command, the match will occur on any FCP_CMND except 
for the selected one, and also on the selected one if the additional parameters do not 
match.

Pin Button - Allows you to "pin" the Properties dialog box to the application so that it does 
not go away when another object appears such as an event, state or action.

Description String - This area contains a textual description of the event.

Specific Event Settings - The largest part of the Event Properties dialog box.  By 
selecting one or more events from the list, you narrow the range of events for which the 
analyzer searches.  

The options presented in this area vary depending on the selected event.  There are three 
basic formats:

• Checkboxes 

• List

• Pattern Editor
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Checkboxes and Lists present options for you to select from.  Selecting one or more 
option tells the analyzer which event(s) the analyzer should search for.  Examples are 
shown below:  

The Pattern Editor, on the other hand, presents a series of text boxes in which you can 
enter a data pattern (in 8 bit codes) that the analyzer can use as a trigger pattern search.
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The Pattern Editor has two components:  the text boxes themselves, in which a pattern 
can be entered, and pull-down menus.  Pull-down menus are available for some fields.  
By clicking on any field header, users will either be presented with a drop down menu 
(below) or they can enter values in decimal or hex and the string will be converted to 
binary after clicking on a different field.  

Actions Tab - The Actions tab opens a page of options for setting  triggers and other 
actions on the selected events.    

Event Properties Dialog Boxes - Descriptions
Each Event button has a different Properties dialog box and each Properties dialog box 
has a different set of options.  

This section describes the Event Properties dialog boxes and their options.
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To see a menu of events, click the New Events button.  The events are:    

The descriptions below follow the order of events listed in the table above.

Primitives
There are two types of primitive events:  Primitive Categories and Primitives.

Category Event
Primitives Primitive Categories 

Primitives

Frames Open Address Frames 
Identify Address Frames 
SSP Frames 
SMP Frames

SCSI Commands SCSI Primary Command set 
SCSI Block Command set 
SCSI Media Changer Command set 
SCSI Stream Command set

SATA FIS Register Host to Device 
Register Device to Host 
Set Device Bits 
DMA Activate 
DMA Setup 
BIST Activate 
PID Setup 
DataRoute 
Vend FIS: 0xFF

ATA Commands All ATA commands

ATAPI Commands All ATAPI 6/7  commands

SSP Header Fields Command  
Data 
Response  
Task 
Vendor 
Reserved

SSP Information Units Command  
Data 
Response  
Task

SMP Request/Response SMP Request 
SMP Response

Errors

Breakout Board Data

Timer

Bus Conditions and OOB 
Signals
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Primitive 
Categories 
Properties 
Dialog

Presents options for triggering or filtering on various Primitive categories.  If NOT is 
checked, any unchecked primitive category will generate an event match. 

Primitives 
Properties 
Dialog

Presents a menu of Primitive types.  If NOT is checked, any unchecked primitive will 
generate an event match.  

Frames
There are four Frame types in the menu:  Open Address Frames, Identify Address 
Frames, SSP Frames, and SMP Frames.

Open 
Address 
Frames 
Properties 
Dialog

Presents options for triggering and filtering on Open Address Frames.  Within the page 
are the following menus and text boxes:

Protocol:  Any, SSP, SMP, STP

Connection Rate:  Any, 1.5 Gbps, 3.0 Gbps

Source Port As:   Any, Initiator, Target

Pathway Blocked Count (hex):  
Destination SAS Address (hex):  
Source SAS Address (hex): 
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Initiator Connection Tag (hex):
If NOT is checked, any unchecked Frame will generate an event match. 

Identify 
Frames 
Properties 
Dialog

Presents options for triggering and filtering on Open Address Frames.  Within the page 
are the following menus and text boxes:

Device Type:  Any, End Type, Edge Expander, Fanout Expander

SSP Initiator:  Any, Present, Not Present

STP Initiator:   Any, Present, Not Present

STP Initiator:  Any, Present, Not Present

SSP Target:  Any, Present, Not Present

STP Target:   Any, Present, Not Present

STP Target:  Any, Present, Not Present

SAS Address (hex):  Text box for entering an address.

PHY Identifier (hex):  Text box for entering PHY identifier.

If NOT is checked, any unchecked Frame will generate an event match. 
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SSP Frames 
Properties 
Dialog

Presents options for triggering or filtering on SSP Frames.  To specify an SSP Frame 
type, select an item from the drop-down menu.  If desired, you can further define the 
event by specifying a data pattern in the data fields.  To enter a value in binary format, 
use the box marked Bitmask.  To enter a value in  hexadecimal format, use the boxes 
marked Mask (hex) and Match (hex).  If NOT is checked, any unchecked frame will 
generate an event match. 

SMP Frames 
Properties 
Dialog

Presents menus for triggering or filtering on SMP functions.  Two menus are presented:  
Function and Function Result.  The Function Result menu is context-sensitive and 
depends on the menu item selected in the Function menu.  If NOT is checked, any 
unchecked Frame will generate an event match. 

SCSI Commands
There are four SCSI Commands in the menu:  SCSI Primary Command Set, SCSI Block 
Command Set, SCSI Media Changer Command Set, SCSI Stream Command Set.
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SCSI 
Primary 
Command 
Set 
Properties 
Dialog

Lets you specify parameters for the selected SCSI Primary Command Set. To enter a 
parameter, select an item from the drop-down menu.

If NOT is checked, any unchecked SCSI Command Set will generate an event match.   

SCSI Block 
Command 
Set 
Properties 
Dialog

Presents options for triggering or filtering on various SCSI Block Command sets.  If NOT 
is checked, any unchecked command will generate an event match. 
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Media 
Changer 
Command 
Set 
Properties 
Dialog

Presents options for triggering or filtering on various Media Changer Command Sets.  If 
NOT is checked, any unchecked command will generate an event match. 

Stream 
Command 
Set 
Properties 
Dialog

Presents options for triggering or filtering on various Stream Command sets.  If NOT is 
checked, any unchecked command will generate an event match. 

SSP 
Information 
Unit: 
Response 
IU

The SSP Information Unit Events provide a bit-level pattern editor for selecting both SSP 
header fields and payload parameters including SCSI sense key and additional sense 
code patterns. Sense data length and related fields within the Response IU can be 
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accessed using the scroll bars. Entering a data pattern tells the analyzer to wait for the 
specified pattern before triggering.  Checking the NOT box selects the inverse match to 
the data pattern defined.

SATA FIS
There are ten SATA FISs that can be selected from the New Events menu:  Register Host 
to Device, Register Device to Host, Set Device Bits, DMA Setup, BIST Activate, PIO 
Setup, Data, Route, and Vend FIS: 0xFF.

The Properties dialogs for these FISs are similar to one another.  They display data fields 
for entering data patterns on a bit-by-bit basis.  Entering a data pattern tells the analyzer 
to search for the specified pattern.  If NOT is checked, any pattern other than the one 
specified will generate an event match.   The Properties dialog below is for Register Host 

to Device.
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Note that some of the data fields have drop-down menus.  To see which fields have 
menus, position your mouse pointer over the blue field headings.  If the pointer changes 
into a hand, then the heading will present a menu if it is clicked.    

ATA Commands
ATA Commands are presented in a single dialog box.    

ATA 
Commands 
Properties 
Dialog

Presents several options:

Commands - Presents a long list of ATA Commands.  Selecting a command will cause 
the analyzer to search for the selected command.

Features - A text box for entering a value.

Sector Count - A text box for entering a Sector Count value.

LBA Mode - Select the radio button, then enter a value.

Sector/Cylinder/Dev/Head Mode - Select the radio button, then enter values into the 
text boxes.  

 If NOT is checked, any unchecked command will generate an event match.
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ATAPI Commands
Individual ATAPI 6/7 commands can be selected as a trigger event. Resource 
limitations restrict ATAPI triggering to a single channel and to a single ATAPI event.   

ATAPI 
Command 
Properties 
Dialog

To specify ATAPI commands as the recording event, select the command using the 
Operation Code or Command name. Additional ATAPI parameters can be specified by 
entering bit-level pattern in binary or decimal including LUN, transfer length and LBA.  

Bus Conditions and OOB Signals
Bus Conditions and Out of Band Signals are presented in a single dialog box.  

Bus 
Conditions 
and OOB 
Signals

Select from the check boxes to specify the type of Bus Condition or OOB Signal that you 
want the analyzer to search for.  

If NOT is checked, any unchecked condition will generate an event match. 
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Errors
Errors are presented in a single dialog box.  

Errors 
Properties 
Dialog

Select from the checkboxes to specify the type(s) of errors you want the analyzer to 
search for.  If NOT is checked, any unchecked condition will generate an event match.  

Breakout Board Data
Breakout board data are entered into a single dialog box.  

Breakout 
Board Data 
Properties 
Dialog 

The Breakout Board Data properties dialog box lets you specify a bit pattern from a 
breakout board that can be used for triggering.    
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State Properties Dialog
The State Properties dialog allows you to specify the Global state’s caption. To access 
this dialog box, click in the Global State Cell (but not on an Event button).  

Timer 
Properties 
Dialog

Specify the value for the timer in seconds, milliseconds, microseconds, and 
nanoseconds.  The actual timer value is shown below the edit controls and reflects the 
hardware precision capabilities.  The time is rounded up to the next 7.519 nanosecond 
sample, which corresponds to the 133 MHz internal clock frequency.  
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Actions Tab in the Properties Dialog
The Actions tab at the top of Event Properties dialog boxes lets you set the type of action 
that the analyzer will perform once an event has been found.    

Assigning Actions
As shown above, you can double-click an Event or Action button to open the Properties 
dialog box, and then select the Actions tab.  You can then select an action from one of 
the options.

The assigned action will be represented by a button to the right of the 
Event button.

You can also assign an action by right-clicking on an Event or Action 
button and selecting an action from the pop-up menu.
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The following table shows the types of Actions you can select. 

Setting Conditions:  The Role of the Global State Cell 
The Global State cell is the arena in which you 
create triggering and/or filtering conditions. 
The cell is called the Global State cell because 
the conditions you create are active at all 
times. You can think of these conditions as the 
default conditions.  You use the Global State 
cell to create simple condition such as "Trigger when you see an xxx error," or "filter out 
all xyz primitives."

Action Comment 

TRIGGER 

Triggers the end of the recording.  
The end point of the recording is 
determined by the buffer settings in 
the Recording Options General 
page. 

FILTER OUT 

FILTER IN 

Filters traffic in or out of the 
recording - thereby conserving 
recording buffer space. 

Can not be assigned to the events 
with Counters.  

RESTART ALL Reinitializes counters.  
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Example - Creating a Simple Event Trigger
To create a simple condition that is active at all times, place an event button in the Global 
State cell:

Step 1 Click the New Event button.  An Events 
menu opens (shown right).  

Step 2 Select an event from the menu.  The 
event will appear as a button in the 
Available Events area on the left.

Step 3 Drag the event button to the cell 
marked "Global State."

Step 4 Right-click on the button (i.e., not the 
Global State cell).  A pop-up menu 
appears.

Step 5 Select Trigger from the menu.  An 
arrow will project from the error button 
and point to a cell marked Trigger.

Creating Multiple Event Conditions in the 
Global State Cell
When multiple buttons are placed in the Global Cell, it 
creates an "AND" condition or an "OR" condition 
depending on the actions selected.  

Creating an OR Condition - When two or more buttons 
in the Global State cell are assigned the same action, 
the analyzer will search for all of the events and perform 
the action on which ever event it sees first.  The example below illustrates.  It reads 
"Trigger if an error or a primitive occurs".  

Creating an AND Condition - When multiple events are placed in the Global State cell 
and assigned different actions, an AND statement is created.  The example below reads 
"Trigger if an error occurs AND filter out any primitives that occur." 
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Filter In and 
Filter Out

A filter causes the analyzer to filter in or out specified events from the recording. If events 
are filtered out of the recording, they are excluded and not simply hidden from the trace. 
The purpose of filtering is to preserve recording memory so you can conduct longer 
recording sessions and exclude events that do not interest you.

To Filter In or Out traffic,

Step 1 Click the New Event button.  The New Event menu opens.

Step 2 Select an event from the menu.

Step 3 Drag the event into the Global State cell.

Step 4 Right-click on the button.  A pop-up menu opens.

Step 5 Select Specify Action(s)
Step 6 Select Filter Out (for example).

The analyzer is now configured to filter out the selected event. 

Filter In or 
Out 
Everything

The options Filter Out Everything or Filter In Everything allow you to filter all traffic in 
or out of the trace.  These options are intended for a future release to allow you to 
selectively exclude and include traffic from a recording.  

Counting 
Events

In addition to setting triggers and filters, you can also set counters.  A counter is an action 
that allows you to set a trigger based on a count of events. For example, you could use 
a counter to "Trigger following the 16th occurrence of an error."

To use a counter, follow these steps:

Step 1 Select an event from the Select Event menu and drag it to the Global 
State Cell in the center of the dialog box.

Step 2 Click the small channel buttons on the selected Event button to select 
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the channels for the actions.

Step 3 Right-click the event and select Add Counter. A dialog box opens.

Step 4 In the text box to the right of the label Count enter a value. 

Step 5 Make sure the checkbox to the left of the label Count is checked.

Step 6 Click the X in the top right corner of the dialog box to close the dialog. A 
counter button should appear below your selected event.
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Creating Event Sequences
Event sequences are chains of events leading to some action. A sequence is a 

multi-event "if, then" condition:  "If x followed by y followed by z occurs, trigger."  Event 
sequences are created by dragging two or more buttons into the Sequence cell.  The 
Sequence cell is a faintly marked cell just below the Global State cell.  The Sequence cell 
contains the text Drag an event here to add a new sequence.  

Note:  Event sequences can only be created in the Sequence cell.  You cannot 
create a sequence in the Global State cell. 

States Sequences are made up of cells called States.  A state is a stage within a sequence that 
specifies what events the analyzer should look for and what actions to apply when the 
event occurs.

In the example below, the Sequence is composed of two states.  The maximum number 
of states a sequence can support is 255. 

The foregoing example reads:  "Trigger if you see a Primitive followed by an error."  

How to 
Create an 
Event 
Sequence

To create an event sequence, you drag event buttons to the Sequence cell,  link them 
with the action Advance the Sequence, then apply a trigger or other action to the end of 
the chain.  The following steps illustrate how to create an event sequence.

Step 1 Click the New Event button.  The New Event menu opens.
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Step 2 Select an event type from the menu, for example an error.  A button 
appears in the Available Events area.

Step 3 Click the New Event button and select a second event type, for example 
a Primitive.  At this point, you should see two buttons in the Available 
Events area.  

Step 4 Drag the first button to the cell marked "Drag an event here to create a 
sequence."  When you finish, notice how two new cells appear in the 
window as shown below the cell where you placed your button. 

Step 5 Double-click on the button.  A Properties dialog box opens.  

Step 6 Select desired options from the dialog box, for example an error 
sub-type.  The options apply immediately.  

Step 7 Close the Properties dialog box by clicking the X in the top right corner.  
The Properties dialog box closes.

Step 8 Drag the second event button to the cell immediately below the cell 
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occupied by your first event button.  Note that an additional cell appears 

marked "Drag an event here to add a sequence."

Step 9 Right-click on the first event button.  A pop-up menu appears.  

Note:  Be sure to click on the button itself and not the cell.  If you click the cell, 
you will get a different menu with fewer options.

Step 10 Select Specify Actions.  Notice 
how this menu differs slightly from 
the menu shown earlier in this 
chapter.  You will see three 
options for advancing or restarting 
a sequence:

• Advance the Sequence - Draws an 
arrow that connects the selected 
event button to the event button 
below it.  This option creates a 
sequence.

• Restart the Sequence - (Not visible in the menu above.)  This option restarts 
the entire sequence.  This option appears once you have linked two or more 
buttons in a sequence.  This option  draws an arrow upward from the selected 
event button to the beginning of the sequence.  

• Restart All - Restart all sequences and counts.  This option creates an arrow 
pointing a cell marked "Restart All."   

Step 11 Select Advance the Sequence.  An arrow will appear that connects 
the first button to the second.

Step 12 Right-click the second button and select Specify Actions.  A 
sub-menu appears.

Step 13 Select Trigger.  A cell will appear to the right of the second button 
saying "Trigger."  Your sequence configuration is now complete and 
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should look like this:

Using a 
Timer

Timers let you set a time-delay for a trigger or other action. The following example 
illustrates how timers work. 

This example reads "Look for a Primitive.  When you see one, wait three seconds then 
trigger."

To create the example shown above, perform the following steps:

Step 1 Click the New Event button to open the Event menu.

Step 2 Select an event such as Primitive from the menu. An event button 
appears in the Available Events area.

Step 3 Drag the event button into a Sequence cell marked "Drag an event here 
to add another state."  Once the button is added, the cell turns blue and 
acquires a title like "Sequence 1, State 1."  Below the cell, a new cell 
appears  marked "Drag an event here to add another state."

Step 4 Click the New Events button.  The Events menu opens.

Step 5 Select Timer.  A Timer button appears in the Available Events list.

Step 6 Drag the Timer Button to the cell marked "Drag an event here to add 
another state."   The cell turns blue and acquires a title like "Sequence 
1, State 2."

Step 7 To link the two events into a sequence, right-click on the first event (in 
our example, the Primitive event button).  Be sure to click on the event 
button and not on the cell.  A pop-up menu appears.

Step 8 Select Specify Action(s).  A sub-menu opens.

Step 9 Select Advance the Sequence.  The menu closes and an arrow 
appears that connects this cell to the State cell below.
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Step 10 Right-click on the Timer button.  A pop-up menu appears.

Step 11 Select Specify Action(s).  A sub-menu opens.

Step 12 Select Trigger.  The menu closes and an arrow appears that connects 
the Timer button to a new cell to the right marked Trigger.

Step 13 To set the duration of the Timer, double-click on the Timer button.  A 
dialog box appears. 

Step 14 Enter a time value in the boxes.

Step 15 Click the x to close the dialog box.  The timer is now set.
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Sequential Events and Timers
The recording option above shows an example of using a Loop and Timer to trigger on 
Open Timeout violation. This reads "Wait for an OPEN ADDRESS on I1; If  OPEN 
ACCEPT or an OPEN REJECT occurs on T1 within 1ms, restart the loop; ELSE IF 1 ms 
elapses (without detecting an OPEN ACCEPT or an OPEN REJECT on T1) then trigger 
the analyzer".
LeCroy Corporation  115



Version 6.2 SASSuite User Manual
Recording Options - Channels
The Channels page allows the channel names to be customized.  To change a channel 
name, select the channel, then click the edit button and enter the new text, then click OK.  
Once the options are set, the analyzer will update the open trace and all future traces with 
the new channel names.  

Note:  You can also change channel names by clicking on the first cell of a 
trace (the channel cell) and selecting Rename Channel from the 
pop-up menu.

Where 
Custom 
Channel 
Names 
Appear

Custom channel names appear in three places:  
• The trace itself

• Link Tracker window

• Bus Usage window  
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Custom Channel Names in the Trace - Custom channel names do not appear right 
away in the trace:  the original names continue to display.  To see the custom channel 
names, click in the first cell of the trace (the channel cell) and select Format from the 
pop-up menu, then select Custom. 

The custom names will then appear in the trace.  

Custom Channel Names in the Link Tracker Window - The Link Tracker window will 
automatically show custom channel names as soon as they have been customized. 

Custom Channel Names in the Bus Usage Window - Custom Channel names 
automatically appear in the Bus Usage window as soon as they have been customized.  
The easiest way to see this is to open the Bus Usage window and then to open the 
Properties dialog for the window.  It will list the custom channel names.

Channel I1 renamed as Init_1.
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To open the properties dialog box for the Bus Usage window, right-click in the window, 
then choose Properties from the pop-up menu.  
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Chapter 6:  Display Options
Use the Display Options menu to specify the way data file information is displayed.

From the Setup menu, select Display Options.  

General Display Options
Use the General Display Options to specify the basic appearance of a view.

• Zoom Level: Adjustable in discrete increments from 10% to 200% 
percent.

• Enable Tips: Select to enable Tool Tips with explanation text to pop up 
when you position your cursor over various fields in the Trace View.

• Wrap: Causes packets to wrap within the window if their length 
exceeds the width of the window.

•Hierarchy Lines:  Adds faint lines (shown at 
left) to the left side of the trace showing the 
hierarchical relationship of the Frames, 
Transactions etc within the trace.  When this 
option is enabled, the lines display any time 
you cascade higher level decodes.
•Right click cell context menu:  Activates 
the right mouse button for opening cell 
context menus.
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• Timestamp At The Beginning:  Moves the timestamp from the end of 
the Frame to near the beginning.

• Trace Viewing Level: Allows you to select the hierarchical level at 
which traffic is displayed.

• Display Configuration Name: Comment field associated with the *.opt 
file containing the current Display Options values. You can also create 
and store your unique Display Options for future use. 

To create a new Display Options file, follow these steps:

Step 1 Enter a comment for the new file in the Display Configuration 
Name field.

Step 2 Click Save...

Step 3 Specify a filename (*.opt).
Step 4 Click Save.

Setting Color, Formatting, and Hiding Options
Click the Color/Format/Hiding tab on the Display Options screen.  

Use this window to customize the colors and formats associated with each field in the 
Trace view. You can also use this window to hide fields within the trace.

Setting 
Color 
Display 
Options 

To change the colors of elements in the trace, select an item in the Group and Color 
column and use the color pallet screen on the right to make the desired changes.
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Note:  The color of an Invalid Data (packet error) field cannot be changed; 
it is permanently set to red.

Use this window to customize the colors associated with each field in the trace.  You can 
experiment with these options to achieve the color combination best suited to a particular 
graphic system.

You can also customize the colors by using the options in the Custom tab. 

Changing 
Field 
Formats

To change field formats, select an item under the Group and Color column.  This action 
will enable the formats radio buttons on the right.  The format types change with respect 
to the item selected under the Group and Color column.  For example, if Display Units is 
selected, the following displays: 
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The following formats are available:

Note:  Not every format is available for every item.

Hiding 
Display 
Options

To hide one or more fields in the trace, select the appropriate item 
from the Group and color column, click the checkbox marked Hidden, 
and click the Save button. 
You can also hide Frames from a trace by selecting the desired options from the 
checkboxes.   

Level Hiding Options
The Level Hiding tab allows you to hide various types of traffic.  To hide traffic, select one 
or more items from the Events Group list and from the list on the right, then click OK. 
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Display Options - Headers
The Headers tab lets you show header fields in either collapsed or expanded state.  The 
Headers tab also lets you change the order of the header fields.  

To change Header format,

Step 1 Select a header type from the Select Header drop-down menu.

A list of header fields appears in the pane below marked Check 
to allow field when header is collapsed.  Selecting fields in 
this pane causes the fields to appear in collapsed format within 
the trace.

Step 2 Select header fields from the pane marked Check to allow field 
when header is collapsed.  

Step 3 If you want to move the selected field within the header, click the 
Move Up or Move Down buttons.
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Step 4 Click OK to apply the changes.

For example, below is a Frame where the Command field has been moved from the 
beginning of the Header field to the end.  

You can restore the default field order by clicking the Restore Defaults buttons.

Saving Display Options 
To complete your display options settings, use the features at the bottom of the Display 
Options window. These features remain the same no matter which of the four Display 
Options windows you are working in.

• Click Save to save the currently specified display options for use in 
future sessions. Any file name can be specified, but you must use the 
.opt extension. If no extension is specified, .opt is added by default.

• Click Load to load a previously saved *.opt file, thus restoring a 
previous set of display options.

• The Save as Default function is equivalent to the Save function, 
specifying the file name default.opt. Whenever you start up the 
Analyzer, it automatically loads the default.opt file if one exists.

• Click OK to apply any changes you have made to Display Options and 
close this dialog box.

• Click Cancel to cancel any immediate changes you have made and exit 
the Display Options menu.

• Click Apply to apply your changes while keeping the Display Options 
window open.
124 LeCroy Corporation



SASSuite User Manual Version 6.2
Chapter 7:  Reading a Recording

Recording View Features
SASSuite viewing software displays make extensive use of color and graphics to fully 
document the captured traffic.  Frames (for Avalanche or SASTracer files) or commands 
(for SASTracker files) are shown on separate time-stamped rows, with their individual 
fields both labeled and color coded.  Data fields can be collapsed to occupy minimal 
space in the display (which can in turn be zoomed in and out to optimize screen 
utilization).  Pop-up Tool Tips annotate Frame fields with detailed information about their 
contents.

The display software can operate independent of the hardware and so can function as a 
stand-alone Viewer that may be freely distributed.

Frame, Transport, SCSI, and Management Views
The default display mode for recorded traces is Frame view.  The trace can also be 
viewed in Transport Layer (Tra), SCSI Application Layer,  Management Application, ATA 
Application Layer and OOB (Out of Band) signaling views.

Changing Display Levels 
To switch between the Frame, Transaction, SCSI,  
Management, ATA application and OOB views, click the 
respective buttons on the  Tool Bar.
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Frame Level
Frame Level view is the default decode level.  Frame Level view displays traffic as shown 
below: 

Transport Layer 
When you click the Tra button, the Transport Layer traffic is decoded and presented as 
shown below.  To see Transport Layer transactions, you may need to scroll through the 
trace or use the Find command (under Search).

SCSI Application Layer
When you click the SCSI button, SCSI Application Level traffic is decoded and presented 
as shown below:

Management Application Layer
When you click the Mgt button, Management Application Layer traffic is decoded and 
presented as shown below: 

ATA Application Layer
When you click the ATA button, ATA Application Layer traffic is decoded and presented. 

You can "open" any of these decode levels to reveal the components by clicking the small 
triangle in the first cell. The following is an example of an expanded Management Level 
view showing its constituent Transport Layer Transactions and Frames:
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You can also get additional information on fields by holding your mouse over selected 
fields as shown in the following example:

OOB (Out of Band) Signaling View
The OOB view combines OOB scenarios (establishing link, speed negotiation, etc.) into 
a simplified and integrated view.  These scenarios typically occur at power on and after 
hardware resets as devices initialize and initiate communications. 

The trace view below shows the default trace display as a SAS target and SAS host 
attempt to initiate communication.  The SAS target powers on first, and starts sending 
COMINIT repeatedly (in fact, in this example, over 1400 times).  When the initiator 
powers on it also sends COMINIT and then both devices immediately respond with 
COMSAS to identify themselves as SAS devices. and then proceed to speed negotiation.

Clicking on the "OOB" button simplifies this long stream of OOB signals into a higher level 
summary, as follows:
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As with other views, you can get additional information on the event by holding your 
mouse over selected fields or you can "open" any decode level to reveal the components 
by clicking the small triangle in the upper left corner of the cell.

Opening the decode levels will first bring you to a list of all OOB signals, and further 
opening the COMINIT events will show the actual times of the traffic bursts that comprise 
the COMINIT, as shown below.

This example shows the power of the SASSuite software in being able to summarize 
details at a very high level, while allowing the user to easily "drill down" into the details 
that comprise each displayed event to find more and more detail on events of interest.

Setting Heirarchical View Level Using the Display Options Window
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You can also set the hierarchical view by selecting checkboxes in the Trace Viewing 
Level Options in the Display Options window. 

STP Decoding
If STP traffic is present in a trace, you can see it by doing the following:

Step 1 Click the  button to display Transport Layer protocols.

Step 2 Select Search > Go To > Frame Types > STP Frame.  The 
trace will reposition itself so that the next STP frame appears at 
the top of the Trace window.  
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STP and 
SATA 
Traffic Over 
Hosts and 
Expanders

Traffic passing through an Expander may be STP on one side and SATA on the other 
side.  Also, note that some Expanders support SAS Zoning, if so this information will be 
available to view in the trace (see “SAS Zoning” on page 132).  

Traces of such setups will show different types of traffic depending on which link(s) were 
being recorded.

STP Link Traffic - Traffic on the STP side will have STP transactions but with SATA 
traffic embedded within it.  

SATA Traffic - Traffic on the SATA side will be purely SATA and have no STP 
transactions.

View Raw Bits
SASSuite allows you to view low-level 8B/10B values for Serial Attached SCSI traffic. 
You can expand a specific Frame to view the raw bits by right clicking on the Frame 
number and selecting Show Raw Bits. 

To view Raw Bits, follow these steps:

Step 1 Click on the first cell of a Frame.

Note:  Raw Bits can be viewed only in Frames.
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Step 2 Select Show Raw 10b Codes. 

The data 8b and 10b field can be displayed in several formats, as 
shown below.

Data Appearance - To change the format of the data, select from following options:
• 8b - Click the column heading to show hexadecimal values.

• 10b - Click the column heading to show hexadecimal values.

Navigation - To move to the previous or next packet in the trace, click one of the two 
buttons at the bottom of the window:

• Prev - Displays data for the previous Frame in the trace.

• Next - Moves to the next Frame in the trace.

Running Disparity Error - If SASSuite detects Running Disparity Errors it will display in 
red and have exclamation marks before and after the value.

The 8-bit codes change to 10-bit codes before they get transmitted. 

Running 
Disparity

Running Disparity is a binary parameter with either the value negative (-) or the value 
positive (+). After receiving any encoded character, the receiver shall determine whether 
the encoded character is valid using the running disparity parameter as a checksum.  The 
receiver will then calculate a new value that is either the opposite of the previous 
character or neutral. The ability to view changes in Running Disparity polarity is an 
important part of the debug process.  The raw bits view displays the running disparity of 
the 10bit code in the column following the raw bits. 

Note: For a more complete definition of Running Disparity, please refer to the Serial 
Attached SCSI Specification (available at www.t10.org)
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Expanding and Collapsing Fields
Many of the fields shown in each display may be expanded (to display additional detail) 
or collapsed (to reduce extraneous information) with a single click.  Fields which allow 
expansion or collapse are indicated by a small solid white triangle located in the upper 
left corner of the field, as shown below:

                      >>expands to>>

As an example, if the Transport Layer is selected, typically individual frames are 
collapsed into Transactions, as shown in the example below.  If you wish to see further 
detail about any specific transaction, simply click the white triangle next to any 
Transaction number, and the Frames which compose that Transaction are displayed.

                      >>expands to>>

SAS Zoning For Expanders that support zoning, the zoning information can be displayed by 
displaying the trace in the Transport mode, then expanding the SMP Response Field to 
provide details on the response.  The fields ""Zoning Supported" and "Zoning Enabled" 
are among the detailed fields that are displayed. [Note:  Currently SAS Zoning is decoded 
using SAS 2r05a.]
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                      >>expands to>>

Expanding a 
Data 
Payload

You can expand a Data Payload field to view it in greater detail or collapse it when you 
want a more compact view. SASSuite allows you to expand and collapse the data 
payload information in four ways: 

• Clicking the small triangular arrows on the left side of the data payload 
field

• Clicking and holding down the mouse button on the triangular button on 
the left side of a data payload field. This action will expand or collapse 
data fields for all Frames throughout the trace

• Double-clicking anywhere in the payload field
• Clicking in the data payload field and selecting Expand/Collapse Data 

in the pull-down menu. 
When you select "Expand Data," only the first 100 dwords are shown. To view all of the 
dwords, select "View Data Block."

This section describes expanding or collapsing data payload by using the menu:

Step 1 In the Serial ATA trace, click in a Data Payload box.

Step 2 In the Data Field menu, select Expand Data.

The Data Payload box expands to show more detailed description of 
the data:
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To collapse data, follow the same steps described above, and select 
Collapse Data. 
You can also expand or collapse all data payload fields within a trace by 
using the above menu. 

View Data Block Window
The View Data Block command opens a dialog box that lets you display and navigate the 
data within Frames and Transport Layer transactions.  This dialog box gives you several 
format choices for the data:  binary, hexadecimal, ASCI, and decimal.  It also gives you 
the ability to navigate through data fields within different Frames and Transport Layer 
transactions.

To access the View Data Block window,

Step 1 Decode to the level of interest by pressing    or .

Step 2 Locate a Frame or Transport Layer transaction with a data field 
such as the one shown below: 

Step 3 Click in the Data field to open a pop-up menu.

Step 4 Choose View Data Block from the menu.  The View Data Block 
window opens.  

Description 
of View Data 
Block 
Window

The View Data Block window (henceforth called the View window) displays the raw data 
for the selected Data field.  Data is displayed in up to four formats, a column per format.  
The window has several options for navigating through Data blocks.

 Save. Saves the currently displayed data block into a text file.

 Previous and Next. These buttons cause the View window to 
jump to the next Frame that has a data block and display that 
data block.

 Data Format Display. Creates a column for the specified data 
format and then displays the currently selected data block in 
that format.

 MSB/LSB Format. Begins the data string with the Most 
Significant Bit (MSB) or Least Significant Bit (LSB).
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 Format Line. Opens a dialog box for setting DWORD length. 
The default is 4 dwords.

 Synchronize Options. Configures the mouse's scrolling 
behavior within the View window. 

The menu presents three scrolling options:
• Update only on request - Locks whatever data block currently is on display 

in the Data window unless overridden by a direct request. There are two ways 
to make a request -- by clicking on the buttons or by right-clicking in the trace 
on a data block and selecting View Data Block from the pop-up menu.

• Update on click - Repositions the Data window to whatever data block you 
click on in the trace window.

• Update on scroll - Synchronizes trace scrolling with the Data window. As 
you scroll the trace, the Data window will reposition to show the data block 
for the Frame at the top of the trace window.

  Scroll to Offset. Repositions the Data window to whatever offset you 
enter in the Offset box. You can enter an offset value in decimal or 
hexadecimal.

Incomplete Frames Handling and Display
If the analyzer captures a frame that was not transmitted properly according to the 
protocol, it records the frame as an Incomplete Frame. This includes SSP, SMP, Address 
or STP(SATA) frames without Start Of Frame and/or End Of Frame, or frames with 
shorter payload that is dictated by the protocol.

The Incomplete frames are marked specifically in the Trace View. Here are some 
examples of Incomplete Frames display:  

Incomplete Address frames 
 

Incomplete SSP frame

Incomplete SATA frame
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When incomplete frames are displayed, no field decoding takes place, only the raw 
payload recorded for the incomplete frame is presented. However, in the Link Tracker 
some field decoding can be performed, if possible (part of the frame header is received 
intact). Here are some examples:  

Link Tracker shows some decoded fields for incomplete Identify Address 
frame

Link Tracker shows some decoded fields for incomplete SMP frame

Split Frames Some frames - mostly STP (SATA) - can take a very long time on the bus. For SATA 
frames it happens when Host and target go into long Hold periods while writing or reading 
the data. In this case it is not viable for the analyzer to record the whole traffic sequence 
as one frame, and the Split Frame approach is used. The long frame is broken into a 
sequence of smaller frames, which are marked as Starting frame, zero or more Middle 
frames and an Ending frame. This is highlighted in the Trace View like this:
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A frame transmitted by SATA initiator is split into three frames.

SATA frames both on Transmitter and Receiver sides are split

The frames that are split get assembled together at the Transport level of 
decoding/display.   For example:  

In the example above, although SATA frames both on Transmitter and Receiver 
sides are split, they are assembled together in the Transport Layer transaction. 
The payload, that was split into 6564 and 1632 bytes is assembled together in 
one 8192 bytes buffer.
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Compact View
Some traces contain field headers which repeat from line-to-line (frame-to-frame) 
even if the content of the fields are changing.  The repeated display of the same 
header information can occupy space on the screen that would be more useful if 
presented in a tabular form.

The compact view provides a means of condensing repeating header information 
into one line of headers, with the data arranged below in "spreadsheet" fashion.  
Compact view automatically condenses repeating headers, but when the next 
header that is different appears it will be shown as a new header.

Compact view can be selected in any of the following ways:
• From the View Menu, select Compact.

• Use the Ctrl-Q keyboard shortcut.

• With the mouse pointer positoned over the display area, right-click the mouse 
and select "Compact" for the menu that displays.

To change back, repeat either the menu selection or the keyboard shortcut.

The following screens illustrate the use of compact view mode.  In the screen below 
(shown in normal view), the same header information repeats for each frame:
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When View>Compact (or Ctrl-Q) is selected, the trace file is now shown as follows, which 
allow far more data to be displayed in the same screen:

Note that the occurance of just one frame in the display with a different header ("Idle" 
instead of "Time Delta") results in the header row being redisplayed.

Export Options
Trace data captured by Avalanche or SASTracer can be exported for other uses, 
including uses outside the system.  These options are accessed through the File menu 
by selecting Export, as shown below.
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There are four export options supported.  The data fields which will be present in the 
exported files are determined by the current screen view.  Please select the appropriate 
data fields before exporting the data to ensure that the correct information is present in 
the exported file.

Packets to 
Text (Packet 
View 
Format)

This option is used to create a text version of the trace (e.g., for use when emailing a trace 
section).  Selecting this option brings up a screen to allow you to define the range of 
events that you want to include in the text file.  The range can be defined by frame 
number, by markers, or by time.

Define the range of events (by frames, markers or time) that you would like in the 
exported file and click "OK".  A screen will appear for you to provide a filename for the 
exported file, and allow you to navigate to the folder where you wish to store the file. The 
exported file will have a ".txt" extension.
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Export to 
Generator 
File Format

A feature of the SASTrainer is the ability to use a trace captured by the SASTracer as the 
basis for traffic to be generated by the SASTrainer.  In order to use this feature, the 
captured trace must first be exported by using the "Export to Generator File Format" 
command.  See Generating Traffic on page 186 for a discussion on how to use this 
feature with the SASTrainer.

Packets to 
EAS Format

This option creates EAS files based on the open trace.  Selecting this option will bring up 
a screen allowing you to name the files and navigate to the folder that you would like to 
store the files.  There are three files created, one file with a ".ecs" extension and two files 
(one for each channel) with a ".eas" extention.  The ".eas" files will have "_000_ch1" and 
"_000_ch2" appended to the file name you provided.

Export to 
CSV Format

Many users might wish to have the trace data exported into a formatted file (e.g., for 
import into databases or spreadsheet programs such as Microsoft Excel).  The 
"Transport to CSV Format" option provides a means of generating a structured file from 
trace data captured by Avalanche or by SASTracer.

Selecting this option will bring up a screen allowing the user to specify the information 
from the current file to be exported and the destination file for the exported data.

  

Select the destination folder and enter the destination filename for the exported data.  
Select the layer to export (either Transport or ATA Application Layer).  Indicate whether 
you would like hidden packets to be included in the exported file or just displayed packets.  
Define the range of events (by frames, markers or time) that you would like in the 
exported file and click "Save".  
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The exported file will have a ".csv" extension.  The first line (or record) in the .csv file will 
be a header indicating the name of each variable included in the file.  Each following line 
(or record) will contain only data.

If opening the exported file from within Microsoft Excel, in the Open File window under 
"Files of Type:" select "Text Files (....; *.csv)". When the file is opened, a spreadsheet is 
shown with a large number of columns (each column representing one data type) and a 
number of rows on the trace which was selected for export.  A typical spreadsheet is 
shown below.  Once opened, the file can be later saved as any supported Excel file type. 
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Chapter 8:  Searching Recordings
SASSuite has several search commands that enable you to navigate a recording in 
search of key events such as errors and triggers.  These commands are launched from 
the Search menu.

To view the search options, click Search in the Menu bar.

Go to Trigger
To display the Trigger Event, select Go to Trigger from the Search menu.

The Trace View is repositioned with the first Frame following the Trigger event (or the 
Frame that caused the Trigger) at the top of your screen.

Go to Event ...
To display a specific Frame or higher decode level, follow these steps:

Step 1 From the Search menu, select Go to Event ... 
The Go to Event window appears.

Step 2 From the Go To pull-down menus, 
select Frame, Time, or Markers (if 
present).

If you select Frame, a menu of 
decode levels will appear.  
Select the decode level of 
interest (if it does not appear, 
you may have to press a decode button on the toolbar).  Then 
enter an event number in the text box to the right.

If you select Time, a text box will appear prompting you to enter 
a time value.

If you select Marker, a list of Markers in the trace will appear.  
Select a Marker from the list.
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Step 3 Click OK.
The trace view is repositioned with the selected item at the top of your 
screen.

Go to Marker
To instruct the Analyzer to display a marked Frame, follow these steps:

Step 1 From the Search menu, select Go to Marker.

Step 2 Select the desired Frame from the displayed list.  

The Trace View is repositioned with the selected item at the top of your 
screen.
Selecting Search > Go to Marker > All Markers will cause a dialog box 
to open with a list of all markers in the trace.  The dialog box offers 
options for editing, deleting, and copying markers.

Note:  The Go to Marker feature functions in conjunction with the Set 
Marker feature. The comments within the parentheses following 
each marked Frame are added or edited with the Set Marker 
feature. Please refer to Set Marker in Reading a Recording.
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Go To
The Go To feature takes you directly to an event in a recording by allowing you to search 
by a specific criteria. Only the items present in a recording will be displayed in the Go to 
menu. If an item is not present in the recording, it is greyed out in the menu.  

To apply the previous Find parameters to the next search, select Find Next from the 
Search menu. 

Find
Find is a utility for conducting searches of one or more events within a recording. In 
SASTracer trace files, Find allows you to search different hierarchical levels within the 
trace - Frames, Transactions, SCSI Operations, and Mgt Transactions.  To start find,

• Select Find... under Search on the Menu Bar
OR

Click  in the Tool Bar.
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You see the User-Defined Find Events screen:

The Find window divides into three areas: 

Left area --  Display options for setting the search level, direction and origin.   The top left 
box is context-sensitive. In order for the Transactions, SCSI Operations, and 
Management Transactions to be active, you will need to decode these levels in the 
trace. 

The left area includes two options at the bottom:
• Find All - Finds all specified events and extracts the results to a new window.

• Search in Hidden - Searches for specified events in all of the trace - 
including in traffic currently hidden from the display via the Hide buttons.

Center area  -- Controls the event groups to be searched. The selection you make will 
display further choices on the right side of the Find window. At the bottom are three 
options called Union, Intersection, and Exclusion that are used with multi-criteria 
searches. These options are explained below.

Right area -- Controls the specific events to be searched within the trace. The box in this 
right section displays events from the selected Event Group. 

The right area is context sensitive - the Event Group selected in the Center Area 
determines what types of events display on the right. For example, if "Primitive Type" is 
selected, the right area will display a list of Primitive types. Bold entries indicate items that 
actually occurred in the trace.

In the example shown above, Primitive Types is selected. The right side of the screen 
shows all of the Primitive Types that occurred in the displayed trace.
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Complex 
Searches

When conducting complex searches in the Find dialog box, 
you first push a decode button in the toolbar to enable 
Frames, Transactions, SCSI Operations, or Management 
Transactions in the Search for... box.

In this example, three of the five "Search for..." choices are 
enabled, and Frames is selected.  The Event Groups box in 
the Find dialog contains available choices based on the 
selection. 

After you have selected a choice in the Event 
Groups, the box on the right of the Find window will 
present choices based on your selection. In the 
following example, the box displays the frame 
types that are available in the trace:

Event 
Groups

Event Groups are categories of events that can occur in a trace. Clicking on an Event 
Group will display a list of Event types on the right side of the Find window that occur 
within each Event Group.

Union, 
Intersection, 
and 
Exclusion

If multiple events are selected, use the options Union, Intersection or Exclusion to 
conduct the search. 

Union is used to search for any selected event: "Find x or y." Union lets you tell the 
Analyzer to search the trace for any of the selected items.    

Intersection is used to search for all selected events: "Find x and y." Intersection lets you 
tell the Analyzer to search the trace for any packet having all of the selected events.

Exclusion is used to exclude selected traffic from the trace. Exclusion is used with Union 
and Intersection --i.e., you select Exclusion with Union or Intersection. 

• Exclusion + Union -- Exclude packets with any of the specified events. 

• Exclusion + Intersection -- Exclude packets with all of the specified events. 

Using Find Step 1 Select the display level to be searched from the Search For box on the 
left side of the window. 

For example, to search through Commands, select Commands. 
The display level affects options presented in the Events Group 
box.

Step 2 Select a search direction and origin.

Step 3 Select one or more events from the Events Group box.

Your choices will affect options displayed on the right side of the 
dialog.
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Step 4 If you have selected two or more criteria, then select either:

• Union: Find all packets that match ANY of the specified events. 

• Intersection: Find all packets that match ALL of the specified events.   

If you want to selected events from the trace, then select:

• Exclusion: Exclude all packets that match any of the specified events.   

Step 5 Click OK.  The search then occurs, and the results display.

Find Next To apply the previous Find parameters to the next search,

Select Find Next (or F3) under Search on the Menu Bar

OR

Click  on the Tool Bar.

When Link Tracker is open and Find Next  is used, the software repositions the 
LinkTracker (and other views) on the next frame containing the same primitive. For 
example, when using Find Next to search for SATA_SYNC primitives - the display will 
select the next primitive in time starting from the specified origin (top of the screen, 
beginning of the file, last match), regardless of which frame and which recording channel 
it occureds.

Figure 1:  When using Find Next for primitives, the search order will be as shown
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Chapter 9:  External Interface for Trigger 
In /Out 
With each Avalanche or SASTracer analyzer, LeCroy includes two mechanisms for low 
latency communications with general purpose test and measurement equipment:

• BNC (or SMA) External IN / OUT - This connection can be used to send 
clocking information and recording commands from one analyzer to 
another (see Setup for Cascaded Multiple Analyzer Use for SASTracer 
in Chapter 11).  The BNC/SMA interface can also be used for 
transmitting and receiving trigger in / out signals from general purpose 
instruments such as a LeCroy Oscilloscope or an InFusion Error 
Injection system. 

• Breakout board  -  The breakout board utilizes a LV TTL level signal 
which can provide a simple trigger in/out interface to the analyzer.  It 
can also be used to configure the analyzer to trigger on a specific bit 
pattern received on the break out board data pins.

BNC/SMA External In / Out
The BNC/SMA External Out capability allows users to specify protocol level events as 
Trigger Out signals to external instruments. This provides a mechanism for SAS or SATA 
link layer errors detected on the analyzer to trigger an attached oscilloscope. The 
BNC/SMA External In provides a similar mechanism allowing physical layer instruments 
to signal the analyzer to trigger at a specific moment. 

Using the 
SMA Trigger 
Out on an 
Avalanche

Step 1 Attach the SMA EXT OUT connector to an appropriate Trigger 
In connector on a general purpose test instrument using the 
provided SMA cable or an SMA-to-BNC cable, as appropriate

Step 2 In the SASSuite software, under Recording Options 
(Avalanche)..., select the Triggering/Filtering tab

Step 3 In either the Global Rules or Sequence section, click on the 
<Click here to add an event> link and select the event desired 
to initiate the external Trigger Out signal, then click OK

Step 4 Click on the <Click here to add an action> link and select the 
SMA Output action, then modify the parameters under Output 
Action and Pulse Length to be appropriate to the external 
instrument, then click OK

Step 5 If you wish the event to also be used to trigger the Avalanche 
analyzer, select the <Click here to add another action> link 
and select Trigger, then click OK

Step 6 Start the recording on the Avalanche analyzer.
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Using the 
SMA Trigger 
In on an 
Avalanche

Step 1 Attach an appropriate Trigger Out connector on a general 
purpose test instrument to the SMA EXT IN connector using the 
provided SMA cable or an SMA-to-BNC cable, as appropriate.

Step 2 In the SASSuite software, under Recording Options 
(Avalanche)..., select the General  Tab and click the radio 
button Event Trigger under Recording Type.

Step 3 Select the Triggering/Filtering Tab. Under the Global Rules 
section (or in one of the Sequence sections), click on the <Click 
here to add an event> link

Step 4 Select SMA Input, adjust the parameters to match the signal 
expected from the external device, and click OK.

Step 5 Click on the <Click here to add an action> link, select Trigger, 
then click OK.

Step 6 Select Start from the Record menu.

Using the 
BNC Trigger 
Out on 
SASTracer

Step 1 Attach the BNC Trigger Out connector to an appropriate BNC 
Trigger In connector on a general purpose test instrument using 
the provided BNC cable

Step 2 In the SASSuite software, under Recording Options (UPAS 
10K)..., select the Recording Rules Tab

Step 3 Select the New Event button and specify the protocol level 
event desired to initiate the external Trigger Out signal

Step 4 Under the Actions Tab, Select the type of External Trigger 
signal suitable for the external instrument. The chassis support 
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three external trigger-out signal types:
• Pulse High 

• Pulse Low 

• Pulse Toggle

Note:In each case, the BNC signal transmits an LV TTL level signal 

Step 5 Select Trigger Analyzer on the Actions Tab if you intend to 
record protocol level traffic simultaneously while using the BNC 
External Trigger Out signal

Step 6 Press the Record button to arm the analyzer. Trigger indicator 
on the analyzer faceplate will indicate when the trigger condition 
has been detected by the analyzer system.

Using the 
BNC Trigger 
In on a 
SASTracer

Step 1 Attach an appropriate BNC Trigger Out connector on a general 
purpose test instrument to the BNC Trigger In connector using 
the provided BNC cable.

Step 2 In the SASSuite software, under Recording Options, select the 
General  Tab and click the radio button Event Trigger under 
Recording Type.

Step 3 Select the Recording Rules Tab. Remove all triggering events 
from the Recording rules (Filtering options can be retained - see 
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Recording Rules screen image below)

Step 4 Press  Record > Start button to arm the analyzer. The analyzer 
will indicate it is waiting for a trigger. Any edge detected on the 
Trigger In signal will stop the recording and fill the buffer on the 
analyzer.

Note:: Voltage required on the edge condition is 0 to.8V low, 2.0V to 3.3V high. 40nS 
is the approximate detection threshold for the BNC Trigger In feature.

Note:: There is also a trigger indicator on the analyzer front panel that will indicate 
when the trigger condition has been detected by the analyzer. 

Breakout Board Trigger In / Out
The Breakout Board connects via a 25 pin 
serial interface cable to the Data In/Out 
connector located on the rear of the analyzer 
unit. Each signaling pin is isolated by a 100Ω 
series resistor and a buffer inside the Analyzer 
unit.  Six ground pins and one 5-volt pin are 
provided.

Pin-Outs for the Data In/Out Connector
The following table lists the pin-out and signal descriptions for the Data In/Out connector 
on a cable that connects to the Breakout board.   

Data In/Out Connector (on cable)
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Data In/Out Connector – Pin-Out

Note:  (*) Pins 4 and 17 have the same function: they allow external signals 
to be used to cause triggering or recording. Pins 3 and 16 are used 
to transmit output signals. Pins 6, 7, 8, 9, 18, 19, 21, and 22 (data 
pins) are used to define data patterns for external input signals. See 
External Input Signals in Chapter 6. 

Pin Signal Name Signal  Description
1 RSV Reserved
2 GND Ground
3 GP OUT General Purpose Output
4 TRG IN 1 Trigger In 1
5 GND Ground
6 DATA 6 Data 6
7 DATA 4 Data 4
8 DATA 3 Data 3
9 DATA 1 Data 1
10 GND Ground
11 RSV Reserved
12 RSV Reserved
13 +5V +5 Volts, 250 mA DC Source
14 RSV Reserved
15 GND Ground
16 TRG OUT Trigger Out
17 TRG IN 0 Trigger In 0
18 DATA 7 Data 7
19 DATA 5 Data 5
20 GND Ground
21 DATA 2 Data 2
22 DATA 0 Data 0
23 GND Ground
24 RSV Reserved
25 RSV Reserved
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External Interface Breakout Board

Prototype 
Rework 
Area

The Breakout Board contains a prototype rework area for making custom circuits for rapid 
development. The area consists of plated-through holes, 20 columns wide by 27 rows 
long. The top row of holes is connected to GND and the bottom row is connected to +5V. 
The remaining holes are not connected. Use the rework area to insert custom 
components and wire-wrap their respective signal, power, and ground pins. 

Configuring Input Signaling through the Breakout 
Board
Triggering 
an 
Avalanche 
System

To configure the Avalanche analyzer to trigger on an input signal from the breakout 
board, perform the following steps: 

Step 1 Select Setup > Recording Options (Avalanche).... and select 
the Triggering/Filtering tab. 

Step 2 Under Global Rules, click on the <Click here to add an event> 
link

Step 3 Select BOB Input - TRIG from the Events menu.  Specify the 
Trigger Source, Input Events and Pulse Length parameters to 
match the expected signal from the external device, then click 
OK

Step 4 Click on the <Click here to add an action> link and select 
Trigger, then click OK. 

Step 5 Select Start from the Record menu   
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Triggering a 
SASTracer 
System

To configure the analyzer to trigger on an input signal from the breakout board, perform 
the following steps: 

Step 1 Select Setup > Recording Rules to open the Recording 
Options dialog.  The Recording Rules page will display. 

Step 2 Click the New Events button to open the New Events menu.

Step 3 Select Breakout Board Data from the New Events menu.  This 
will cause a button to appear in the Available Events area.  The 
button will be labeled Breakout Board.

Step 4 Drag the new button to the Global State Cell or to the cell faintly 
marked Drag an event here to add another state.  The Global 
State Cell allows you to set conditions that are globally true (i.e., 
always enabled).  The cell marked Drag an event here to add 
another state is used to create event sequences - i.e., chains 
of events leading to a trigger or other action.  For further 
explanation, see “Assigning an Action” on page 42.

Step 5 Right-click on the Breakout Board button to open a pop-up 
menu.

Step 6 Select Properties from the pop-up menu.  The Properties dialog 
opens.  

Step 7 If you want to configure the analyzer to trigger on a specific bit 
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pattern, enter it in the box marked Byte0.  Alternatively, you can 
enter a hex pattern and mask into the boxes marked Mask and 
Match.  If no pattern is specified, the analyzer will trigger on ANY 
input signal.

Step 8 Click the tab marked Actions.  

Step 9 In the Internal Triggering section, select Trigger Analyzer.  The 
analyzer is now configured to trigger on an input signal.
156 LeCroy Corporation



SASSuite User Manual Version 6.2
Chapter 10:  Reports
The Report menu provides several reports to assist you in analyzing traffic recorded by 
the Analyzer.  

File Information
To display data on a trace, select Report >File Information from the menu.

The File Information dialog opens and provides information about the recording such as 
when it was made and version of the Analyzer Firmware and BusEngine.

Perhaps the most useful information listed in the dialog is the Recording Option settings 
used to create the open trace.  These settings are shown in the above screenshot.  Also 
shown in the screenshot is a hypertext link to the Recording Option settings themselves.  
The link is marked with the text Open Recording Options in a dialog.  Clicking this link 
causes the software to open the Recording Options dialog and automatically populate the 
dialog with the settings used to create the open trace.
LeCroy Corporation  157



Version 6.2 SASSuite User Manual
Traffic Summary
The Traffic Summary displays a report of traffic in the data file and appears at the bottom 
of the SASSuite main window. The left side contains a tree view where you can expand 
or collapse types of data you want displayed to the right of the Traffic Summary window. 
You can print, e-mail, save to disk, or display data in a two-column table by using the 
buttons in the Traffic Summary tool bar. 

From the Report menu, select Traffic Summary. 

Navigating
The Traffic Summary window also functions as a trace navigation tool.  If you click one 
of the numbers in the right side of the window, the trace will jump to the first instance of 
your selection.  Afterwards, click the up or down arrows at the top of the Traffic Summary 
window to navigate forward or backward through the display.

Buttons
Buttons at the top of the Traffic Summary window serve to format the display and export 
summarized data to email, file, or the printer:

The buttons have the following functions:

Save As -  Saves 
Traffic Summary 
results into an HTML 
format

Displays results tabular text format

Email - Creates an 
email with a *.html file 
attachment of the 
graphs  

Displays drop-down menu with:
Grid Lines - Displays/Hides grid lines
Row Selection - Allows entire rows to be 
selected
Tight Columns - Reformats column widths 
to match data

Print
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Error Summary
The Error Summary button opens the Traffic Summary window and displays a list of 
errors analyzed throughout the recording.

Step 1 From the Report menu, select Error Summary.

The Traffic Summary window appears with Error information displayed.

Step 2 Navigate to an error within the recording by clicking the number 
of the Frame containing the error.

Step 3 Use the arrows to cycle though each occurrence of a particular 
error.

Timing Calculations
The timing calculation measures timing between any two specified frames or markers. 
The timing calculator feature is designed for tracking bus utilization and I/O performance 
in current or previously captured trace files. By default the statistics will be calculated on 
a complete capture file or one bounded between markers or between any two frames. 

To run the Timing Calculator, perform the following steps:

Step 1 From the Report menu, select Timing Calculations. 
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Step 2 Select the range, and click the Calculate button.  The results will 
then display in the window.

Bus Utilization
The Bus Utilization window displays information on bandwidth use.  

To open the Bus Utilization window, select Report >Bus Utilization or click the button 
marked  .  A window opens like the one shown below:  

Window Layout
The Bus Utilization window divides into two areas:

•   Graph Area - Displays graphs. Initially, no graphs will be 
displayed. To display one or more graphs, click  and 
make a selection from the menu. See “Graph Areas 
Menu” on page 162 for an explanation of the types of 
graphs listed in this menu.

• Min/Max/Avg Area - Displays the minimum, maximum, 
and average values for several parameters.  Data is 
available only after you have displayed the relevant 
graph.  After displaying a graph, the Min/Max/Avg 
information is calculated and is thereafter available to the 
user even if the graph is closed.  The user can close this 
section by clicking  and deselecting Statistics 
Accumulation from the menu. 

Bus Utilization Buttons
The Bus Utilization window has a row of buttons for changing the format of the displayed 
data and for exporting data:
160 LeCroy Corporation



SASSuite User Manual Version 6.2
The buttons have the following functions:

View Settings Menu
Clicking the View settings button  causes a menu to 
open with options for formatting the display.

• Orient Horizontally - changes the 
orientation of bus usage to horizontal.  
After selecting this option, the menu 
will say "Orient Vertically."

• Tile Vertically - tiles the two graphs 
vertically (i.e., side by side).

• Show Markers - Places "tick" marks 
along the x axis of each graph.

• Show Plumb Line - Displays a vertical line that connects 
your cursor to the horizontal axis. As the mouse is moved, 
the status bar will show the packet and time frame to which 
the cursor is pointing.

Save As - Saves the 
graphs as a bitmap file 
(*.bmp)

Vertical zoom in

Email - Creates an email 
with a *.bmp file 
attachment of the 
graphs

Vertical zoom out

Print
Click and Drag zoom - Click 
diagonally to select and zoom in on 
part of the graph.  The initial direction 
you begin dragging the cursor 
determines whether the horizontal or 
vertical axis is magnified.

Full Screen Select Range

View Settings - opens a 
sub-menu with options 
for formatting the 
display. See “View 
Settings Menu” below

Sync and Graph areas - If two or more 
graphs are displayed, this button will 
synchronize the graphs to one 
another.  Once synchronized, the 
positioning slider of one graph will 
move the other graphs

Horizontal zoom in
Graph Areas - Presents a menu of 
graphs for various types of bus data

Horizontal zoom out
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• Status - Opens a sub-menu with the following options:

— Bar - Displays a status bar at bottom of graph.

— Tooltip - Causes a tooltip to appear if you position your 
mouse pointer over part of the graph and leave it there for a 
couple of seconds.

— None - Turns off tooltips and the status bar.

• Grid Lines - Opens a sub-menu with the following options:

— Both - Displays both X and Y axis gridlines

— X Axis - Displays X axis gridlines

— Y Axis - Display Y axis gridlines

— None - Turns off gridlines

• Grid on Top - Moves the grid lines above the graph.

• Fonts and Colors - Opens a dialog box for setting the colors 
and fonts used in the graphs:

Graph Areas Menu
The Graph Areas menu allows you to view different information in the Bus Utilization 
window. 

Step 1 Click the button.
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The Graph Areas menu opens. 

Step 2 Select a graph type from the menu.  Repeat for additional 
graphs. 

Note:  Some graphs will only be available after decoding the logical SCSI or 
ATA layer operations.

Modifying the Appearance of Graphs
To modify a Bus Usage graph, follow these steps below.

Step 1 With a graph displaying in the Graphs Area, right-click anywhere 
in the graph and choose Properties from the pop-up menu.   

The following dialog box opens.

Step 2 Select an a data type from the box on the left, then edit the Title, 
Appearance, Type, or Color boxes as appropriate.

Step 3 Click OK to apply the changes.

Creating a New Graph
To create a new graph, 

Step 1 Click .
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Step 2  From the menu, select New ... 
Step 3 From the Title, Appearance, and Type boxes, select the 

desired options.

Link Tracker Window
The Link Tracker window displays a detailed chronological view of events.  Events are 
shown on a primitive-by-primitive basis within columns within the window, each column 
represents a single upstream or downstream channel.  Time is presented as rows.  Idle 
time is shown by empty rows in the window.  Idles can be collapsed into gray strips 
running across the window.

Each time slot in the vertical axis represents the minimum time required by a dword to 
traverse the bus.  

The time slots are not fixed in size:  they vary depending on how zoomed out the display 
is.  When the Link Tracker is fully zoomed in, time slots for 1.5 G traffic measure 26.66 
ns and time slots for 3.0 G traffic measure 13.33   ns.

When the Link Tracker window is fully zoomed out, the grid lines disappear  and the scale 
changes to 1 dword equaling a line measuring one pixel in height.

Opening the Link Tracker Window
To open the Link Tracker window, select Report > Link Tracker or click the button 
marked  .  A window opens like the one shown below:  

Window Layout
The Link Tracker window divides into two areas:

•   Toolbar - Presents buttons for changing data format.

• Main Display Area - Displays traffic chronologically as it 
occurred in the recording.  The window divides into 
columns:  the first column shows time and traffic is shown 
on a channel by channel basis in the columns on the right. 
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Link Tracker Buttons
The Link Tracker window has a row of buttons for changing the format of the displayed 
data and for exporting data:

The buttons have the following functions:

Full Screen Show Values

Synchronize Trace View.  
Synchronizes the Trace View 
and Link Tracker windows so 
that a move in one window 
repositions the other. Because 
of the differences in scale and 
logic between the Link Tracker 
and Trace view windows, 
scrolling produces different 
effects depending on which 
window is being scrolled.  
Scrolling in the trace window 
causes the Link Tracker window 
to rapidly jump from event to 
event. Long periods of idle time 
are skipped. Scrolling in the 
Link Tracker window, in 
contrast, causes small moves in 
the trace window. Scrolling in 
the Link Tracker window causes 
the trace window to pause until 
the start of a packet is 
displayed.  At that point, the 
trace window  repositions itself. 
While scrolling through idle 
periods or the contents of a 
packet, the trace window will 
not move.

Show Scrambled Values

View Options.  Opens a menu 
with three options:  Collapsible 
Idle Time, Tooltip Display, and 
Reset Column Widths. See View 
Options Menu below for 
descriptions.

Show 10b Codes

Zoom In Show Symbols
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View Options Menu
Clicking the View Options button  causes a menu to open with options for 
formatting the display.

• Collapsible Idle Time - Opens a dialog box for setting the 
Idle time value.  By setting a value, you tell the analyzer 
when to collapse Idle times and display them as grayed out 
strips within the Link Tracker window.  For example, if you 
had set the Idle time to value x then any time an Idle time 
exceeded x it would be displayed as a gray strip across the 
Link Tracker window.  

• Tooltip Display - Opens a menu with options for adding 
content to  tooltips.  Tooltips will display when you position 
the mouse pointer over an item in the Link Tracker window.  
The options are:
• Tooltip Display Values

• Tooltip Display Scrambled Values

• Tooltip Displays 10 bit Codes

• Tooltip Displays Symbols

• Tooltips Displays Text Decoding

The following screenshot shows a tooltip in which all five options have been 
enabled:

• Reset Column Widths  - This option resets column widths 
to their defaults.

Zoom Out Show text decoding of 
frame header fields

Collapse Idles Collapse Idles plus. Further 
condenses Link Tracker 
display to show only first 5 
DWORDs of each frame.
166 LeCroy Corporation



SASSuite User Manual Version 6.2
Docking and Undocking the Window
You can undock the Link Tracker window by double-clicking on the blue title bar along 
the left side of the window.  Once undocked, the window can be dragged anywhere in the 
application.  To redock, double-click again on the title bar.

Setting Markers
Markers can be set on any dword on any event within the Link Tracker window.  To set a 
marker, right-click on an event, then select Set Marker from the pop-up menu.  Once 
marked, events can be easily navigated to via the Go to Marker command in the Search 
menu.    

Calculating Time between Dwords
You can calculate time between dwords by clicking on a specific cell and then positioning 
your mouse pointer over a second cell. A tooltip will display the time delta between the 
two cells.

Step 1 Click on the cell for the first event to select it.   

Step 2 Scroll down through the trace to the second event and position 
the mouse pointer over the event.  A tooltip will appear showing 
the time interval between the first and second events.  

More about Cell Selection
When searching for a frame or primitive within Link Tracker, the found cell will become 
the selected cell. When a cell is selected, it will remain selected even if it's off the screen. 
Keyboard actions in LinkTracker (scrolling, arrow key, etc...) will not affect the selection. 
Once a cell is selected, it can only be deselected by switching the selection to another 
cell. 
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Searching
When the Trace view and Link Tracker windows are synchronized, the Find and Go To 
options in the Search menu will apply to the Link Tracker window.  The Trace and Link 
Tracker windows can be synchronized by selecting the Synchronize button .

Hiding Traffic
You can hide Aligns, Channels and other data from the Link Tracker window by clicking 
the Hide buttons on the toolbar in the Trace window  or by 
selecting one or more of the various Hide options in the Display Options dialog box. 

Zooming In and Out
Zooming out can give you a quick, high-level view of a trace.  A fully zoomed out trace 
will only show columns and colored lines.  Using the colors you can see what types of 
traffic running through the trace - for example, brown represents data, and dark green is 
a Start of Frame.  

Further information can be obtained on any point of interest in the trace by positioning 
your mouse pointer over it.  Tool tips provide detailed description of events.  

Note that when fully zoomed out, the smallest graphical unit is the dword, represented by 
a single line.  Zooming out makes the trace appear smaller and increases the time scale 
in the first column.

  

Collapsing Idle Time, Enabling Tooltips, and Resetting Column 
Widths
Click the View Options button  to open a menu with options for formatting the 
display.  Three options are presented:
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Collapsible Idle Time - Opens a dialog box for setting the Idle time thresholds.  Setting 
a value tells the analyzer when to collapse Idle times and display them as grayed out 
strips within the Link Tracker window.  

Tooltip Display - Opens a menu with options for adding content to tooltips.  Tooltips will 
display when you position the mouse pointer over an item in the Link Tracker window.  
The options are:

• Tooltip Display Values

• Tooltip Display Scrambled Values

• Tooltip Displays 10 bit Codes

• Tooltip Displays Symbols

• Tooltips Displays Text Decoding

The following screenshot shows a tooltip in which all five options have been enabled:  

Reset Column Widths  - This option resets column widths to their defaults and enables 
columns to resize themselves automatically any time the application window is resized.  

Normally, columns will automatically resize themselves if the application window is made 
larger or smaller.  However, if you manually resize any columns in the Link Tracker 
window, column widths become static.  Thereafter, if you resize the application window, 
the Link Tracker columns will not adjust automatically.  Reset Column Widths 
re-enables this automatic resizing capability.

Frame Tracker Window
The Frame Tracker window displays a detailed chronological view of traffic on a 
Frame-by-Frame basis.  Events are shown within columns within the window, each 
column representing a channel.  Time is presented as rows.  Idle time is shown by empty 
rows in the window.  

Each time slot in the vertical axis represents the elapsed time required by the Frame to 
traverse the bus.  
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Opening the Frame Tracker Window
To open the Frame Tracker window, select Report > Frame Tracker or click the button 
marked  .  A window opens like the one shown below:  

Window Layout
The Frame Tracker window divides into two areas:

•   Toolbar - Presents buttons for changing data format.

• Main Display Area - Displays traffic chronologically as it 
occurred in the recording.  The window divides into 
columns:  the first column shows time and traffic is shown 
on a channel by channel basis in the columns on the right. 

Frame Tracker Buttons
The Frame Tracker window has a row of buttons for changing the 
format of the displayed data and for exporting data:

The buttons have the following functions:

View Options Menu
Clicking the View Options button  causes a menu to open with options for 
formatting the display.

Full Screen Zoom In

Synchronize Trace View.  
Synchronizes the Trace View 
and Frame Tracker windows so 
that a move in one window 
repositions the other.

Zoom Out

View Options.  Opens a menu 
with three options:  Collapsible 
Idle Time, Tooltip Display, and 
Reset Column Widths. See View 
Options Menu below for 
descriptions.
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• Time Format- Opens a menu with options for setting the 
time format.  There are two options: 
• Seconds 

• Clocks  

• Reset Column Widths  - This option resets column widths 
to their defaults.
Normally, columns will automatically resize themselves if the application window 
is made larger or smaller.  However, if you manually resize any columns in the 
Frame Tracker window, column widths become static.  Thereafter, if you resize 
the application window, the Frame Tracker columns will not adjust automatically.  
Reset Column Widths re-enables this automatic resizing capability.

Docking and Undocking the Window
You can undock the Frame Tracker window by double-clicking on the blue title bar along 
the left side of the window.  Once undocked, the window can be dragged anywhere in the 
application.  To redock, double-click again on the title bar.

Calculating Time between Frames
You can calculate time between cells within Frame Tracker by clicking on an event and 
then positioning your mouse pointer over a second event and reading the ensuing tooltip.

Step 1 Click on the time value for the first event.   

Step 2 Scroll down through the trace to the second event and position 
the mouse pointer above its time value.  A tooltip will appear 
showing the time interval between the first and second events.  

Hiding Traffic
You can hide Aligns, Channels and other data from the Frame Tracker window by clicking 
the Hide buttons on the toolbar in the Trace window  or by 
selecting one or more of the various Hide options in the Display Options dialog box. 

Searching
When the Trace view and Frame Tracker windows are synchronized, the Find and Go To 
options in the Search menu will apply to the Frame Tracker window.  The Trace and 
Frame Tracker windows can be synchronized by selecting the Synchronize button.  
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Zooming In and Out
Zooming out provides a high-level view of a trace.  This allows users to display more 
events on screen. Cell coloring can be used to distinguish between different types of 
traffic on the bus.
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Chapter 11:  Networking 

SASSuite has networking and cascading functions that are described in this chapter.   

• Cascading -- Allows mutliple analyzers be linked (or "cascaded") together 
into a single, synchronized, logical unit in order to increase the number of 
ports that can be monitored.  To enable synchronized multi-analyzer 
recording, the analyzers are connected together via their connectors on the 
back of the analyzers.  These connections are used to send clocking 
information and recording commands are sent from one analyzer to another. 

• Networking -- SASSuite can support analyzers connected remotely over an 
IP LAN.  Using the Network browse dialog, you can remotely control one or 
more analyzers. 

Working with Multiple Analyzers
Multiple analyzers can be set up in three ways:

Directly Connected by USB - Two or more analyzers can be connected to a single host 
PC via USB.  In this setup, no additional cables are used (as they are in a Cascaded 
setup) and the analyzers function as  non-cascaded, standalone units.  Users toggle back 
and forth between the units.

Cascaded - Two or more local analyzers linked together.  One (or all) of the analyzers 
then connect via USB to a host PC.  

The link cable functions to transmit clocking and control information between the 
analyzers, thereby allowing the analyzers to function as a cascade - i.e., a single, logical 
analyzer. Cascading  analyzers allows them to perform synchronized, multi-analyzer 
recordings.  

Connected Remotely over an IP Network - A PC connected to analyzers across an IP 
network.   

Hardware Setup for Direct USB Connections
Connecting multiple analyzers to a single PC by USB gives you the convenience of being 
able to control multiple analyzers from a single SASSuite application. The application 
provides you with a means of toggling back and forth between the different analyzers that 
are connected.
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To set up multiple analyzers via USB, you attach 
USB cables between the analyzers and the host 
PC as shown in the illustration on the right.  If you 
do not intend to group the analyzers together for 
synchronized multi-analyzer recordings, no 
further hardware setup is required.  If you do 
intend to group the analyzers, then you will need 
to add connection cables as described in the section below under "Setup for Multiple 
Analyzer Use."  Once the analyzers are connected and started, you can browse to the 
analyzers via the command Setup > Analyzer Network ...

Note:  The SASSuite software will allow you to toggle between the 
analyzers but not run two copies of SASSuite software on your 
screen simultaneously.

Setup for Cascaded Multiple Analyzer Use 
Using 
Multiple 
SASTracer 
Analyzers

SASTracer Analyzers are connected in a cascade using the "EXT IN" and "EXT OUT" 
BNC connectors on the rear of the chassis. SASTracer supports up to four analyzers 
connected together in a cascade.

If you add a BNC connection between the 
analyzers shown, you create a cascade 
which allows the analyzers to function 
together as a logical unit. Cascading 
increases the numbers of ports that can be 
simultaneously recorded.  

To set up a cascade, you connect a BNC 
cable between the External Output port on the back of one 
analyzer to the input port on the second.  The first analyzer will 
serve as the controlling or master analyzer.  It will transmit clocking 
information, Recording Option commands and other data to the 
other analyzers.  If you plan to group three or four analyzers 
together, daisy-chain the remaining analyzers together, and then 
loop the output of the last analyzer to the input of the first analyzer 
as shown in the figure on the right. 

Note:  For SASTracer Analyzers, the BNC cables must 
form a complete loop by connecting a BNC cable 
from the last analyzer’s "EXT OUT" port to the first analyzer’s "EXT 
IN" port.

Using 
Multiple 
Avalanche 
Analyzers

Avalanche Analyzers are connected in a cascade using the "SYNC IN" and "SYNC OUT" 
DB-9 connectors on the rear of the chassis. Avalanche supports up to eight analyzers 
connected together in a cascade.
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If you add a DB-9 male-to-female cable 
connection between the analyzers shown, 
you create a cascade which allows the 
analyzers to function together as a logical 
unit. Cascading increases the numbers of 
ports that can be simultaneously recorded.  

To set up a cascade, you connect a DB-9 
cable between the SYNC OUT port on the back of one 
analyzer to the SYNC IN port on the second.  The first 
analyzer will serve as the controlling or master analyzer.  It 
will transmit clocking information, Recording Option 
commands and other data to the other analyzers.  If you 
plan to group more than two analyzers together, daisy-chain 
the remaining analyzers together using additional DB-9 
male-to-female cables. 

Note:  For Avalanche Analyzers, the resulting 
connection is an open daisy chain.  Do 
NOT form a loop by connecting an extra 
cable between the first and last analyzers.

Note:  As of the date of this release, Avalanche and SASTracer Analyzers 
cannot be mixed together in a cascade.  

Set Up for Remote Access over an IP LAN
Analyzers can be run remotely 
over an IP network.  In an IP 
network, the analyzers connect 
their respective hosts via USB and 
the hosts, in turn, connect to each 
other via IP.  

Setup involves installing SASSuite 
software on each analyzer host, then enabling IP LAN connectivity between the hosts.  

When the remote analyzer is powered on, you connect remotely control the analyzer via 
its host.  Your connection will be Local host => Remote host => Analyzer.  
Use the command Setup > Analyzer Network to browse to the remote host.

You can cascade IP-connected analyzers by adding BNC connections between the 
analyzers as described above in “Setup for Cascaded Multiple Analyzer Use” on 
page 174.  

Configuring the Connection
Once you have completed the physical setup, you are ready to configure the analyzer 
connection.  
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USB 
Connected 
Analyzers

Configuration for two or more USB connected analyzers is minimal.

In the following example, two SASTracer analyzers are linked via USB to a host PC.  You 
connect to one of the two analyzers.

Step 1 Start the SASTracer analyzers and the SASSuite software.

Step 2 From the menu, select Setup > All Connected Devices.  

The Analyzer Network dialog box opens.  To select an analyzer, check 
the relevant checkbox on the left.   

Step 3 Click Close.  

The dialog box closes and the analyzer is selected.  The SASSuite 
software on your screen will now control the selected analyzer.

Note:  You can update the Firmware, BusEngine and License from this 
dialog by checking an analyzer and then clicking the appropriate 
button on the right.  You can also directly open and set Recording 
Options for any of the analyzers by checking one or more analyzers 
and then clicking the Recording Options button.  The Recording 
Options dialog will open.  The settings you create will apply to all 
selected analyzers.

Remote 
Analyzers 
Over an IP 
Network

To configure SASSuite to remotely control an analyzer over an IP LAN, you will need to 
use the Analyzer Network dialog to browse to the host controlling the analyzer and add 
both the host and its PC to the dialog.

Step 1 From the menu, select Setup > Analyzer Network.  

The Analyzer Network dialog box opens.  This dialog lists host PCs and 
their analyzers.  The listed devices are either currently connected or 
were connected at some point previously.   

Step 2 Remove any host (other than the Local Machine) from the list by 
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selecting the host and then clicking Remove.

You should keep in the list only the host(s) that you are planning to 
immediately use.

Step 3 To add a host and analyzer to the list, click Add.  

A browse dialog box opens.  

Step 4 Browse to the host that has an analyzer attached to it and 
double click on it.  

Step 5 The host will be added to the Analyzer Network dialog.

Step 6 Click Close to close the dialog box.

Step 7 Select Setup > All Connected Devices ... to open the Analyzer 
Devices dialog box.  

Step 8 Uncheck all boxes except for the one for the remote analyzer 
that you wish to connect to.

Step 9 Click Close to close the dialog box and establish a connection 
to the selected analyzer.

Recording 
Multi-Trace 
Files

To configure SASTracer analyzers to work as a group (i.e., into a cascade), attach BNC 
cables as described in “Setup for Cascaded Multiple Analyzer Use” on page 174, then 
perform the following steps:

Step 1 Perform Steps 1 and 2 as described above in “USB Connected 
Analyzers” on page 176.

The Analyzer Devices dialog box will open.

Step 2 In the Analyzer Devices dialog box, verify that the checkboxes 
are checked for the cascaded analyzers.

Step 3 Click Close.

The dialog closes and the analyzers are selected.
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Step 4 Test the setup by recording some traffic.  

If the analyzers are not connected by the BNC cables, an error message 
will appear prompting you to correct the problem.

Step 5 The SASSuite software will display traffic from each analyzer in 
adjacent windows. The windows are synchronized together and 
can be scrolled in tandem.

 

Traffic from each analyzer can also be merged together into a single 
unified display (as shown below).  See Merging Multi-Trace Files on 
page 179.

  

The merged view includes the Link Tracker display providing  time 
correlated analysis of DWORD level data structures.

Multi-Trace file before merge - two synchronized trace files 

Multi-Trace file after merge - one unified trace file 
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Merging Traces
SASSuite v2.5 and later supports merging multi-trace files (*.smtt) recorded on an 
Avalanche or SASTracer into a single trace display containing up to 16 bidirectional links 
of traffic. The merge feature is ideal for analyzing 4 lane traffic moving both upstream and 
downstream through a SAS expander device. It’s primarily intended for use when 
cascading multiple analyzers together. The BNC interface is used to synchronize the 
timing information across multiple systems (for configuration information, see Setup for 
Cascaded Multiple Analyzer Use on page 174). 

Note:  Although this feature is intended for merging traces that have been 
recorded as multi-trace files, it can be used for merging regular trace 
files (that have a .sas or .sata file extension) as follows:  Make sure 
the files you want to combine are in the same folder.  Select Open... 
from the File menu.  Choose all the files you want to combine by 
holding down the "Ctrl" button and clicking on each file, then click 
Open.  This opens the files in a side-by-side display.  Select Merge 
Multi-trace... from the File menu.  You will get a message saying the 
file has not yet been saved, click OK and then provide a filename for 
the combined trace file.  You will then get the dialog shown in Step 2 
below, allowing you to merge the files.

Merging Multi-Trace Files
Merged files can be created either by selecting Merge Multitrace files... with a .smtt file 
open or by selecting the .smtt file from the Select SAS Multitrace File for Merging... 
dialog:

Step 1 Select  'Merge Trace files…' item in 'File' menu

Step 2 If an .smtt file is open, the 'Merge Multi-Trace recording' dialog 
will open and automatically populate the Merge Trace Layout list  
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with the individual segments of the currently open .SMTT file.

Note: The application recommends the channel layout for the merged files. For steps 
to change the channel layout; see Altering Channel Layout on page 182.

Alternatively, users may click the 'Select SAS Multitrace File for 
Merging...' dialog to choose up to 4 different files to merge.

Step 3 Click the Start Merge button to begin merging the selected files

All open trace files will be closed before merging begins. The time 
required to complete the merge process is dependent on system 
performance. The merging process can be stopped before merging is 
complete either by clicking the button 'Stop Merge' or by exiting the 
dialog. During the merge process, the Merge dialog will display:
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Step 4 When the merging process completes, the Merge File Output 
dialog will invite users to open the resulting merged file:

Note: If the total recording has more than 32,000,000 frames or events, then the 
merged file will be truncated and a new one will be started from that point. The 
merge operation will produce as many files as necessary to complete the full 
merge.

The merge feature will only display channels that actually contain valid 
SAS/SATA traffic. For example, a multi-trace file captured from 4 
cascaded systems with real traffic in only the first channel (on each 
analyzer)  will result  in a display with traffic on channels:  (I1 / T1), (I5 / 
T5), (I9 / T9), and (I13 / T13).
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Adjusting Timestamps Between Merged Trace Files 
When using more than one analyzer in cascaded configuration, the 
segments are automatically synchronized by timestamp. It is possible to 
adjust timestamps between different segments. This allows users to 
customize the display (post-capture) to accommodate for latency that 
may occur on one of the links in the system under test.

Step 1 Select the Timestamp Delta field

Step 2 Enter the amount of the delta to add to the trace file

Step 3 Select the time increment using the pop-up menu (ns, us, ms, 
sec)

Step 4 Press Start Merge button.

Step 5 The designated time interval will be added to the first timestamp 
in a selected trace.

It’s best to rename the merged trace using Save as... after altering the 
time delta in case the timing is changed unintentionally, the user can 
revert back to the original and repeat the process. 

Altering Channel Layout
When a multi-trace file is selected for merge, the application recommends the channel 
layout of the merged file. The ' Merge Multitrace Recording'  dialog allows customization 
of the display order. For example, some users may prefer to keep the initiator traffic on 
links 1-4 with downstream traffic on links 5-8.

Step 1 Within the Merge Multitrace Recording'  dialog,  select the trace 
file name that you wish to reposition to a different set of 
channels.

Step 2 Use the arrow key to move up or down in the Trace Order 
display

Step 3 Repeat to reposition other trace files in the display if needed

Step 4 Press the start merge button

Note: The time required to complete the merge process is dependent on system 
performance. At least 1048 MB RAM and SCSI or SAS-based storage devices 
are recommended when merging large files.
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Merge dialog settings
• Put merged files into the special folder

If checked, this setting instructs the application to put resulting merged 
files into the specified folder. If it is not set resulting files will be saved in 
the folder where the merged multi-trace file is located.

• Add serial numbers of recording devices to merged custom 
channel settings.
If checked, this option instructs the application to add the serial numbers 
from the analyzers in front of the custom channel settings (different from 
the default ones). If it is not checked, the channel settings are copied 
without changes.

• Overwrite silently if merged file already exists
If checked, this option instructs the application not to prompt user in case 
if a file having the same name as a resulting merged file already exists 
and overwrite it silently. If it is not checked, the application will prompt 
user before overwriting it.

• Close the merge dialog after merging
If checked, this option instructs the application to close the merge dialog 
after merging is complete. If it is not checked, the merge dialog will 
remain open.

Manually merging two or more regular trace files
Merging trace files is primarily designed for use with multi-analyzer  
cascaded recordings. However, the merge feature can also be used to 
combine regular trace files (*.sas) or multi-segmented files (*.smt ). To 
manually merge up to 4 trace files follow steps  in “Merging Multi-Trace 
Files” on page 179 except click the 'Select SAS Multitrace File for 
Merging...' dialog and choose up to 4 different files to merge. 

Network Chat
Analyzer Network Chat is a utility that allows users to conduct chat sessions over an IP 
LAN.  

In order to send and receive electronic text messages, each user must be working with a 
PC that is attached to an analyzer.  And each PC must, in turn, be connected to an IP 
LAN. 
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To start a chat session, 

Step 1 Select View > Analyzer Network Chat Bar from the menu.  The 
following dialog opens. 

Step 2 Click in  the cell at the bottom of the window and type some text.

Step 3 Click Send.  The sent text will appear in the top of the window 
next to your prompt.
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Chapter 12:  Traffic Generation with  
SASTrainer
SASTrainer is a traffic generator that can emulate a SAS initiator/target or SATA 
host/device. Traffic generation enables engineers to test designs under realistic 
conditions and to transmit known errors, allowing engineers to observe how devices 
handle faulty link conditions. Traffic generation is performed via the execution of 
text-based scripts.  These scripts contain statements about the types of traffic to be 
generated.  

SAS/SATA Exerciser Hardware
LeCroy SASTrainer requires both the SAS Analyzer module and the SAS Exerciser 
module that plugs into the right slot of the CATC 10K chassis. Installing the SASTracer 
Exerciser module will require that you remove ports 3&4 (if equipped with a 4 port 
analyzer) or the blank face plate (if equipped with a 2 port analyzer).

Figure 2:  SASTracer/Trainer 2 port Analyzer with Exerciser option installed

Setting Up SAS/SATA Exerciser for Initiator Emulation
Connect the SAS cable from the 
SAS/SATA Exerciser To Target port to 
the Target port on the unit under test. 
This transmits the Traffic Generator 
stream from the To Target port on the 
SASTracer/Trainer to the target-side 
port on the unit under test.
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Setting Up SAS/SATA Exerciser for Target Emulation
Connect the SAS cable from the 
SAS/SATA Exerciser To Initiator port to 
the Initiator-side port on the unit under 
test. This transmits the Traffic Generator 
stream from the To Initiator port on the 
SASTracer/Trainer to the initiator-side 
port on the unit under test.

Generating Traffic
Generating traffic using SASSuite is a two step process. First, a text-based Traffic 
Generator file must be created. This file can be created through a special conversion 
command in SASSuite that converts a trace file captured by a SASTracer analyzer into 
a traffic generator file. Alternatively, you can edit an existing file or write your own. 

This text file is named with an .ssg extension. Once the file has been created, in can be 
opened and displayed in the SASSuite application. You can invoke the  SASSuite 
application to transmit the traffic generation file by using the Traffic Signal button . 

Creating a 
Traffic 
Generation 
File with 
SASSuite

The easiest way to create a Traffic Generation file is to convert an SASTracer trace file 
(*.sas) into a *.ssg file. This is done with the Export function in SASSuite.

Step 1 Open a trace file.

Step 2 From the menu, select File>Export>to Generator File Format 
(.ssg). The Export to Generator Text screen appears (.ssg).
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There are several options .

File Name - Enter a user-defined file name.

Save As Type - There is but one option:  SASTrainer Generator Files 
(.ssg).

Link and Direction - Select the source and direction of the traffic you 
are going to export into a traffic generation file.  You can only export a 
single uni-directional link (for example, I1).

Do not export hidden packets - If selected, will only export traffic that 
is currently displayed onscreen.  Traffic hidden via the various hide 
buttons will not be exported into the traffic generation file.

Use Auto Alignment - If selected, exports Auto Aligns to the traffic 
generation file.

From - (Optional) Enter the range of traffic (in Frames, Markers, or Time) 
to be exported.  The default is to export all traffic in the open trace.

Step 3 Select the desired options, the click Save.

A  Generator file (*.ssg) has now been created and can be read with the SASSuite 
application. 

Opening a Traffic Generation File
Once the Traffic Generation file (*.ssg) file has been created, you can then open it in the 
SASSuite application.
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To open a Traffic Generation file,

Step 1 Select Open under File on the Menu Bar

OR

Click  on the Tool Bar. 

Step 2 Select a Generator text file (*.ssg) and click Open. If needed, 
navigate to the install directory. For samples, see the install 
directory. The Generator file appears in a Trace view, shown 
below:

Layout The .ssg file will show several colored bars across the screen that represent  global 
settings.  The bars serve to show how the generation file is currently configured.  These 
settings include the link speed (1.5 Gbps vs. 3.0 Gbps), the type of device (for example, 
SAS Initiator or SATA Device), COMINIT, COMWAKE and some other settings.  As 
changes are made and saved to the traffic generation file, the bars will immediately 
update.  

The actual traffic pattern that is about to be generated appears below the bars as a series 
of Frames.  In the generation file shown in the above screenshot, the first generation 
Frame is a Start of Address Frame labeled as Frame 8.

You can edit the traffic generation file to add, edit or remove frames.
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Starting the Script Editor
To edit an .ssg file, use the Script Editor.  The Script Edit is an editing tool that will display 
the .ssg file and its supporting Include files.

To launch the Script Editor:  click the Script Editor button on the toolbar  or right-click 
in the trace window and choose Edit as Text.
The Script Editor window will open and display in the lower portion of the trace window.  

The Script Editor divides into three areas:  the toolbar, the script window, and the file tabs 
at the bottom of the window.  If errors occur, a log will open at the bottom of the window.

Toolbar The toolbar contains buttons for saving your edits, navigating, searching and other 
functions. 

The buttons have the following functions:

Save.  Saves your edits and 
immediately updates the setting 
bars and Frames shown in the 
trace window.

Go to next bookmark.

View Options.  Opens a menu 
with three options:  Enable 
Outlining, Toggle Outlining, and 
Line Numbers. See View 
Options Menu below for 
descriptions.

Go to previous  bookmark.
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View Options  Menu 
The View Options button has a menu with three options: 

• Enable Outlining - Adds an expandable/collapsible tree 
structure to the left side of the Script Editor showing the 
hierarchical relationship of the script lines.

• Show Line Numbers - Adds line numbers to the left side of the 
Script Editor window.

• Show Tooltips - Displays tooltips in the editor window.

• Toggle Outlining - Toggles the outline tree between collapsed and expanded states.

Pop-up Menu 
Right click anywhere in the script 
window to open a pop-up menu with the 
following options:  

Cut - Cuts selected text.

Copy - Copies selected text.

Paste - Pastes selected text.

Go to Definition of - Repositions the 
script window to whatever definition 
has been selected.

Open File - Opens whatever file has been pointed to with the mouse in the script.  This 
command works with Include statements - for example, "%include 
"Generation\Include\PrimitivesDecl.inc".

Close File - Closes whatever script file is currently being displayed.

Enable Outlining, Toggle Outlining, and Line Numbers - Enables the three options 
described above under View Options Menu.

Cut. Clear all bookmarks.

Copy. Find.

Paste. Find and Replace.

Undo. Print.

Redo. Go to Definition.

Add/Remove bookmark.  Allows 
markers to be set or removed to 
aid in navigation.

Open File Under Cursor.  
Opens whatever file has 
been pointed to with the 
mouse in the script.  This 
command works with 
Include statements.
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File Tabs At the bottom of the window are a series of tabs that allow the .ssg file and its supporting 
Include files to be opened and edited.  The Include files open automatically when the 
software first reads the script. 

Error Log Whenever you create a scripting error, a log will open at the bottom of the application 
window.  When the error is corrected, the window automatically closes. 

Overview of Generation & Global Settings Files  
Sample .ssg files and Include files reside in two directories called  
\Samples and \Include that are typically installed  in: 
C:\Program Files\LeCroy\SASTracer\Generation.

Traffic 
Generation 
(*.ssg) Files

The .ssg traffic generation files are text files consisting of include statements, a 
generation block and, optionally, global statements.  

The generation block is the code responsible for the actual traffic generation.  It is marked 
by the tag "Generation."  The composition and format of the generation block is described 
later.  

The include statements provide links to the Include files which, in turn, provide the 
definitions for primitives, frames, and "global settings" - i.e., settings that hold for most or 
all of the generation session.  

The definitions for SAS and SATA traffic are contained in five LeCroy-provided Include 
files:  Settings.inc, PrimitivesDecl.inc, AddressFramesDecl.inc, SSPFrames.inc, 
SMPFrames.inc and SSPFrames.inc.
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Settings.inc 
File

The Settings.inc file contains global statements about the link, the type of device being 
emulated, and other conditions that are to exist throughout part or all of the traffic 
generation. This file must be included in the traffic generation file.  

There are fifteen groups of settings in this file:  
• AutoMode

• COMINIT/COMRESET OOB Signal

• COMWAKE OOB Signal

• COMSAS OOB Signal

• Generation Commands

• Link Speed

• SATA Link Initialization

• SAS Speed Negotiation

• SATA Speed Negotiation

• Autowait:

•SAS After

•SAS Before

•SATA After

•SATA Before

• Wait Command Timeout

• Scrambling Mode

Details about each group of settings are described in the following chapter Traffic 
Generation Language.

Editing Settings.inc
Text in the Settings.inc file can be edited directly or copied into the beginning of the traffic 
generation file and edited there.  Many users opt for this latter approach.  

When editing global settings, keep in mind the following rule:  
• The last line encountered before the generation block takes precedence.  Thus, 

if the following two lines about the device emulation were added just above the 
generation block, the second would take effect:

set GenerationMode = GEN_MODE_SATA_HOST

set GenerationMode = GEN_MODE_SAS_INITIATOR
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The Global Setting "AutoAlign"
AutoAlign is a global setting that may be on or off depending on the type of device 
you are emulating.  There is an AutoAlign setting for SAS and one for SATA - for 
example, "set AutoAlignSAS = ON" and "set AutoAlignSATA=OFF."

SAS - Sends AutoAligns every 2048 dwords.

SATA - Sends AutoAligns every 256 dwords.

If you plan to set and reset AutoAlign in the middle of traffic generation, then you need to 
know what the defaults are for AutoAlign.  The defaults are as follows:  

For SATA host/device emulation, then 
• AutoAlignSATA is assumed to be ON

• AutoAlignSAS is assumed to be OFF.

For SAS emulation, then the assumptions are opposite:
• AutoAlignSATA is assumed to be OFF

• AutoAlignSAS is assumed to be ON

For STP, 
• AutoAlignSAS and AutoAlignSATA are assumed to be ON
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Placing Global Settings in the Generation Block
Some global settings such as AutoAlign = On/Off can be set and reset in the generation 
block.  For example, a user might want to set SASAutoAlign = ON prior to traffic 
generation and then have it change to OFF half way through the generation session.  

When placed within the generation block and then viewed in the trace window, global 
settings appear as colored bars interspersed amidst the traffic.  
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While most global settings can be set in the generation block, three will be ignored if 
placed within the generation block:

set Link Speed =

set GenerationMode =

set SSC = 

These commands should be configured either in the Setting.inc file or at the beginning of 
the traffic generation file as a global statement.

Primitive and Frame Definitions
Five other Include files are provided that define the most of the known templates for 
Primitives and Frames.  The five are: 

• PrimitivesDecl.inc

• AddressFramesDecl.inc

• SSPFramesDecl.inc

• SMPFramesDecl.inc

• STPFramesDecl.inc.  

Each of the Frame templates defines header and field structure.  

The default value for all Frame fields is zero. 

Special 
Conditions 
for Frames

There are three conditions about Frames that need to be kept in mind when configuring 
Frame generation:

1.  Frame delimiters need to agree -  At the present time, when defining a Frame, make 
sure that the Frame Prologue and Frame Epilogue agree.  Do not mix types.  For 
example, do not mix a SAS Start of Frame (SOF) with a SAS End of Address Frame 
(EOAF).  

A SAS SOF should be matched to a SAS EOF, a SAS SOAF should be matched to a 
SAS EOAF.  If generating SATA traffic, a SATA_SOF should be matched to a 
SATA_EOF.

At the present time, if you mix different types of prologues and epilogues for any given 
Frame, the Frame will be ignored.  
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2.   Data Length Fields can be fixed-length or variable - By default, data frames are 
of a fixed length.  If you want to generate variable length frames, then place an asterisk 
in the Data definition field in the SSPFramesDecl.inc file:   
Data   : * 

If you replace the asterisk with a value, then the field becomes fixed length.

3.  CRC Calculations will be calculated by SASSuite unless told otherwise - If the 
CRC is not explicitly set in the traffic generation file, SASSuite will assume that you want 
it and will calculate and display it in front of the generated frames.  

If the user provides a CRC value, SASSuite will use that value even if it is incorrect.  This 
gives the user the option of configuring the generator to  create errors.

If the generation file was created through the Export command (i.e., File > Export > To 
Generator File Format ...), the CRC is calculated but commented out.  If the source trace 
has a bad CRC, the CRC is exported into the generation file and is not commented out.

Primitives 
Decl.inc

The PrimitivesDecl.inc file defines Primitives.  The file consists of a declarations (left) and 
the corresponding byte stream (right).  

To generate Primitives, copy relevant portions of text on the left (i.e., not the bytes shown 
right) from this file into the generator block section of the .ssg file.  

For examples of usage, see primitives.ssg in the Samples directory.

Address 
FramesDecl 
.inc

The AddressFramesDecl.inc file defines Address Frames. 

For examples of usage, see AddressFrames.ssg in the Samples directory.

SSPFrames 
.inc

The SSPFrames.inc file defines SSP Frames.

For examples of usage, see SSPFrames.ssg in the Samples directory.

SMPFrames 
.inc

The SMPFrames.inc file defines SMP frames

For examples of usage, see SMPFrames.ssg in the Samples directory.

STPFrames 
.inc

The STPFrames.inc file defines STP frames

For examples of usage, see STPFrames.ssg in the Samples directory.
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Working with Generation Files
The easiest way to generate traffic is to start with one of the sample generation files and 
edit the settings to see how the script file behaves.  As you make and save changes, the 
trace view of the generation file is automatically updated.  

The following screenshots shows the sample file SSPFrames.ssg as it appears in the 
script editor and trace window.
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In the lower screenshot, global settings make up the eight bars at the top of the window.  
Below that are five frames.  If you look at the script itself, you will see that there are six 
frame commands, five active and one commented out.

Generating Traffic
Once the .ssg file has been opened onscreen, recording and traffic generation can begin 
at any time.  

Step 1 Click  to begin the recording.

Step 2 If the script does not have a connect block built into it, connect 
the exerciser to the DUT by clicking the Connect Link button 

. Clicking this button will cause the generator to invoke the 
various settings in your script (for example, the global settings) 
and then establish a connection.

Step 3 Click the Start Generation button   on the Tool Bar. 

While generating traffic, a bar appears on the right of the trace view, indicating that traffic 
generation is taking place (The green light on the Traffic signal button also blinks during 
traffic generation).

Stop Traffic 
Generation

Normally, traffic generation stops automatically when SASSuite reaches the end of the 
Generator file. 

To manually stop traffic generation, Click the Stop Generation button  .

Resume 
Traffic 
Generation

If traffic generation is stopped prior to the end of the script, it can be resumed. 

To resume traffic generation, Click the Stop Generation button  .
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Chapter 13:  SASTrainer Generation  
Language
The SASTrainer File Generation Language is an API that allows you to separate traffic 
into text commands. These commands are used construct primitives and frames that are 
sent to the host or the device. 

File Structure
Traffic Generation files (*.ssg) should have the following structure:

Declarations • Global generation settings   
• Constants
• Data patterns
• Chain of symbols (primitives, raw data, etc)
• Packet templates

Note:  Some declared objects could be used in further declarations as long 
as they are previously declared. No forward declarations are 
allowed at this time.

Generation 
blocks 

• List of generation instructions

Note:  It is possible to create many generation blocks - but at current time 
only a block with the name 'Generation' will be executed. (Calls of 
some blocks from another blocks are not currently allowed)

Language
Comments: '#' - Comment symbol. The line remainder after this symbol will be ignored.

'/*' '*/' - Comment Block. All the text between '/' '*' and '*' '/' is ignored.

/*

    This is an example of a block of comments. 

*/

Includes: %include "FileName.inc" - This directive includes the file "FileName.inc". This lets the 
user add common definitions and templates into new scripts.

Language parser makes sure the same file is not included more than once.
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EXAMPLE:

%include "SomeInc.inc"   # This directive will actually include file 'SomeInc_1.inc'

%inline - The same as %include, but without the Language parser check.

Settings Using the "Set "Constant Name" = Value" statement, users can set different 
constants/modes using the following value types:

• Predefined constants (TRUE/FALSE/ON/OFF/INFINITE/etc)
• Numbers

EXAMPLES:

Set AutoAlignSATA=ON

Set WaitTimeOut=239

Constants Only unsigned integers can be defined as constants. Some constants are predefined in 
SASTrainer.

EXAMPLES:

Const SOME_HEX_DATA   = 0xAABBFFEE # defines hexadecimal 
constant 
Const SOME_DEC_DATA   = 12     # defines decimal constant
Const "SOME DEC DATA" = 64     # defines decimal constant
Const "Some Hex Data" = 0xCDCDBEBE

Predefined 
Constants

• TRUE
• FALSE
• ON
• OFF
• INFINITE

                       

Data 
Patterns

Data patterns are streams of hexadecimal values. Using '['']' lets the user include 
constants or predefined data pattern in another pattern. 

EXAMPLES:

DataPattern PATTERN_1 = AAAABBBB [SOME_HEX_DATA] EEEEFFFF   
1210ABB1 AAAABBBB 1210ABB1  AAAABBBB 1210ABB1 AAAABBBB 
1210ABB1 ["SOME DEC DATA"] 1210AB
DataPattern PATTERN_2 = 00000000 11111111 22222222 33333333 
AAAABBBB 55556666 FEFEFEFE CDCDCDCD 9999BBBB 12343434 
6767676B 56BBFF                  
DataPattern PATTERN_3 = [PATTERN_1] FFFFFFFF EEEEEEEE 
[SOME_HEX_DATA]
DataPattern SOME_PATTERN = BBBBBBBB DDDDDDDD
200 LeCroy Corporation



SASSuite User Manual Version 6.2
Primitives Primitives can be defined using the following:

• Byte values ('k' indicates control symbol). The 10b codes are calculated 
based on the current running disparity

• Primitives are completely interchangeable with SymChains.
EXAMPLE:

Primitive "CHAIN (ONE)"  = kBC 1E 1E 1E kBC 1A 0F
SymChain ChainTwo = k28.5  D12.3  D10.2  D11.6
SymChain ChainThree = k28.3  3EA 25  k18 IFA
Primitive SOF = kBC 18 E4 67 
Primitive EOF = kBC 18 F0 9B

• Raw 10 bits codes. This definition might cause running disparity errors.
EXAMPLE:

Primitive "CHAIN (TWO)"  = 305 2D4 1E4 362
• Mixed bytes and 10b codes. This definition might cause running disparity 

errors.
EXAMPLE:

Primitive "CHAIN (TWO)"  = 305 2D4 1E4 362 ["CHAIN (ONE)"]

Packets/ 
Frames

Using the "Frame" or "Packet" keyword, user can define a frame of traffic to be used in 
the generation stream. Declarations of prolog and epilog may be mixed with field 
declarations.  

Frame "name" : "parent name"
{
Field Definition 0: "Field Name : Field Length = Default Value" 
…
Field Definition n: "Field Name : Field Length = Default Value"

Primitive Definition 0: "Primitive name, offset, count"
…
Primitive Definition m: "Primitive name, offset, count"
                      
Prolog = "primitive name"    
Epilog = "primitive name"
}   

• Field Definition
• Field length is in bits, '*' means that the length is variable and will be set 

based on the assigned value
• Field starting offset is calculated from frame start based on the length of 

the previous fields
EXAMPLES:

Field32         : 32 = 0xAABBFFEE     
FrameType   : 8  = 12
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HashedDest  : 24 = HEX_DATA    
Reserved1    : 8  = 0xDA
Field16         : 16 = 0xAAAA
Reserved2    : 8  = 0xAD
CRC             : 32

• Data field Definition 
• "Data = { pattern }" - Pattern is assigned to Data
• "Data = count, value" - A pattern of "count" times "value" is assigned to 

Data
• "Data = count, start value, step" - A pattern of values starting with "start 

value" with steps of "step" and a length of "count" is assigned to Data
• Primitive definition. Primitives are inserted into the frame payload. Primitive 

definitions are inherited by descended frame templates 
• Assigning '*' clears all previous settings (maybe from parent frame 

template). 
• Offset specifies the dword offset where this primitive will be inserted in 

the Frame
• Count specifies how many times to repeat the primitive 

EXAMPLES:

Primitive : *
Primitive : SOF, 48   # where 48 = offset
Primitive : "CLOSE (NORMAL)", 36, 5   # where 5 = repeat

• Prolog and Epilog define Primitive chains to be used at the beginning 
and end of the frame 

EXAMPLES:

Prolog = SOF   # For this frame primitive 'SOF' is used as a Prolog.    
Epilog = EOF   # For this frame primitive 'EOF' is used as a Epilog.

• Frames can be derived from other Frames, therefore inheriting the layout of 
the parent Frame. In this case, the user may:

• Change Prolog and Epilog
• Change default field values
• Add new fields

 

FRAME EXAMPLES:

Frame  Some_Frame
{           
    Field32         : 32 = 0xAABBFFEE 
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    FrameType   : 8  = 12
    HashedDest   : 24 = HEX_DATA    
    Reserved1       : 8  = 0xDA
    Field16         : 16 = 0xAAAA
    Reserved2       : 8  = 0xAD
    Data            :  * = PATTERN_1
    CRC             : 32                
            
    Primitive : *
    Primitive : SOF, 48
    Primitive : SOF, 96
    Primitive : "CLOSE (NORMAL)", 36, 5  

    Prolog = SOF
    Epilog = EOF
}
Frame Some_Frame_1 : Some_Frame 
{           
    Field32 = "Some Hex Data"                         
    Data    = { 11111111 22222222 33333333 44444444 55555555 }
    Opcode          : 128, 8, 0x2A
    LBA             : 64
    
    Primitive : *
    Primitive : "CLOSE (NORMAL)", 24, 48 
    
    Prolog = "CHAIN (ONE)"
    Epilog = "CHAIN (ONE)"    
}

Generation Block
SASTrainer will generate the stream that is defined in this block. 

Generation
{
Chain Definition (Repeat = N, Idle = M)
Chain Definition (N, M)
Chain Definition
Frame Definition
Frame Definition (RunningDisp = ON/OFF)
Frame Definition
{
Field Definition
Data Definition
} (Repeat = N, Idle = M, RunningDisp = ON/OFF)
}
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Definitions
• Chain Definition:

• Without any parameters, the chain is sent once
• With "Repeat" and "Idle" parameters, the chain is sent N times and then 

nothing is sent (idle) M times. "Repeat" and "Idle" are optional.
• Frame Definition

• Without any parameters, send the frame based in default values
• With "RunningDisp" ON, send the frames based on default values and 

insert a running disparity error.
• With parameters overriding or adding to a template frame, with or 

without injection of an overriding or adding to a template frame, with or 
without injection of running disparity error.

Field 
Variable 
Declarations

You can declare a variable (var_name) as a frame of type (frame_type)

$var_name = frame_type     

Note:  Frame variables can be declared/re-declared and used many times.                  

Changing 
Frame 
Fields    

You can change some fields in a frame variable

 Change var_name { field_name = value }

 
Preprocess
or integer 
arithmetic

The user can declare DWORD variables, make arithmetic operations and use them in 
field and parameters assignments

Note: Arithmetic expressions are allowed only in numeric variable assignments.

EXAMPLES: 

Legal Operations

x = 2
    y = ( z = 12 ) + ( SOME_DEC_DATA + 36 ) / 8
    
    z = 0x1 << 5     
s = "Some Hex Data" # constant may be used in operations
    
x++
y--    
z += ( x + y )
x = ( ( y & 0xFF ) >> 5 ) / 12
    
SOF ( Repeat = x, Idle = y )     
    
X
{        
        Field16 =  0xEEEE   # Example of the data payload assignment which uses 
both integer variables, constants, hex literals and data patterns                                                       
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        Data    =  { y y y y 7a7a7a7a "Some Hex Data" "Some Hex Data" 8b8b8b8b 
z z z z [PATTERN_3] }
}
( Repeat = 10, Idle = y )   # uses integer variable for parameter/setting

Illegal operations

     x = y + 2
SOF ( Repeat = (x+y)*7 )  # - illegal, use z = (x+y)*7   SOF ( Repeat = z ) instead

Loops Loops can be used in two modes:

1. Using an integer number, loop a specified number of loops. This number has to be 
smaller than 64K.

2. Using the word "infinite", loops for ever.

Loops ( loop_count/Infinite )
{
 send instructions
 assignments
change values
send instructions
}    
        

  EXAMPLE:

    LOOP( 50 )
   {
        "CHAIN (ONE)"
        "CHAIN (TWO)"        
        Some_Frame        
        $Y = Some_Frame { Data = 256, 0xFEFEFEFE }        
        Y         
        Change Y { Field32 = x }        
        Y   
        Y
    } 

SASTrainer Generation Commands
General 
Commands

IDLE (n) Generator will insert n idle dwords into gen stream

CLEAR_CREDIT_AVAIL  This commands clears the credit established with 
the command WF_CREDIT_AVAIL. (See 
WF_CREDIT_AVAIL in following section on Wait 
Commands for explanation).  
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RD_POS   Generator will insert one idle dword into gen 
stream, which will bring current RD to positive level  

RD_NEG   Generator will insert one idle dword into gen 
stream, which will bring current RD to negative level  

RD_ERROR   Generator will insert one idle dword into gen 
stream, which will intentionally break RD sequence 
creating RD error  

CONNECT   Generator will go through connection sequence 
using current GenFile settings (gen mode, speed 
e.t.c.) Generation will not resume until connection is 
established  

DISCONNECT   Generator will break existing connection to DUT  

PAUSE   Generator will come to a break and the user will be 
able to resume generation by pressing Resume 
button on Generation toolbar. Generator shall 
transmit idle dwords while in the Pause.  

OUTPUT_ON   Takes the Trainer out of Electric Idle state. If it is 
already out of Electric Idle, this is a NOP.  

OOB Commands

COMINIT   Generator will send COMINIT OOB signals using 
current COMINIT settings.  

COMRESET   Generator will send COMRESET OOB signals 
using current COMRESET settings.  

COMWAKE   Generator will send COMWAKE OOB signals using 
current COMWAKE settings.  

COMSAS   Generator will send COMSAS OOB signals using 
current COMSAS settings.  

SATA_ALIGN   Generator will go through SATA_ALIGN stage of 
SATA SpeedNeg process using current 
SATA_ALIGN settings.  

SATA_D10_2   Generator will go through SATA_D10_2 stage of 
SATA SpeedNeg process using current 
SATA_D10_2 settings.  

SPEED_NEG_RCDT   Generator will go through SPEED_NEG_RCDT 
stage of SAS SpeedNeg process using current 
SPEED_NEG_RCDT settings.  

SPEED_NEG_ALIGN0   Generator will go through SPEED_NEG_ALIGN0 
stage of SAS SpeedNeg process using current 
SPEED_NEG_ALIGN0 settings.  
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SATA 
Commands

Look at STP sample file for syntax.

• SEND_SATA_FRAME
• SendSATAFrame
• SATAData
• SATA_Data
• SATACRC
• SATA_CRC
• SATAXXXX
• SATA_XXXX

Primitive 
Commands

The following is a list of SAS and SATA primitives declared in "Primitives.Decl.inc" as 
Symbol Chains.  If you want to use these primitives in your script you must also include 
"Primitives.Decl.inc" in your script.

• SOF
• EOF
• SOAF
• EOAF
• ALIGN (0) 
• ALIGN (1)
• ALIGN (2)
• ALIGN (3)
• NOTIFY (ENABLE SPINUP)
• NOTIFY (RESERVED 0)
• NOTIFY (RESERVED 1)
• NOTIFY (RESERVED 2)
• ACK
• NAK (CRC ERROR)
• NAK (RESERVED 0)
• NAK (RESERVED 1 
• NAK (RESERVED 2)
• CREDIT_BLOCKED
• RRDY (NORMAL)
• RRDY (RESERVED 0)
• RRDY (RESERVED 1)
• SATA_SOF
• SATA_EOF
• SATA_CONT

SPEED_NEG_ALIGN1   Generator will go through SPEED_NEG_ALIGN1 
stage of SAS SpeedNeg process using current 
SPEED_NEG_ALIGN1 settings.  
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• SATA_DMAT
• SATA_HOLD
• SATA_HOLDA
• SATA_PMACK
• SATA_PMNAK
• SATA_PMREQ_P
• SATA_PMREQ_S
• SATA_R_ERR
• SATA_R_IP
• SATA_R_OK
• SATA_R_RDY
• SATA_SYNC
• SATA_WTRM
• SATA_X_RDY
• SATA_ERROR
• AIP (NORMAL)
• AIP (RESERVED 0)
• AIP (RESERVED 1)
• AIP (RESERVED 2)
• AIP (RESERVED WAITING ON PARTIAL)
• AIP (WAITING ON CONNECTION)
• AIP (WAITING ON DEVICE)
• AIP (WAITING ON PARTIAL)
• BREAK
• BROADCAST (CHANGE)
• BROADCAST (RESERVED 0)
• BROADCAST (RESERVED 1)
• BROADCAST (RESERVED 2)
• BROADCAST (RESERVED 3)
• BROADCAST (RESERVED 4)
• BROADCAST (RESERVED CHANGE 0)
• BROADCAST (RESERVED CHANGE 1)
• CLOSE (CLEAR AFFILIATION)
• CLOSE (NORMAL)
• CLOSE (RESERVED 0)
• CLOSE (RESERVED 1)
• ERROR
• HARD_RESET
• OPEN_ACCEPT
• OPEN_REJECT (BAD DESTINATION)
• OPEN_REJECT (CONNECTION RATE NOT SUPPORTED)  
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• OPEN_REJECT (NO DESTINATION)
• OPEN_REJECT (PATHWAY BLOCKED)
• OPEN_REJECT (PROTOCOL NOT SUPPORTED)
• OPEN_REJECT (RESERVED ABANDON 0)
• OPEN_REJECT (RESERVED ABANDON 1)
• OPEN_REJECT (RESERVED ABANDON 2)
• OPEN_REJECT (RESERVED ABANDON 3)
• OPEN_REJECT (RESERVED CONTINUE 0)
• OPEN_REJECT (RESERVED CONTINUE 1)
• OPEN_REJECT (RESERVED INITIALIZE 0)
• OPEN_REJECT (RESERVED INITIALIZE 1)
• OPEN_REJECT (RESERVED STOP 0)
• OPEN_REJECT (RESERVED STOP 1)
• OPEN_REJECT (RETRY)
• OPEN_REJECT (STP RESOURCES BUSY)
• OPEN_REJECT (WRONG DESTINATION)
• DONE (ACK/NAK TIMEOUT)
• DONE (CREDIT TIMEOUT)
• DONE (NORMAL)
• DONE (RESERVED 0)
• DONE (RESERVED 1)
• DONE (RESERVED TIMEOUT 0)
• DONE (RESERVED TIMEOUT 1)              
• SAS Specific Script-Defined Constants

• SAS_AF_DT_NO_DEVICE_ATTACHED
• SAS_AF_DT_END_DEVICE
• SAS_AF_DT_EDGE_EXPANDER_DEVICE
• SAS_AF_DT_FANOUT_EXPANDER_DEVICE

• SAS_AF_FT_IDENTIFY
• SAS_AF_FT_OPEN

• SAS_AF_PROTOCOL_SMP
• SAS_AF_PROTOCOL_SSP
• SAS_AF_PROTOCOL_STP
• SAS_AF_PROTOCOL_UNKNOWN

• SAS_AF_RATE_1_5_GBPS
• SAS_AF_RATE_3_GBPS
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• SMP_FRAME_TYPE_REQUEST
• SMP_FRAME_TYPE_RESPONSE

• SMP_REPORT_GENERAL
• SMP_REPORT_MANUFACTURER_INFO
• SMP_DISCOVER
• SMP_REPORT_PHY_ERROR_LOG
• SMP_REPORT_PHY_SATA
• SMP_REPORT_ROUTE_INFO
• SMP_CONFIGURE_ROUTE_INFO
• SMP_PHY_CONTROL

• SSP_FRAME_TYPE_DATA
• SSP_FRAME_TYPE_XFER_RDY
• SSP_FRAME_TYPE_COMMAND
• SSP_FRAME_TYPE_RESPONSE
• SSP_FRAME_TYPE_TASK
• SSP_FRAME_TYPE_VENDOR

Wait 
Commands

Syntax: WAIT_FOR { <command1> <command2> ... <group1> <group2> ... } 
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WaitCommand Name Description

WF_TIMEOUT  Timeout Credit 
Available 

When WF_TIMEOUT is 
requested in WAIT_FOR 
command the wait ses-
sion will be released after 
timeout has elapsed. 

The Timeout value can be 
set two different ways:
1. Through the global 

WaitTimeout setting 
that can appear any-
where in generation. 
Default value is 1000 
microseconds. 

Syntax:
     Set WaitTimeout = 

<value> (in microsec-
onds) 

  2. Through local WaitTim-
eout value for this spe-
cific wait session. 

Syntax: 
 WAIT_FOR ( 
<number_of_microseco
nds> ) { WF_TIMEOUT 
<other_wait_commands
> } 
In this case wait for other 
commands will be 
released no later then 
after 
number_of_microsecond
s, but global WaitTime-
out value remains 
unchanged for future 
use. 

See Generation\Include\ 
WaitCommands.inc in 
your SASTracer program 
folder for the samples of 
syntax. 

WF_SOF   primitive

WF_EOF   primitive

WF_SOAF   primitive

WF_EOAF   primitive

WF_ACK   primitive

WF_NAK_CRC_ERROR   primitive
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WF_NAK_RESERVED_0   primitive

WF_NAK_RESERVED_1   primitive

WF_NAK_RESERVED_2   primitive

WF_CREDIT_AVAIL  Credit Available
This function is based on 
a 10-bit counter whose 
value can range  from 
-512 to +511 (twos-com-
plement). This counter is 
cleared  by sending or 
receiving an 
OPEN_ACCEPT primi-
tive, or by  execution of a 
CLEAR_CREDIT_AVAIL 
command in the script. 

This counter is incre-
mented by receiving any 
SAS RRDY primitive and 
is decremented by send-
ing SAS SOF. The 
wait_for command will 
wait for this counter to 
have a positive value 
between +1 and  +511. 
This wait_for condition is 
intended to be used 
before sending a SAS 
frame within a connec-
tion.
ClEAR_CREDIT_AVAIL 
clears this credit function.

WF_CREDIT_BLOCKED_RECEIVED CreditBlocked 
Received

This function is based on 
a flip-flop which is cleared 
by sending or  receiving 
an OPEN_ACCEPT primi-
tive. It is set by receiving a  
CREDIT_BLOCKED prim-
itive. It is intended to be 
used in conjunction  with 
wf_credit_avail to prevent 
script hangs in those 
cases where there  is not 
going to be any more 
credit granted. 

WF_CREDIT_BLOCKED   primitive

WaitCommand Name Description
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WF_RRDY_NORMAL   primitive

WF_RRDY_RESERVED_0   primitive

WF_RRDY_RESERVED_1   primitive

WF_BREAK   primitive

WF_CLOSE_CLEAR_AFFILIATION   primitive

WF_CLOSE_NORMAL   primitive

WF_CLOSE_RESERVED_0   primitive

WF_CLOSE_RESERVED_1   primitive

WF_DONE_ACK_NAK_TIMEOUT   primitive

WF_DONE_CREDIT_TIMEOUT   primitive

WF_DONE_NORMAL   primitive

WF_DONE_RESERVED_0   primitive

WF_DONE_RESERVED_1   primitive

WF_DONE_RESERVED_TIMEOUT_0   primitive

WF_DONE_RESERVED_TIMEOUT_1   primitive

WF_ERROR   primitive

WF_HARD_RESET   primitive

WF_AIP_NORMAL   primitive

WF_AIP_RESERVED_0   primitive

WF_AIP_RESERVED_1   primitive

WaitCommand Name Description
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WF_AIP_RESERVED_2   primitive

WF_AIP_RESERVED_WAIT_ON_PART   primitive

WF_AIP_WAIT_ON_CONN   primitive

WF_AIP_WAIT_ON_DEVICE   primitive

WF_AIP_WAIT_ON_PARTIAL   primitive

WF_IDENTIFY_FRAME   Identify 
Address  Frame

WF_OPEN_FRAME   Open Address 
Frame

WF_SMP_REQUEST   SMP Request 
Frame

WF_SMP_RESPONSE   SMP Response 
Frame

WF_REC_RESOURCES_OUTPUT_A  Advanced Wait 
Condition A
This command causes 
generation to wait for 
Event "A" to occur that 
you defined in the Gen-
eration Options dialog 
described at the end of 
this chapter.

WF_REC_RESOURCES_OUTPUT_B  Advanced Wait 
Condition B
This command causes 
generation to wait for 
Event "B" to occur that 
you defined in the Gen-
eration Options dialog 
described at the end of 
this chapter.

WaitCommand Name Description
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WF_REC_RESOURCES_OUTPUT_C  Advanced Wait 
Condition C
This command causes 
generation to wait for 
Event "C" to occur that 
you defined in the Gen-
eration Options dialog 
described at the end of 
this chapter.

WF_REC_RESOURCES_OUTPUT_D  Advanced Wait 
Condition D
This command causes 
generation to wait for 
Event "D" to occur that 
you defined in the Gen-
eration Options dialog 
described at the end of 
this chapter.

WF_REC_RESOURCES_OUTPUT_E  Advanced Wait 
Condition E
This command causes 
generation to wait for 
Event "E" to occur that 
you defined in the Gen-
eration Options dialog 
described at the end of 
this chapter.

WF_REC_RESOURCES_OUTPUT_F  Advanced Wait 
Condition F
This command causes 
generation to wait for 
Event "F" to occur that 
you defined in the Gen-
eration Options dialog 
described at the end of 
this chapter.

WF_COMRESET_COMINIT   COMRESET 
OOB Signals

WF_COMSAS   COMSAS OOB 
Signals

WF_COMWAKE   COMWAKE 
OOB Signals

WaitCommand Name Description
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WF_BLOCK1_MISC_RESERVED_0    reserved 

WF_BLOCK1_MISC_RESERVED_1    reserved 

WF_BLOCK1_MISC_RESERVED_2    reserved 

WF_BLOCK1_MISC_RESERVED_3    reserved 

WF_BLOCK1_MISC_RESERVED_4    reserved 

WF_SATA_CONT   primitive

WF_SATA_DMAT   primitive

WF_SATA_EOF   primitive

WF_SATA_ERROR   primitive

WF_SATA_HOLD   primitive

WF_SATA_HOLDA   primitive

WF_SATA_PMACK   primitive

WF_SATA_PMNAK   primitive

WF_SATA_PMREQ_P   primitive

WF_SATA_PMREQ_S   primitive

WF_SATA_R_ERR   primitive

WF_SATA_R_IP   primitive

WF_SATA_R_OK   primitive

WF_SATA_R_RDY   primitive

WF_SATA_SOF   primitive

WF_SATA_SYNC   primitive

WF_SATA_WTRM   primitive

WF_SATA_X_RDY   primitive

WF_OPEN_ACCEPT   primitive

WaitCommand Name Description
216 LeCroy Corporation



SASSuite User Manual Version 6.2
WF_OPEN_REJECT_BAD_DESTINATION   primitive

WF_OPEN_REJECT_CONN_RATE_NOT_SUPPOR
TED  

 primitive

WF_OPEN_REJECT_NO_DESTINATION   primitive

WF_OPEN_REJECT_PATHWAY_BLOCKED   primitive

WF_OPEN_REJECT_PROTOCOL_NOT_SUPPORT
ED  

 primitive

WF_OPEN_REJECT_RETRY   primitive

 WF_OPEN_REJECT_STP_RESOURCES_BUSY   primitive

WF_OPEN_REJECT_WRONG_DESTINATION   primitive

WF_OPEN_REJECT_RESERVED_ABANDON_0   primitive

WF_OPEN_REJECT_RESERVED_ABANDON_1   primitive

WF_OPEN_REJECT_RESERVED_ABANDON_2   primitive

WF_OPEN_REJECT_RESERVED_ABANDON_3   primitive

WF_OPEN_REJECT_RESERVED_CONTINUE_0   primitive

WF_OPEN_REJECT_RESERVED_CONTINUE_1   primitive

WF_OPEN_REJECT_RESERVED_INITIALIZE_0   primitive

WF_OPEN_REJECT_RESERVED_INITIALIZE_1   primitive

WF_OPEN_REJECT_RESERVED_STOP_0   primitive

WF_OPEN_REJECT_RESERVED_STOP_1   primitive

WF_ALIGN_0   primitive

WF_ALIGN_1   primitive

WF_ALIGN_2   primitive

WF_ALIGN_3   primitive

WF_NOTIFY_ENABLE_SPINUP   primitive

WaitCommand Name Description
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WF_NOTIFY_RESERVED_0   primitive

WF_NOTIFY_RESERVED_1   primitive

WF_NOTIFY_RESERVED_2   primitive

WF_BROADCAST_CHANGE   primitive

WF_BROADCAST_RESERVED_0   primitive

WF_BROADCAST_RESERVED_1   primitive

WF_BROADCAST_RESERVED_2   primitive

WF_BROADCAST_RESERVED_3   primitive

WF_BROADCAST_RESERVED_4   primitive

WF_BROADCAST_RESERVED_CHANGE_0   primitive

WF_BROADCAST_RESERVED_CHANGE_1   primitive

WF_BLOCK2_MISC_RESERVED_0    reserved 

WF_BLOCK2_MISC_RESERVED_1    reserved 

WaitCommand Name Description
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Wait 
Command 
Groups

 

Wait Command Group  Group Contents

WF_TIMEOUT WF_TIMEOUT_BLOCK_ONE
WF_TIMEOUT_BLOCK_TWO

WF_ALL_SOF  
 

WF_SOF   

WF_SOAF 

WF_ALL_EOF  WF_EOF   

WF_SOAF 

WF_NAK  WF_NAK_CRC_ERROR   

WF_NAK_RESERVED_0   

WF_NAK_RESERVED_1   

WF_NAK_RESERVED_2  

WF_RRDY  WF_RRDY_NORMAL   

WF_RRDY_RESERVED_0   

WF_RRDY_RESERVED_1  

WF_CREDIT_OK  WF_CREDIT_AVAIL   

WF_CREDIT_BLOCKED_RECEIVED  

WF_CLOSE  WF_CLOSE_CLEAR_AFFILIATION   

WF_CLOSE_NORMAL   

WF_CLOSE_RESERVED_0   

WF_CLOSE_RESERVED_1  
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WF_DONE  WF_DONE_ACK_NAK_TIMEOUT   

WF_DONE_CREDIT_TIMEOUT   

WF_DONE_NORMAL   

WF_DONE_RESERVED_0   

WF_DONE_RESERVED_1   

WF_DONE_RESERVED_TIMEOUT_0   

WF_DONE_RESERVED_TIMEOUT_1  

WF_AIP  WF_AIP_NORMAL   

WF_AIP_RESERVED_0   

WF_AIP_RESERVED_1   

WF_AIP_RESERVED_2   

WF_AIP_RESERVED_WAIT_ON_PART   

WF_AIP_WAIT_ON_CONN   

WF_AIP_WAIT_ON_DEVICE   

WF_AIP_WAIT_ON_PARTIAL  

WF_REC_RESOURCES  WF_REC_RESOURCES_OUTPUT_A   

WF_REC_RESOURCES_OUTPUT_B   

WF_REC_RESOURCES_OUTPUT_C   

WF_REC_RESOURCES_OUTPUT_D   

WF_REC_RESOURCES_OUTPUT_E   

WF_REC_RESOURCES_OUTPUT_F  

WF_RCV_STATUS  
  

WF_SATA_R_ERR

WF_SATA_R_OK

Wait Command Group  Group Contents
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WF_PM_REQ  
  

WF_SATA_PMREQ_P   

WF_SATA_PMREQ_S

WF_PM_STATUS  
  

WF_SATA_PMACK   

WF_SATA_PMNAK

WF_OPEN_REJECT  WF_OPEN_REJECT_BAD_DESTINATION   

WF_OPEN_REJECT_CONN_RATE_NOT_
SUPPORTED   

WF_OPEN_REJECT_NO_DESTINATION   

WF_OPEN_REJECT_PATHWAY_BLOCKED   

WF_OPEN_REJECT_PROTOCOL_NOT_
SUPPORTED   

WF_OPEN_REJECT_RETRY   

WF_OPEN_REJECT_STP_RESOURCES_ 
BUSY   

WF_OPEN_REJECT_WRONG_
DESTINATION   

WF_OPEN_REJECT_RESERVED_ 
ABANDON_0   

WF_OPEN_REJECT_RESERVED_ 
ABANDON_1   

Wait Command Group  Group Contents
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WF_OPEN_REJECT  
(continued...)

WF_OPEN_REJECT_RESERVED_ 
ABANDON_2   

WF_OPEN_REJECT_RESERVED_ 
ABANDON_3   

WF_OPEN_REJECT_RESERVED_ 
CONTINUE_0   

WF_OPEN_REJECT_RESERVED_ 
CONTINUE_1   

WF_OPEN_REJECT_RESERVED_ 
INITIALIZE_0   

WF_OPEN_REJECT_RESERVED_ 
INITIALIZE_1   
WF_OPEN_REJECT_RESERVED_STOP_0   

WF_OPEN_REJECT_RESERVED_STOP_1  

WF_OPEN_RESPONSE  
  

WF_OPEN_ACCEPT   

WF_OPEN_REJECT

WF_ALIGN  WF_ALIGN_0   

WF_ALIGN_1   

WF_ALIGN_2   

WF_ALIGN_3  

WF_NOTIFY  WF_NOTIFY_ENABLE_SPINUP   

WF_NOTIFY_RESERVED_0   

WF_NOTIFY_RESERVED_1   

WF_NOTIFY_RESERVED_2  

Wait Command Group  Group Contents
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Predefined 
Constants

WF_BROADCAST  WF_BROADCAST_CHANGE   

WF_BROADCAST_RESERVED_0   

WF_BROADCAST_RESERVED_1   

WF_BROADCAST_RESERVED_2   

WF_BROADCAST_RESERVED_3   

WF_BROADCAST_RESERVED_4   

WF_BROADCAST_RESERVED_CHANGE_
0   

WF_BROADCAST_RESERVED_CHANGE_
1  

Wait Command Group  Group Contents

Predefined Constant Internal Value

GEN_MODE_ERROR 0

GEN_MODE_SATA_HOST 1

GEN_MODE_SATA_DEVICE 2

GEN_MODE_SAS_INITIATOR 3

GEN_MODE_SAS_TARGET 4

GEN_LINK_SPEED_1_5G 0

GEN_LINK_SPEED_3G 1

SCRAMBLING_MODE_NONE 0

SCRAMBLING_MODE_SAS 1

SCRAMBLING_MODE_SATA 2
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Generation 
Settings

Setting
Default 
Value Description 

Global Settings

GenerationMode    >>>>>   Generation Mode - must be defined or no 
generation will take place.  Possible Values:  
GEN_MODE_SATA_HOST  
GEN_MODE_SATA_DEVICE  
GEN_MODE_SAS_INITIATOR  
GEN_MODE_SAS_TARGET  

Default Value:  GEN_MODE_ERROR - undefined 
mode 

SSC    0   Spread Spectrum Clocking mode for SATA. Can 
only be set outside Generation block. 

MultiSpeedMode    0  When set, the change of speed within Generation 
block is allowed with following syntax: set Speed = 
LINK_SPEED_1_5G / LINK_SPEED_3G. 

Output Disable   0 This very poorly named register bit forces the 
Trainer to output data.  It is a little like the output_on 
script command except that its effect cannot be 
undone for the duration of the script. If this is turned 
on, none of the out-of-band commands will work, as 
the output enable is forced on.

AutoMode Settings

AutoOOBMode   0 When set, the generator will go through the stages 
of bringing up the link automatically, including 
waiting for and responding to the device or host it is 
connected to. 

AutoHoldMode    0  When set, the generator will respond automatically 
to Hold requests. Not supported for version 1.1 
(reserved). 

AutoDMAT    0  When set, the generator will respond automatically 
to DMAT requests. Not supported for version 1.1 
(reserved). 

AutoHandshake    0  When set, the generator will respond automatically 
to TBD commands. Not supported for version 1.1 
(reserved). 

AutoSpeedNeg    0  When set, the generator will automatically go 
throughthe speed negotiation process, for the 
speed set in the PINTERFACEC_SERDES register 
for the Trainer. 
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AutoAlignSATA    0  When set, the generator will automatically inserting 
the stream 2 Align(0) primitives every 254 dwords, 
as specified in the SATA spec. 

AutoAlignSAS    0  When set, the generator will automatically inserting 
the stream Align primitives every 2048 dwords, as 
specified in the SAS spec.Two Align modes can be 
turned on simultaneously, to support STP

COMINIT Settings

COMINIT_NegLen    800  The number of bursts to send as part of this OOB 
type.Each Burst is followed by an Idle. The 
Burst-Idle pairs are repeated the requested number 
of times, and then followed by the Negation_length 
of Idle. 

COMINIT_IdleLen    480  Burst time between each OOB idle in OOBIs.During 
the specified period, the generator will send 
ALIGN(0) at the specified speed. 

COMINIT_BurstLen    160  Idle time between each OOB burst in OOBIs.During 
the specified period, the generator will keep the line 
at electric idle. 

COMINIT_NumBursts    6  Negation time at the end of the OOB signal in 
OOBIs.During the specified period, the generator 
will keep the line at electric idle. 

COMWAKE Settings

COMWAKE_NegLen    280  The number of bursts to send as part of this OOB 
type.Each Burst is followed by an Idle. The 
Burst-Idle pairs are repeated the requested number 
of times, and then followed by the Negation_length 
of Idle. 

COMWAKE_IdleLen    160  Burst time between each OOB idle in OOBIs.During 
the specified period, the generator will send 
ALIGN(0) at the specified speed. 

COMWAKE_BurstLen    160  Idle time between each OOB burst in OOBIs.During 
the specified period, the generator will keep the line 
at electric idle. 

COMWAKE_NumBursts    6  Negation time at the end of the OOB signal in 
OOBIs.During the specified period, the generator 
will keep the line at electric idle. 

Setting
Default 
Value Description 
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COMSAS Settings

COMSAS_NegLen    2400  The number of bursts to send as part
type.Each Burst is followed by an Idle
Burst-Idle pairs are repeated the requ
of times, and then followed by the Ne
of Idle. 

COMSAS_IdleLen    1440  Burst time between each OOB idle in
the specified period, the generator w
ALIGN(0) at the specified speed. 

COMSAS_BurstLen    160  Idle time between each OOB burst in
the specified period, the generator wi
at electric idle. 

COMSAS_NumBursts    6  Negation time at the end of the OOB
OOBIs.During the specified period, th
will keep the line at electric idle. 

SATA Link Init Settings

OOB_SATA_D102_Time    100000  D10.2 time for SATA link synchroniza
OOBIs.During the specified period, th
will transmit D10.2 symbols. 

OOB_SATA_Align_Time    100000  ALIGN(0) time for SATA link synchron
OOBIs.During the specified period, th
will transmit ALIGN(0) primitives. 

SAS Speed Negotiation Settings

OOB_SAS_Align1_Time    81920  ALIGN(1) time for SAS speed negotia
OOBIs.During the specified period, th
will transmit ALIGN(1) primitives. 

OOB_SAS_Align0_Time    81920  ALIGN(0) time for SAS speed negotia
OOBIs.During the specified period, th
will transmit ALIGN(0) primitives. 

OOB_SAS_Interspeed_Tim
e  

  750000  Interspeed time for SAS speed negot
OOBIs.During the specified period, th
will keep the line at electric idle. 

Setting
Default 
Value Description 
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SATA Speed Negotiation Settings

OOB_SpeedNeg_RCDT    750000  Maximum time in OOBIs during the speed 
negotiation window for a transmitter to reply with 
ALIGN(1). 

OOB_SpeedNeg_SNTT    163840  Time in OOBIs during which ALIGN(0) or ALIGN(1) 
is transmitted at each physical link rate during the 
speed negotiation sequence. 

OOB_SpeedNeg_SNLT    153600  Time in OOBIs during which the transmitter shall 
transmit idle between rates during speed 
negotiation. 

Speed Settings

Speed    >>>>>   Link Speed  Possible Values:  LINK_SPEED_1_5G  
LINK_SPEED_3G  Default Value:  
LINK_SPEED_1_5G

RateMatching    0  When set, the generator will automatically inserting 
the stream Align(0) primitive after every dword. 

Setting
Default 
Value Description 
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Scrambling Mode Settings

ScramblingMode    >>>>>   Raw Data Scrambling Mode - Only those raw 
dwords will be scrambled that contain only data 
bytes (no 10bit symbols or 'K' bytes. Scrambling is 
reset by changing ScramblingMode or by any valid 
SAS or SATA frame.  Possible Values:  
SCRAMBLING_MODE_NONE  
SCRAMBLING_MODE_SAS  
SCRAMBLING_MODE_SATA  Default Value:  
SCRAMBLING_MODE_NONE

Wait Timeout Settings

WaitTimeout    1000  Sets global WaitTimeout value in microseconds 

AUTO_WAIT_SAS_AFTER Settings

AUTO_WAIT_SAS_AFTER
_ 
CLOSE_FOR_CLOSE  

  FALSE  When set, the generator will insert WAIT_FOR 
CLOSE command immediately after each CLOSE 
primitive. 

AUTO_WAIT_SAS_AFTER
_EOF_FOR_ACK  

  FALSE  When set, the generator will insert WAIT_FOR ACK 
command immediately after each EOF primitive. 

AUTO_WAIT_SAS_AFTER
_EOF_FOR_ACK_OR_NAK  

  FALSE  When set, the generator will insert WAIT_FOR ACK 
or NAK command immediately after each EOF 
primitive. 

AUTO_WAIT_SAS_AFTER
_ 
OPEN_FOR_OPEN_ACCE
PT  

  FALSE  When set, the generator will insert WAIT_FOR 
OPEN_ACCEPT command immediately after each 
Open Address Frame. 

AUTO_WAIT_SAS_AFTER
_ 
OPEN_FOR_OPEN_REJE
CT  

  FALSE  When set, the generator will insert WAIT_FOR 
OPEN_REJECT command immediately after each 
Open Address Frame. 

AUTO_WAIT_SAS_AFTER
_ 
IDENTIFY_FOR_IDENTIFY
_ 
FRAME  

  FALSE  When set, the generator will insert WAIT_FOR 
Identify Frame command immediately after each 
Identify Address Frame. 

AUTO_WAIT_SAS_AFTER
_SMP_REQ_FOR_RESP  

  FALSE  When set, the generator will insert WAIT_FOR SMP 
Response Frame command immediately after each 
SMP Request Frame. 

AUTO_WAIT_SAS_BEFORE Settings

Setting
Default 
Value Description 
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AUTO_WAIT_SAS_BEFOR
E_ 
CLOSE_FOR_CLOSE  

  FALSE  When set, the generator will insert WAIT_FOR 
CLOSE command right before each CLOSE 
primitive. 

AUTO_WAIT_SAS_BEFOR
E_ 
SOF_FOR_CREDIT  

  FALSE  When set, the generator will insert WAIT_FOR 
CREDIT command right before each SOF primitive. 

AUTO_WAIT_SAS_BEFOR
E_ 
IDENTIFY_FOR_IDENTIFY
_ 
FRAME 

  FALSE  When set, the generator will insert WAIT_FOR 
Identify Frame command right before each Identify 
Address Frame. 

 
AUTO_WAIT_SAS_BEFOR
E_ 
OPEN_ACCEPT_FOR_OP
EN  

  FALSE  When set, the generator will insert WAIT_FOR 
Open Frame command right before each 
OPEN_ACCEPT primitive. 

 
AUTO_WAIT_SAS_BEFOR
E_ 
OPEN_REJECT_FOR_OP
EN  

  FALSE  When set, the generator will insert WAIT_FOR 
Open Frame command right before each 
OPEN_REJECT primitive. 

 
AUTO_WAIT_SAS_BEFOR
E_AIP_FOR_OPEN  

  FALSE  When set, the generator will insert WAIT_FOR 
Open Frame command right before each primitive 
of AIP group. 

AUTO_WAIT_SAS_BEFOR
E_ 
SMP_RESP_FOR_REQ  

  FALSE  When set, the generator will insert WAIT_FOR SMP 
Request Frame command right before each SMP 
Response Frame. 

AUTO_WAIT_SATA_AFTER Settings

AUTO_WAIT_SATA_AFTE
R_X_RDY_FOR_R_RDY  

  FALSE  When set, the generator will insert WAIT_FOR 
SATA_R_RDY command immediately after each 
case of SATA_CONT primitive following 
SATA_X_RDY primitive. 

AUTO_WAIT_SATA_AFTE
R_ 
WTRM_FOR_STATUS  

  FALSE  When set, the generator will insert WAIT_FOR 
SATA_R_ERR or SATA_R_OK command 
immediately after each case of SATA_CONT 
primitive following SATA_WTRM primitive. 

AUTO_WAIT_SATA_AFTE
R_PMREQ_S_FOR_RESP
ONSE  

  FALSE  When set, the generator will insert WAIT_FOR 
SATA_PMACK or SATA_PMNAK command 
immediately after each case of SATA_CONT 
primitive following SATA_PMREQ_S primitive. 

Setting
Default 
Value Description 
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Setting Complex "Wait For" Conditions
The Generation Options dialog lets users define complex "Wait For" events and assign a 
letter value ("A" through "F") to the definition so that you can refer to the definition by letter 
instead of by textual name.  

Once a letter value has been assigned to an event, the letter is referred to in your 
generation script using the following command syntax:

Wait_For {WF_REC_RESOURCES_OUTPUT_A}
where "A," in this case, is the defined condition.

AUTO_WAIT_SATA_AFTE
R_PMREQ_P_FOR_RESP
ONSE  

  FALSE  When set, the generator will insert WAIT_FOR 
SATA_PMACK or SATA_PMNAK command 
immediately after each case of SATA_CONT 
primitive following SATA_PMREQ_P primitive. 

 
AUTO_WAIT_SATA_AFTE
R_ 
SYNC_FOR_SYNC  

  FALSE  When set, the generator will insert WAIT_FOR 
SATA_SYNC command immediately after each 
case of SATA_CONT primitive following 
SATA_SYNC primitive. 

AUTO_WAIT_SATA_BEFORE Settings

AUTO_WAIT_SATA_BEFO
RE_ 
PMACK_FOR_PMREQ  

  FALSE  When set, the generator will insert WAIT_FOR 
SATA_PMREQ_S or SATA_PMREQ_P command 
right before each SATA_PMACK primitive. 

AUTO_WAIT_SATA_BEFO
RE_ 
PMNAK_FOR_PMREQ  

  FALSE  When set, the generator will insert WAIT_FOR 
SATA_PMREQ_S or SATA_PMREQ_P command 
right before each SATA_PMNAK primitive. 

AUTO_WAIT_SATA_BEFO
RE_ 
RERR_FOR_WTRM  

  FALSE  When set, the generator will insert WAIT_FOR 
SATA_R_ERR command right before each 
SATA_WTRM primitive. 

AUTO_WAIT_SATA_BEFO
RE_ 
ROK_FOR_WTRM  

  FALSE  When set, the generator will insert WAIT_FOR 
SATA_R_OK command right before each 
SATA_WTRM primitive. 

AUTO_WAIT_SATA_BEFO
RE_RIP_FOR_SOF  

  FALSE  When set, the generator will insert WAIT_FOR 
SATA_R_IP command right before each 
SATA_SOF primitive. 

AUTO_WAIT_SATA_BEFO
RE_ 
R_RDY_FOR_X_RDY  

  FALSE  When set, the generator will insert WAIT_FOR 
SATA_X_RDY command right before each 
SATA_R_RDY primitive. 

Setting
Default 
Value Description 
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Setting 
Conditions 
with the 
Generation 
Options 
Dialog

To set a complex condition, open the Generation Options dialog: 

Step 1 Select Generate > Generation Options from the menu.  The 
Generation Options dialog opens.  The Generation Options 
dialog looks very similar to the Recording Rules dialog:  

Step 2 Click the New Events button and select an event from the menu.  
The selected event should appear in the Available Events area 
along the left side of the dialog box.

Step 3 Drag the new event button to the Global State cell.

Step 4 Right-click on the new event button and select Specify Action(s).  A 
menu appears showing the letters A through F and the option "No 
action."
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Step 5 Select a letter from the menu.  
The menu closes.  The event 
button should now point to a 
neighboring button that has the 
letter value you assigned.  

Step 6 Once the condition has been defined, you can then add the Wait 
For command line (with whatever letter you assigned) to your 
script.  For example: 
Wait_For {WF_REC_RESOURCES_OUTPUT_A}
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Chapter 14:  SASTracker Systems
The SASTracker Command Analyzer option for SASTracer systems is designed to track 
commands in a SAS or SATA network that can involve up to 8 initiators and up to 128 
targets.  Within this matrix, SASTracker will track all commands issued and completed, 
included queue depths up to the full 16 bit depth provided for in the SAS specification.

Product Configurations
SASTracker capability is supported on the same hardware modules that support 
SASTracer systems (see “Analyzer Hardware Description” on page 7).  Running the 
SATracer option uses a different BusEngine and cannot operate simultaneously with 
SASTracer on the same CATC 10K system.  A simple menu selection converts back and 
forth between the two capabilities.

Theory of Operation
The SASTracker Command Analyzer option monitors traffic and identifies all new 
commands issued and command completions sent in an active SAS/SATA environment.  
Every command issued is tracked, and when any command exceeds a user-defined 
timeout (which can vary based on command type), the system triggers and provides a 
Command Log File of up to the last 8 million commands issued. 

SASTracker monitors live traffic in a SAS or SATA network, and each time a command 
is issued SASTracker records information on that command and begins to track that 
command to determine when it is completed, how it is completed, and to trigger on any 
command that fails to complete within user-defined timeout periods.

The Command Log File generated by SASTracker will contain information about every 
command initiated and completed during the session.  In addition, the Command Log File 
will contain "command fragments" of two types:

Incompletes: Command Start Events that were not completed during the recording 
session.  These may include commands which exceeded the 
user-defined timeout, or simply commands that were issued near the 
end of the recording and did not have time to complete before 
recording was stopped.  

Orphans: Command End Events that do not correspond to any issued command 
that is present in the recording.  Called "orphans", these typically occur 
when recording is started during live traffic, resulting in command 
completions being observed for commands that were issued prior to 
the start of recording.  Orphans also occur in recordings that "wrap", 
where the available memory space has been exceeded and the user 
has specified that the recording should continue until a trigger 
condition is encountered. 

For command timeout purposes, the SASTracker Analyzer actively tracks all commands 
which have been issued, but for which no Command End Event has yet occurred.  Once 
a Command End Event that terminates that command has occurred, the command is no 
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longer actively tracked, but the information on that command will still be present in the 
Command Log File (provided the Command Log File does not wrap and overwrite the 
data).

Note that Command End Events may not all be successful command completions.  
Events such as CHECK_CONDITION result in termination of a command in a way 
consistent with the SCSI protocol, and will result in the command being terminated 
without generating a timeout trigger condition.

When a trigger condition is reached (or when the desired recording size is reached when 
in "snapshot" mode), the recording will stop and the Command Log File will be available 
for viewing.

Note:  Catastrophic events such as Bus Resets which result in all 
commands being terminated are not supported by SASTracker.

Installing the SASTracker Command Analyzer
The SASTracker Command Analyzer option is installed and connected to systems in 
exactly the same way as the SASTracer Protocol Analyzer (see “Installation” on page 7).  
Both systems reside in the traffic pathway on a SAS/SATA link.

If not already installed, the SASSuite software should be installed on the host PC as 
described in “Installing the SASSuite Software” on page 15.

Changing 
the 
BusEngine

If the system is being operated as both a SASTracer Protocol Analyzer and a 
SASTracker Command Analyzer, the BusEngine will need to be changed each time the 
unit is converted between the two functions.  As noted previously, the same hardware can 
support both functions, but the two functions cannot coexist at the same time.  If both 
tracing and tracking are required simultaneously, two separate CATC 10K platforms must 
be used.

To check which BusEngine is currently loaded, select the About... option from the Help 
menu.

To switch from one BusEngine to the other, select the Switch ... to ... option under the 
Setup menu.  This option will display whenever a SASTrainer or SASTracker System is 
connected to the host PC.  If multiple systems are connected, a selection will show for 
each connected analyzer.  Make sure that the analyzer you wish to update is connected 
to the host PC and is turned on.
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Once selected, a screen will appear asking you to confirm the choice.  Select "Yes".

A progress bar will show the progress of the update.  

When the update completes, the analyzer will be restarted and a screen will appear 
confirming the update process.  Click on "OK".
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Preparing to Track a Command Sequence
Before starting to track commands with the SASTracker Command Analyzer, you should 
first set up the recording options by selecting Tracker Options under the Tracker menu 
(or under the Setup Menu--but do not use "Recording Options", that selection applies to 
SASTracer only).

Note:  If you have more than one SASTracker System attached, you will 
see a submenu allowing you to choose whether to set the Tracker 
Options for all systems, or for a specific system only.

Note:  In this and the following sections, the menu selections available in 
the Tracker menu are also available as icons in the Tracker Toolbar, 
as follows:

Tracker Buttons 

Start Tracking
Tracker Options (if multiple 
SASTracker systems are 
connected, this button is used for 
"All Devices" by default).

Stop Tracking
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Selecting the Tracker Options menu selection brings up the following screen:

Tracking 
Type

There are two types of tracking, differentiated by the way the recording is terminated, as 
listed below.  

• Manual Trigger:  In this mode, recording continues until  Stop Tracking is 
selected in the Tracker menu.  If the recording memory (defined in the 
Tracker Archive Memory Size selection) is exceeded, the recording wraps 
and recording continues, overwriting the oldest contents of the recording 
memory.  The recording will continue to wrap (multiple times if necessary) 
until the manual trigger is pressed or recording is otherwise stopped.
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• Timeout Trigger:  In this mode, recording normally continues until one of the 
commands issued fails to complete within the user-defined Trigger Timeout 
period.  In this mode, recording can also be stopped by using the Stop 
Tracking selection in the Tracker menu.

Misc. 
Options

Under Miscellaneous Options, there is an option for the SASTracker to provide a beep 
to alert the user when a trigger occurs.

Tracker 
Archive 
Memory 
Size

Under Tracker Archive Memory Size, the user may decide how large a recording file to 
generate by specifying the maximum file size in MB.  The maximum value for this setting 
is roughly 1024 MB (1 GB).  This setting affects when recording is terminated while using 
snapshot mode, and affects when recording wraps when using either trigger mode.  Each 
1MB of recording memory represents information on approximately 10,000 completed 
commands.

Time Out 
Triggering 
Options

Under Time Out Triggering Options, the user may specify the trigger timeout to use 
with each of seven command classes.  This value in each class may vary from 0 to 32 
seconds, and can be specified in integer units of seconds, milliseconds, microseconds or 
nanoseconds.  Very small values are likely to result in almost immediate termination of 
the recording when Timeout Trigger mode is selected.

The seven command classes are as follows:
• SSP Read

• SSP Write

• SSP Other (any SSP command other than Read or Write)

• SATA Read

• SATA Write

• SATA Other (any SATA command other than Read or Write)

• SMP

Any of the seven command classes can be included as a trigger condition by selecting 
the checkbox to the left of the command class.  Each selected command class is treated 
as a trigger condition such that any command timeout violation in any selected class will 
result in the system triggering.

For example, the user may specify that SSP Read commands that fail to complete within 
100 microseconds are a trigger condition, but that SSP Write commands are allowed 1 
second to complete.  This allows the user to "fine tune" the trigger conditions to focus on 
specific command classes.

When the system triggers, tracking is stopped and the user is informed that a trigger has 
occurred.

Command 
Log 
Filename

Under Command Log Filename & Path, the user can define the name of the file to be 
used for storing the recording when completed.  
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Saving 
Tracker 
Option 
Settings

When a specified set of Tracker Options has been established, the conditions may be 
saved by giving the options a name (under Options Name) and then choosing "Save..." 
or "Save as Default".  A previously saved set of options can be reloaded by selecting the 
"Load..." button.

By selecting the "Channel Settings" tab, the following options are displayed:

Speed 
Settings

The SASTracker system supports Autodetect Link Rate which is designed to pass 
through the speed negotiation signaling allowing the initiator and device to determine the 
link speed using the method defined in the SAS specification. In general, this is the most 
convenient setting to use because it ensures the traffic will get recorded at the negotiated 
rate. Alternatively, users may force the analyzer to record at the 1.5G or 3G rate. 
However, if the negotiated link speed is higher or lower than the speed selected in this 
tab, SASTracker will not decode the traffic properly. The user will know if devices are 
negotiating successfully by getting clean recordings.

Channel 
Settings

These options allow you to inhibit recording on a channel by channel basis.

Inhibit - Inhibits recording of traffic from selected channels.  For example, if you check 
the option for T1, it means "record all channels except for Target channel 1 (T1)."
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By selecting the "Advanced Options" tab, the following screen is displayed:

Tracker 
Sweeping

Under Tracker Sweeping, the user may select whether to enable sweeping and the 
sweeping interval.  "Sweeping" refers to the rate at which SASTracker checks for 
incomplete commands which have exceeded the timeout trigger period.  The 
SASTracker BusEngine divides available processing time between the tasks of (a) 
processing incoming commands and command terminations, and (b) monitoring for any 
commands that have exceeded the trigger timeout period.  If the incoming traffic has a 
large number of very short commands with little data interspersed, or has a large number 
of complex command termination situations where multiple commands are ended with a 
single event, more time may be needed for command processing in order to keep up with 
the command flow.  In such situations, the user can increase the interval of tracker 
sweeping to allow a larger portion of processing time to go towards command 
processing.

Note:  If Tracker Sweeping is disabled but the Timeout Trigger mode is 
selected, the SASTracker system will still trigger when a Command 
End Event occurs that exceeds the defined Timeout Trigger value.  
However, in this situation the system will not be able to detect a 
timeout trigger due to commands that never receive a Command 
End Event (i.e., lost commands). 
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Viewing Command Log Files
Command Log Files are displayed by SASSuite in a format very similar to trace displays 
captured by SASTracer (discussed in “Reading a Recording” on page 125).

A typical SASTracker Command Log File is shown below.

In this file, we can see a simple set of events (commands and completions) taking place 
between one initiator and one target device.  The value under the "CMD START" and 
"CMD COMPLETE" headings is the Command ID which is assigned by SASTracker 
(when the command is first issued) as a unique ID number for that particular command.

A more useful way to view this file (and many other SASTracker Command Log Files) is 
to select the transaction-oriented view by selecting Transport Layer under the View 
menu.  The resulting view is as follows:
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In this view, related events are grouped together as commands, and each command can 
be expanded to show the Command Start Event and Command End Event, as has been 
shown above in Command 2.  To expand (or combine) commands, click on the small 
arrow in the upper left corner of the "Command XX" box.

When grouped as commands, the command completion time is shown for each 
command.

In this display, command fragments (see “Theory of Operation” on page 233) are shown 
as individual events that are not grouped into commands.  However, if a command has 
caused the timeout trigger condition to be violated, that trigger event will be shown as a 
command in which the second "event" is a special trigger condition summary.  This 
situation is illustrated in the following display:

A Command End Event is inserted by the SASTracker System when timeouts are detected
and no Command End Event was recorded.
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In this Command Log File, the command initiated in "Event 12" did not complete, and as 
a result the system has indicated this by flagging the event as "TIMED OUT".  Expanding 
the transaction shows the result as "CMD TIMEOUT" to indicate that no command 
completion for this event was present in the Command Log File.  A Command End Event 
is inserted by the SASTracker System to indicate that the trigger condition was violated.

A command may complete with an execution time longer than the trigger timeout period, 
but before the system has stopped recording.  These late commands will have both a 
Command Start Event and a Command End Event, but the execution time still exceeds 
the trigger timeout.  An example of this is shown in the display below:

This display shows that the Command End Event was recorded, but since the execution 
time exceeded the trigger timeout, the command was flagged as "TIMED OUT".

When viewing a large number of commands to determine a timeout violation, use of the 
Compact View is helpful.  Select Compact from the View menu, or use the Ctrl-Q 
keyboard shortcut. The resulting display is shown below.
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Command Log File Reports
As with trace files collected with SASTracer, command log files generated by 
SASTracker have access to reporting capabilities within the SASSuite program.

One of the more useful reports available for SASTracker Command Log Files is the "Bus 
Utilization" report, which in the case of SASTracker files will show the following:

• The number of pending commands at all times during the period that the 
Command Log File was recording.  This display is useful to determine the 
outstanding commands that existed at any point in time, and to determine 
times at which the number of pending commands was larger than usual for 
the system.

• The command duration for all completed commands contained within the 
command log file, shown against the time they occurred within the recorded 
trace.  This display highlights commands which were taking unusually long 
times to complete, and by having this data aligned with the pending 
command data mentioned above, the user can determine whether long 
command completion times are related to the number of pending commands, 
or due to some other effect.

To display the Bus Utilization report, select the Bus Utilization menu selection in the 
Report menu, or click the Bus Utilization button  in the Analysis toolbar.

The following graphs are displayed in the bottom half of the screen:

The graph display can be customized to focus on areas of particular interest using the 
tools provided in the icons at the top of the graph. By double-clicking at any point within 
the graph area, the Command Log File display in the top half of the screen will jump to 
that section of the file.  For more information on manipulating this display, see “Bus 
Utilization” on page 160.
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Exporting Command Log Files
As with trace files, Command Log Files from SASTracker can be exported for use by 
other data analysis programs (such as MicroSoft Excel).  The data that is exported 
depends, to an extent, on the data displayed on the screen.

In the default SASTracker display, the timestamps for each event are combined (for 
convenience in reading the log file) with the command number, as shown below.  

If timestamps are desired in the exported data file, the first step in exporting the data is 
to separate the timestamp into its own field.  To do this, select Display Options... from 
the Setup Menu.  Under the "General" tab, change the field marked "Time Stamp 
Position" to be "At the beginning", and click "OK".   The display will now appear as follows:

In a similar fashion, the user can have some control over the data which is exported by 
expanding and/or contracting data files as described in “Expanding and Collapsing 
Fields” on page 132.

To export the Command Log File, select Export.. to CSV Format... in the File menu.

The next screen will allow you to specify a filename and location for the exported file, and 
also to limit the data exported to some portion of the file if only a portion is required.

Working 
with 
Exported 
Data Files

The file type which is exported from SASSuite is a generic text data file (.csv) which can 
be imported into many applications.  In this example, we will use Microsoft Excel, but the 
same procedure can be used with many database and spreadsheet applications.
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Once the file has been saved, open Microsoft Excel.  Select Open.. from the File menu, 
which will bring up a screen allowing you to navigate to the folder in which you saved the 
file. (If you have forgotten where you saved the file, go back to the SASSuite program and 
select File... Export to CSV Format... again and note which directory and folder contains 
the exported file.)

At the bottom of this screen, under "Files of Type:", select "Text Files".  This will produce 
a display of all .csv files contained in the folder.  Click on the correct file to highlight it, 
then click on Open.

When the file is opened, a large spreadsheet similar the following will appear:
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This spreadsheet will have a large number of columns (most of which are blank).  This 
format is used for all SASSuite data exports, and many of the columns will not have 
application to SASTracker data files.

The first row of the spreadsheet contains the titles for each column.  Remaining rows 
contain information on each completed command that was present in the exported data.

Since there are many blank columns (for data values which are not used in SASTracker 
Command Log Files), these columns can be deleted to simplify the spreadsheet.  If a very 
large number of events has been exported, it may be difficult to be sure that no data 
exists anywhere in a column.  In such cases, insert an extra row just below the column 
titles and enter a formula similar to "=1000 - COUNTBLANK(A3:A1002)", and copy this 
value across all columns.  In this example (which assumes 1000 exported events), all 
blank columns will show "0" as the result of this function and may be deleted.  Any column 
with data will show the number of cells that contain data in that column.

Some data is exported as text fields which represent numeric values.  For example, the 
command completion time will be exported as fields such as "234.245 us" or "3.456 ms".  
In order to convert these text fields to values which can be sorted and otherwise 
manipulated, create a new column next to the "COMPL TIME" column and enter a 
formula such as the following into the first data row of the new column:

=IF(P2="","",IF(RIGHT(P2,2)="ms",1000*VALUE(LEFT(P2,LEN(P2)-3)),
                                                                                   VALUE(LEFT(P2,LEN(P2)-3))))
This formula assumes that the original data value is in cell P2.  The formula first checks 
to see if P2 contains any data (if not a blank value will be inserted--this is typically the 
case for command fragments such as incomplete commands or orphans).  If data exists, 
the formula determines whether the units used are millisecs ("ms"), in which case it 
extracts the numeric value of the cell and multiplies it 1000.  If the units are not ms, then 
the formula extracts the numeric value as microseconds.  The result (for data that 
contains only millisec and microsec values), is a column with completion times all in 
microseconds.

Copy this formula down the length of the column, and all original text data is converted 
to numeric data expressed in microseconds.

Note:  If the data fields contain other units such as seconds or nanseconds, 
the formula will need to be modified to account for all units used.

The commands in the file can now be sorted in increasing or decreasing order of 
command completion time by selecting all rows containing data, then selecting Sort from 
the Data menu in Microsoft Excel.  Choose the column which contains the numeric 
completion times, and select "Ascending" or "Descending".

Creating a 
Histogram 
using 
Microsoft 
Excel

Microsoft Excel and other database and spreadsheet programs often have sophisticated 
statistical functions useful for analyzing the data produced by SASTracker.  For example, 
it may be useful to have a histogram of command completion times for a Command Log 
File, to show the range and the pattern of variation of the command completion times.  A 
histogram is a chart which shows the frequency of occurance of values within a specified 
data range, and allows the user to easily see which completion times cluster around 
certain values, and which are unusual.
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One way to create this chart is to begin by converting all command completion times into 
data values as described above.  Once this column is created, some basic statistic values 
can be determined using Excel formulas, such as the following (in this example, the data 
is contained in column Q, rows 2 through 512):

• The number of valid datapoints can be determined by using the formula 
"=511 - COUNTBLANK(Q2:Q512)"

• The maximum value in the range of command completion times can be 
determined by the formula "=MAX(Q2:Q512)"

• The minimum value in the range of command completion times can be 
determined by the formula "=MIN(Q2:Q512)

Once the minimum and maximum values are known, the histogram can be prepared by 
deciding on the "buckets" to be used to collect the data.

An example is shown below.  In this example, the measured command completion times 
varied from 1.645 microseconds to 36,852 microseconds.  Data "buckets" were set up for 
the following ranges:

• Less than 2 us

• 2-3 us

• 3-5 us

• 5-10 us

• 10-100 us

• 100-1,000 us

• 1,000-10,000 us

• 10,000-50,000 us

These values were entered in cells Q519 through Q526.

To create the histogram, first select all cells which will contain the data, in this case cells 
R519 through R526.  Type in the following formula:

=FREQUENCY(Q2:Q512,Q519:Q526)

but instead of pressing ENTER to enter the formula, press CTRL+SHIFT+ENTER.  This 
enters this formula into the entire array of cells you selected.  The values shown are the 
number of datapoint that fall between each "bucket" value.

You can produce a graph of this data by using the Excel Chart Wizard.  Select the cells 
containing the histogram data.  Click on the Chart Wizard icon and follow the instructions. 
On the second step, click on the "Series" tab, then on the "Category (X) axis labels:" field, 
select the list of "buckets" in Q519 through Q526, and enter them as axis labels.
248 LeCroy Corporation



SASSuite User Manual Version 6.2
The result is the graph shown below:

This graph shows an interesting bimodal distribution in command completion times, with 
a large set of commands completing within less than 5 microsecond, and another set of 
commands requiring 1-20 milliseconds to complete.  By sorting and analyzing this 
pattern, the user can more easily understand which commands are resulting in long 
completion times and causing performance degradation.
LeCroy Corporation  249



Version 6.2 SASSuite User Manual
250 LeCroy Corporation



SASSuite User Manual Version 6.2
Chapter 15:  Updates and Licensing
From time to time as modifications are made to the SASSuite Analyzer Software, it may 
become necessary to update the SASSuite software.  You can obtain new software from 
the LeCroy website:  

www.LeCroy.com  
When you download new SASSuite software, firmware and BusEngine files are included 
as part of the software package.  Occasionally, LeCroy will update these files.  The new 
files will install automatically following installation of the new analyzer software.  If you 
prefer, however, you can manually update firmware and BusEngine. This chapter 
describes both automatic and manual updates.

Note:  LeCroy SAS analyzers include downloads of new SASSuite 
software releases that are made available during the 12 months 
after purchase.  Following that time, software releases are included 
when the LeCroy Maintenance Agreement is purchased.  Contact 
LeCroy for details.

Software, Firmware and BusEngine Versions
The Readme.txt file on the installation CD and on the installed directory on your hard 
drive gives last-minute updates about the current release. Included with each release are 
the most recent downloadable images of the Firmware and the BusEngine. 

Once the SASSuite Analyzer has completed the self diagnostics and is connected to the 
PC, you can check the latest version of the software and BusEngine.

To check information about the current software, select  
About SASSuite… from the Help menu.

The About SASSuite window appears. 
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About SASSuite details revisions of the following software and hardware:

• SASSuite Software Version, Build Number
• Firmware Version of Analyzer (if connected)
• BusEngine Version, Build Number (if connected)
• Unit Serial Number (if connected)

Note:  When contacting LeCroy for technical support, please have available all 
the revisions reported in the About SASSuite window.

Software Updates
When a new software release is available, it is posted on the Support page of the LeCroy 
website at www.LeCroy.com/support.html.
To update the software, follow these steps:

Step 1 Find the latest released software version on the LeCroy website 
under Support.
If you are running the latest version of the software, no further action is 
needed. 
If you are not running the latest version, continue to Step 3.

Step 2 Download the installer file from the website.

Step 3 Unzip the files into your choice of directory (if required).

Step 4 Click Start, then Run, and browse to where you unzipped the 
files.

Step 5 Select the program named Setup and click Open.

Step 6 Click OK to run the Setup and begin the installation.

Step 7 Follow the on-screen instructions to complete the installation.

Step 8 Read the Readme file for important information on changes in 
the release.

Automatic BusEngine and Firmware Updates
BusEngine and Firmware updates often need to be performed when you update the 
SASSuite software. These updates can be performed automatically or manually. Both 
processes are described.

Updating 
the 
BusEngine

The BusEngine core is the heart of the LeCroy SAS Analyzer. Using FPGA technology, 
it incorporates both the high speed recording engine and the configurable building blocks 
that implement data/state/error detections, triggering, capture filtering, external signal 
monitoring, and event counting and sequencing. Both the BusEngine program and the 
Firmware that manages the internal microcontroller are fully field updateable.

Within a new software release, it may be necessary to update the Analyzer’s BusEngine 
hardware for proper operation. The Readme file lets you know if this is necessary. 
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Updating 
the 
Firmware

Within a new software release, it may also be necessary to update the Analyzer’s 
firmware for proper operation. The Readme file informs you if this is necessary. 

Automatic 
Updates

When the SASSuite software is updated, the software may become incompatible with the 
BusEngine and Firmware. If a recording is attempted, SASSuite displays an error 
message and then automatically begins an update process for the BusEngine and 
Firmware. 

To perform an automatic BusEngine and Firmware update, follow these steps: 

Step 1 If needed, update the SASSuite software, following the steps 
outlined in "Software Updates."

Step 2 Turn on the Analyzer.

Step 3 Select Start > Record from the menu. 

Because the BusEngine and/or the Firmware are incompatible with the 
current SASSuite software version, an error message appears showing 
your current versions and indicating what versions you need to install.

Step 4 Click Yes.

The Analyzer Setup window appears.

Step 5 Click Update.

You can select only one item at this point. If both the BusEngine and 
the Firmware need to be updated, the update will complete for the first 
item and then return to the above window so the second update can be 
performed. 
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Note:  Once you have started updating the BusEngine or Firmware, do not 
interrupt the update!

When the second update has finished, the following message appears 
and tells you that the update is complete. 

Step 6 To complete the update, power cycle the SASSuite (turn the unit 
off then back on).

If you are running Windows 2000, the Analyzer will automatically 
reboot, and the following message will appear:
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Step 7 Click OK.

In this instance, you do not need to power cycle the Analyzer (turn off 
then back on). 

License Information
Licensing information for SASSuite can be viewed by selecting Display License 
Information from the Help menu. The License window provides maintenance expiration 
for SASSuite. 

Updating the Software License
A current License agreement with LeCroy entitles the analyzer owner to continued 
technical support and access to software updates as they are  published on the LeCroy 
website. 

If your license expires, a License Key must be obtained by LeCroy (refer to the contact 
information at the back of this manual.) 

Once the License Key is obtained, follow these steps to install it:

Step 1 From the Help menu, select Update License. The Update 
License dialog appears. 

Step 2 Enter the path and filename for the License key or use the Browse button 
to navigate to the directory that contains the License Key. 

Step 3 Select the *.lic file, and then click Update Device.
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Limited Hardware Warranty
How to Contact LeCroy

Limited Hardware Warranty
So long as you or your authorized representative ("you" or 
"your"), fully complete and return the registration card 
provided with the applicable hardware product or peripheral 
hardware products (each a "Product") within fifteen days of 
the date of receipt from LeCroy or one of its authorized 
representatives, LeCroy warrants that the Product will be free from defects in materials 
and workmanship for a period of three years (the "Warranty Period").  You may also 
complete your registration form via the internet by visiting 
http://www.lecroy.com/support/register/.  The Warranty Period commences on the earlier 
of the date of delivery by LeCroy of a Product to a common carrier for shipment to you or 
to LeCroy's authorized representative from whom you purchase the Product.

What this Warranty Does Not Cover
This warranty does not cover damage due to external causes including accident, damage 
during shipment after delivery to a common carrier by LeCroy, abuse, misuse, problems 
with electrical power, including power surges and outages, servicing not authorized by 
LeCroy, usage or operation not in accordance with Product instructions, failure to perform 
required preventive maintenance, software related problems (whether or not provided by 
LeCroy), problems caused by use of accessories, parts or components not supplied by 
LeCroy, Products that have been modified or altered by someone other than LeCroy, 
Products with missing or altered service tags or serial numbers, and Products for which 
LeCroy has not received payment in full.

Coverage During Warranty Period
During the Warranty Period, LeCroy or its authorized representatives will repair or 
replace Products, at LeCroy's sole discretion, covered under this limited warranty that are 
returned directly to LeCroy's facility or through LeCroy's authorized representatives.

Type of Service Contact
Call for technical 
support…

US and 
Canada:

1 (800) 909-2282

Worldwide: 1 (408)  653-1260
Fax your questions… Worldwide: 1 (408) 727-6622
Write a letter… LeCroy

Protocol Solutions Group 
Customer Support 
3385 Scott Blvd. 
Santa Clara, CA 95054
USA

Send e-mail… support@CATC.com
Visit LeCroy’s web site… http://www.lecroy.com/
LeCroy Corporation  257



Version 6.2 SASSuite User Manual
How to Obtain Warranty Service
To request warranty service, you must complete and return the registration card or 
register via the internet within the fifteen day period described above and report your 
covered warranty claim by contacting LeCroy Technical Support or its authorized 
representative.  
LeCroy Technical Support can be reached at 800-909-7112 or via email at 
support@catc.com.  You may also refer to LeCroy's website at http://www.lecroy.com for 
more information on how to contact an authorized representative in your region.  If 
warranty service is required, LeCroy or its authorized representative will issue a Return 
Material Authorization Number. You must ship the Product back to LeCroy or its 
authorized representative, in its original or equivalent packaging, prepay shipping 
charges, and insure the shipment or accept the risk of loss or damage during shipment. 
LeCroy must receive the Product prior to expiration of the Warranty Period for the 
repair(s) to be covered.  LeCroy or its authorized representative will thereafter ship the 
repaired or replacement Product to you freight prepaid by LeCroy if you are located in the 
continental United States.  Shipments made outside the continental United States will be 
sent freight collect.
Please remove any peripheral accessories or parts before you ship the Product. LeCroy 
does not accept liability for lost or damaged peripheral accessories, data or software.
LeCroy owns all parts removed from Products it repairs. LeCroy may use new and/or 
reconditioned parts, at its sole discretion, made by various manufacturers in performing 
warranty repairs. If LeCroy repairs or replaces a Product, the Warranty Period for the 
Product is not extended.
If LeCroy evaluates and determines there is "no trouble found" in any Product returned 
or that the returned Product is not eligible for warranty coverage, LeCroy will inform you 
of its determination.  If you thereafter request LeCroy to repair the Product, such labor 
and service shall be performed under the terms and conditions of LeCroy's then current 
repair policy.  If you chose not to have the Product repaired by LeCroy, you agree to pay 
LeCroy for the cost to return the Product to you and that LeCroy may require payment in 
advance of shipment.
General Provisions
THIS LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS.  YOU MAY HAVE 
ADDITIONAL RIGHTS THAT VARY BY JURISDICTION.  LECROY'S RESPONSIBILITY 
FOR DEFECTS IN MATERIALS AND WORKMANSHIP IS LIMITED TO REPAIR AND 
REPLACEMENT AS SET FORTH IN THIS LIMITED WARRANTY STATEMENT. 
EXCEPT AS EXPRESSLY STATED IN THIS WARRANTY STATEMENT, LECROY 
DISCLAIMS ALL EXPRESS AND IMPLIED WARRANTIES FOR ANY PRODUCT 
INCLUDING, BUT NOT LIMITED TO, ANY IMPLIED WARRANTIES OF AND 
CONDITIONS OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE, AND ANY WARRANTIES THAT MAY ARISE FROM ANY COURSE OF 
DEALING, COURSE OF PERFORMANCE OR TRADE USAGE.  SOME 
JURISDICTIONS MAY NOT ALLOW LIMITATIONS ON HOW LONG AN IMPLIED 
WARRANTY LASTS, SO THE PRECEDING LIMITATION MAY NOT APPLY TO YOU.

LECROY DOES NOT ACCEPT LIABILITY BEYOND THE REMEDIES SET FORTH IN 
THIS LIMITED WARRANTY STATEMENT OR FOR INCIDENTAL OR 
CONSEQUENTIAL DAMAGES INCLUDING, WITHOUT LIMITATION, ANY LIABILITY 
FOR THIRD PARTY CLAIMS AGAINST YOU FOR DAMAGES, PRODUCTS NOT 
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BEING AVAILABLE FOR USE, OR FOR LOST DATA OR SOFTWARE.  LECROY'S 
LIABILITY TO YOU MAY NOT EXCEED THE AMOUNT YOU PAID FOR THE 
PRODUCT THAT IS THE SUBJECT OF A CLAIM.  SOME JURISDICTIONS DO NOT 
ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL 
DAMAGES, SO THE PRECEDING EXCLUSION OR LIMITATION MAY NOT APPLY TO 
YOU.

The limited warranty on a Product may be transferred for the remaining term if the then 
current owner transfers ownership of the Product and notifies LeCroy of the transfer.  You 
may notify LeCroy of the transfer by writing to Technical Support at LeCroy, 3385 Scott 
Blvd., Santa Clara, CA 95054 USA or by email at: support@catc.com.  Please include 
the transferring owner's name and address, the name and address of the new owner, the 
date of transfer, and the Product serial number.
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Appendix A:  Specifications
Avalanche Systems

Host Requirements Windows 2000 or gretaer; Intel Pentium II processor or 
greater; USB port

Recording Memory Size 4 GB for trace capture, timing and control information

Power Requirements 100-250 VAC, 50-60 Hz (universal input), 480W max

Back Panel Connectors AC Power connection, External trigger connections (TRIG 
IN/OUT, SMA), USB type "B" host computer connection, 
Breakout Board Data Output Connection

Manual Trigger Switch Forces a trigger event when pressed

Basic Trigger Events Primitives, Bus Conditions, FISs, Errors, ATA 
Commands, SATA Commands, External Signals, Vendor 
FIS, Data Pattern SCSI Operations, SCSI Status, SSP 
IUs, SMP Request/Response

Traffic Summary Reports Errors, Primitives, FIS, Frames, Transactions, SCSI 
Operations, ATA Commands

Bus Utilization Reports Pending SCSI IOs, Pending ATA IOs, Response Time, 
Latency Time, Throughput, Frame Length, Link 
Utilization, Data Throughput, Frames Count

Connectors Two (2) 4-port MiniSAS One MiniSAS connector supports up to four initiators, the 
second connector supports up to four targets

Indicators Initiator Status (1, 2, 3, 4) Green when receiving frame, Mixed Green/Red during 
OOB, Red on error

Initiator Speed (1, 2, 3, 4) Green for 6 Gb/s,  Mixed Green/Yellow for 3 Gb/s, Yellow 
for 1.5 Gb/s

Target Status (1, 2, 3, 4) Green when receiving frame, Mixed Green/Red during 
OOB, Red on error

Target Speed (1, 2, 3, 4) Green for 6 Gb/s, Mixed Green/Yellow for 3 Gb/s, FYellow 
for 1.5 Gb/s

Trig/Err Right Green when Channel 1 or 2 are triggered, Red on error

Rec/Upload Right Red when Channel 1 or 3 are recording, Green when 
uploading

Trig/Err Left Green when Channel 3 or 4 are triggered, Red on error

Rec/Upload Left Red when Channel 3 or 4 are recording, Green when 
uploading
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Physical 
and 
Environmen
tal

Dimensions (W x H x D) 29.4 x 6.7 x 23.7 cm (11.6 x 2.6 x 9.3 inches)

Net Weight (Chassis) 3.4 Kg (7.5 lbs)

Net Weight (Chassis + PS) 4.3 Kg (9.5 lbs)

Temperature: Operating 0C to 55C (32F to 131F)

Temperature: Non-operating -20C to 80C (-4F to 176F)

Humidity: Operating 10% to 90% RH (non-condensing)

SASTracer/Trainer Systems
LeCroy SASTracer/Trainer analyzers are hardware modules that install into the CATC 
10K  platform. The following specifications describe a combined SAS 10K based system. 

Package

Power 
Require- 
ments

90-254VAC, 47-63Hz (universal input), 120W maximum 

Environ- 
mental 
Conditions

 

Dimensions: CATC 10K: 12.2 x 12.2 x 3.5 inches 
(31.1 x 31.1 x 8.9 cm)
Single-wide Plug-in: 4.5 x 6.7 x 1.3 inches 
(11.3 x 17.0 x 3.2 cm)
Double-wide Plug-in: 9.5 x 6.7 x 1.3 inches 
(24.1 x 17.0 x 3.2 cm)

Rear Connectors: CATC 10K: 
AC power connection
External trigger connection (TRIG IN/OUT, BNC)
PC connection (USB 2.0 Hi-Speed, type "B")
Break-out board (type "D")

Weight: CATC 10K: 9.5 lbs (4.3 kg)
Single-wide Plug-in: 1 lb 11.4 oz (.77 kg)
Double-wide Plug-in: 3 lb 3 oz (1.45kg)

Operating Range: 0 to 40 °C (32 to 104 °F)
Storage Range: -20 to 80 °C (-4 to 176 °F)
Humidity:
Operating Altitude:

10 to 90%, non-condensing
Up to 6.560 feet (2,000 meters)
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Probing 
Character- 
istics 

Model SS002MAA & SS003MAA

Model SS004MAA

Recording 
Memory 
Size 

2 GBytes for trace capture, timing and control information.

Host PC 
Require- 
ments

 

Switches  

LEDs  

Connector Type: One Port Model - Single Pair of Internal Connectors (Initiator and 
Target; Serial ATA Standard)
Two Port Model - Dual Pair of Internal Connectors (Initiator and 
Target; Serial ATA Standard)
Four Port Model - Single Pair of Internal Connectors (Initiator and 
Target; Serial ATA Standard)

SASTrainer Connection 
Type:

Single Initiator and Target connectors 
(for transmission only)

Connector Type: 2 pairs SAS External 4 lane Connector:

Non-intrusive tap - samples the signal without re-driving the 
differential lines (high value resistors contribute to reduction in 
amplitude ˜ 15%).

Repeater tap - re-drives the signal at either SAS (high swing) or 
SATA (low swing) voltages; does not re-time the signal.

Operating System: Windows 98SE, Windows 2000, Windows ME or Windows XP

Power: On/off
Manual Trigger: When pressed, triggers the end of the recording

CATC 10K: Illuminated when the analyzer is powered on.
Status (STATUS): Illuminates for approximately 25 seconds during 

initialization/power up of the CATC 10K base unit. If this LED 
blinks following initialization, this is an indication that initialization 
failed.

Recording (REC): Illuminated when the analyzer is actively recording traffic data
Triggered (TRG): Illuminated during power-on testing and when the analyzer has 

detected a valid trigger condition.
UPloading (UPLD): Illuminated when the analyzer is uploading its recording memory 

to the Host PC for displaying the CATC trace

SASTracer Plug-in 
Module:
Status (STATUS): Illuminates when there is traffic on both the host and device 

sides.  Blinks when there is traffic on one side only.
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Basic SASTracer Trigger Events

SASTracer Traffic Summary Reports

Miscellaneous Information
The following tables are supplied in compliance with China’s Restriction of Hazardous 
Substances (China RoHS) requirements:

Frames: SSP Command, Data, Response, Task, X_RDY and Vendor 
Unique, SMP Request, Response, Report, Discover and 
Configure; 

Primitives: ACK, CREDIT_BLOCKED, DONE 
(ACK/NAK TIMEOUT),  NAK, RRDY, SOF,  AIP, 
BREAK, BROADCAST, CLOSE, OPEN_ACCEPT, 
OPEN_REJECT, and more task management functions  

Errors: Invalid 10b codes, CRC Errors, Running Disparity Errors, 
Time-outs, Alignment errors, Code Violation

SCSI Operations: Pending SCSI I/Os, SCSI I/O Response, SCSI I/O Latency,
SCSI I/O Throughput, Frame Length, Data Throughput,
Link Utilization (%), Frame Count

Data Frames
Primitives
Connects/Disconnects
Errors
SCSI Commands
Read Response (min, max, avg.)
Write Response (min, max, avg.)
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A
AC Connector 10
Action Pop-up Menu 88
Actions 69
Actions Tab 93, 105
Adding Comments 35
Address Frames Properties Dialog 95
Address FramesDecl.inc 196
Adjusting Timestamps 182
Altering Channel Layout 182
Analyzer Network Chat 183
AND Condition 107
Assigning Actions 105
ATA Application Layer 126
ATA Command Event 63
ATA Commands 94, 101
ATAPI Commands 94, 102
AutoAlign 193
Autodetect Link Rate 44, 81, 239
Avalanche Front Panel 7
Avalanche LED Descriptions 7

B
Beep Action 70
Beep on Trigger 40, 76
Beep When Trigger Occurs 40, 76
BNC Connectors 10
BNC External Trigger 149
BNC Output Action 70
Branch to Existing State Action 69
Branch to New State Action 70
Breakout Board 7, 10, 103, 149, 152, 154
Breakout Board Input Trigger Event 65
Breakout Board Output Trigger Action 70
Buffer Size 40, 77
Bus Conditions 102
Bus Utilization 30, 160
Bus Utilization Buttons 160
Byte Value in 10b Raw Bits 131

C
Cascaded Multiple Analyzer 174
Cascading 173

CATC 10K Platform 8
Changing Display Levels 125
Changing Field Formats 121
Changing the BusEngine 234
Changing the Color of the Data Fields 32
Channel Names 71
Channel Settings 43, 44, 81, 239
Channels 71, 116
Clear Marker 37
Collapse Data 32
Collapsing Data Fields 132
Color Display Options 120
Command Completion Time 242
Command End Events 233
Command Fragments 233
Command Log File 233, 234, 241, 243
Command Start Events 233
Comments 35
Compact View 138, 243
Complex "Wait For" Conditions 230
Complex Searches 147
Configuring Input Signaling 154
Connected Remotely over an IP Network 173
Connecting Devices 11
Connectors 10
Contact LeCroy 257
Conventional Recording 76
Counters 87, 108
Counting Events 108
CRC Calculations 196
Creating a Traffic Generation File 186
Ctrl-Q Keyboard Shortcut 138
Custom Channel Names 71, 116

D
Data Block Window 134
Data In/Out Connector 152
Data Output Connector 10
Data Pattern Event 64
Data Payload 133
Decode Buttons 30, 236
Decode Toolbar 31
Descrambling 44, 81
Dimensions 262
Disparity Error 131
Display Options 29, 119, 122, 123, 129
DWORD Display 4, 5
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Edit Comment 35
Environmental Conditions 262
Error Event 65
Error Report 30
Error Summary 31, 159
Errors Properties Dialog 103
Event Properties Dialog Box 93
Event Sequences 110
Event Trigger 40, 76
Events 59
Exerciser Hardware 185
Expand Data 32
Expanders 130, 132
Expanding Data Fields 132
Export 25
Export Options 139
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Export Packets to Text 140
Export to CSV Format 141
Export to Generator File Format 141
External Connector Module 13, 14, 21
External Interface for Trigger 149
External Trigger 89

F
Features 4, 5
File Information Report 30
Filter 88, 108
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FIS Event 62
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Frames 94, 95
Frames Properties Dialog 96
Front Panel LEDs 9

G
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Generating Traffic 186, 198
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Global State Cell 82, 85, 87, 106, 107
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H
Hardware Description 7
Hardware Warranty 257
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High Swing 22
Host Computer Connector 10
Host PC Requirements 263
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Identify Address Frame Event 68
Idle Time 166
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Initiator Emulation 185
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Installation 7
Installing Software 15
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Left Mouse Button 32
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Markers 167
Media Changer Command Set 99
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Multisegment Toolbar 43, 79
Multisegment Trace 30, 41, 78

N
Navigation Tools 34
Network Chat 183
Networking 173
New Events Menu 89
Non-intrusive Tap 12
Normal Swing 22

O
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OOB Idle Sensitivity 22
OOB Signal 48
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Open File 29
Opening Trace Files 24
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Output Power 21
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Print 29
Probe Control Settings 19
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Recording Rules Page 83
Recording Rules Toolbar 83
Recording Scope 40, 76
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Reports 157
Right Mouse Button 32
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Running Disparity 131
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S
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